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Wprowadzenie 
Gratulujemy wybrania najnowocześniejszego tłumacza 
skanującego firmy WizCom Technologies. WizCom 
Technologies oferuje tłumacze skanujące, które pomagają w 
rozumieniu i przetwarzaniu czytanych tekstów.  
 
Tłumacz Quicktionary®2 Premium pozwala skanować tekst, 
wyświetla tłumaczenie oraz odtwarza poprawną wymowę. 
Szeroki wybór słowników zainstalować można przy użyciu 
dołączonej płyty CD. 
Quicktionary®2 Premium posiada również funkcję 
przechowywania zeskanowanych tekstów.  
Tłumacz przechowuje do 500 stron znormalizowanego 
tekstu, rozpoznaje wiele krojów i rozmiarów czcionek.  
 
Dodatkowym ułatwieniem jest możliwość prostego 
i szybkiego przesyłania zeskanowanego tekstu do 
komputerów, palmtopów, telefonów typu Smartphone, a 
także wszelkich innych urządzeń obsługiwanych przez 
system operacyjny Windows. 
 
Instrukcja obsługi składa się z 4 rozdziałów: 
1. Pierwsze Kroki – Ten rozdział dostarcza 

podstawowych informacji na temat skanowania, 
użytkowania dołączonej płyty CD, instalowania 
oprogramowania WizCom oraz nawiązywania połączeń 
komputer-tłumacz. 

2. SuperPen™ Professional – Rozdział poświęcony 
obsłudze menu, aplikacji do skanowania, wprowadzania 
i edytowania tekstu. 

3. Oprogramowanie WizCom – Rozdział dotyczy 
użytkowania aplikacji służących do przesyłania danych 
z tłumacza na komputer oraz ich synchronizacji.  

4. Informacje dodatkowe – Rozdział uwzględnia 
dodatkowe informacje dotyczące m.in. wydajności i 
konserwacji.  
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Pierwsze kroki 
Zapoznanie się z budową tłumacza 
Części tłumacza 
Tłumacz składa się z następujących części: 

 
 

 
Ważne: Przed nałożeniem słuchawek należy pamiętać o 
ustawieniu siły głosu w menu Preferences (Voice 
Settings). 
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Szybki start 
 
1. Wyjmij tłumacza z etui. 
2. Otwórz schowek na baterie. 
3. Włóż dwie baterie AAA („małe paluszki”). 
4. Zamknij schowek. 
5. Zdejmij nakładkę ochronną z wąskiej końcówki. 
6. Aby rozpocząć, naciśnij  . 
7. Zacznij skanowanie. 

Uwaga: Informacje o ustawieniach dla osób leworęcznych 
znajdują się na stronie 53. 

Podstawowe komendy 
Funkcje klawiatury 
Na klawiaturze znajduje się 7 przycisków: 

  – włączanie i wyłączanie tłumacza.  
  – wejście do menu, potwierdzanie wyboru oraz 

uruchamianie funkcji. 
  – wycofywanie wyboru, zamykanie okien, 

anulowanie operacji. 
     – klawisze wyboru – poruszanie się po 

menu.  

Obsługa Menu  
Aby wybrać opcję:  

1. Używając przycisków  lub  przewijaj listę do 
momentu w którym wybrana opcja zostanie 
podświetlona. 

2. Naciśnij  
 
Aby wybrać komendę na wyświetlaczu: 
1. użyj klawiszy wyboru, aby podświetlić komendę 
2. naciśnij . 
 
Aby powrócić do poprzedniego menu, naciśnij  . 
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Skanowanie 
Tryb skanowania 
Przy włączonym trybie skanowania na wąskiej końcówce 
tłumacza miga czerwona lampka.  

Kierunek skanowania 
Tekst skanować można zaczynając od lewej lub od prawej 
strony. Rezultat pozostaje ten sam. 

Ograniczenia 
Tłumacz skanuje teksty w różnych językach. Rozpoznaje 
wiele kolorów, krojów i rozmiarów czcionek (6-22 pkt – do 8 
mm), również teksty na kontrastujących tłach (z wyjątkiem 
kombinacji: czerwony na białym, biały na czerwonym, 
niebieski na czarnym oraz czarny na niebieskim). Tłumacz 
nie rozpoznaje pisma ręcznego, kursywy, symboli 
matematycznych oraz niektórych znaków specjalnych.  

Wskazówki 
Aby osiągnąć najlepszy efekt należy: 

 trzymać tłumacza pod odpowiednim kątem (90˚), 
 umieścić skanowany tekst na płaskiej powierzchni, 
 zwrócić uwagę na jakość skanowanych wydruków – 

skanowanie niskiej jakości kserokopii oraz pognie- 
cionego papieru może przynieść niezadowalający 
rezultat, 

 skanować powoli. 

 
Tak należy trzymać tłumacza 

Problemy z ropoznaniem znaków 
Problemy z rozpoznaniem znaków mają związek z: 

 niską jakością skanowanego materiału, 
 błędnie dobranymi ustawieniami,  
 skanowaniem pod nieodpowiednim kątem,  
 zbyt szybkim skanowaniem. 



Pierwsze kroki 

7 

Jak skanować? 
Tutaj znajdują się informacje dotyczące nauki poprawnego 
skanowania, i dołączonego do Quicktionary®2Premium 
trenera skanowania. 

1. Załóż plastikową nakładkę-trenera na wąską 
końcówkę tłumacza. 

 
2. Włącz tłumacza. Pojawi się Pen Main Menu. Jeżeli 

tak się nie stanie, naciśnij  aż do momentu 
pojawienia się Pen Main Menu.  

3. Używając klawiszy wyboru wybierz aplikację Notes po 
czym naciśnij . 

4. Wybierz New File I naciśnij . 
5. Aby zachować nazwę domyślną wybierz OK. Na 

pustym ekranie pojawi się migający kursor. 
6. Ustaw tłumacza pod kątem 90° w stosunku do podłoża. 

Linijki skanowanego tekstu powinny znajdować się we 
wgłębieniu plastikowej nakładki, tak jak pokazano na 
rysunku.  
Do ćwiczenia użyj poniższego zdania: 

 
This sentence will help me practice scanning. 

 

 
7. Przesuwaj tłumacza w linii prostej, od prawej do lewej 

strony. Zacznij skanowanie 1 cm dalej, niż kończy się 
wiersz, zakończ 1 cm dalej, niż się zaczyna.  

8. Na ekranie pojawi się skanowany tekst. Jeżeli tak się 
nie stanie, albo jakość skanu nie jest zadowalająca, 
naciśnij  by wymazać.  



Pierwsze kroki 

8 

Płyta CD 
Po włożeniu do stacji dysków komputera płyta CD uruchomi 
się automatycznie. W przeciwnym wypadku należy: 

1. w menu Start wybrać Uruchom 
2. wpisać x:\setup.exe (gdzie x to napęd CD-ROM), a 

następnie wybrać OK. 
Płyta CD służy do: 

 Instalowania sterowników USB i oprogramowania 
WizCom Desktop niezbędnych do przesyłania 
danych z tłumacza na komputer 

 Instalowania dodatków takich jak dodatkowe 
słowniki, interfejsy językowe, funkcje sprawdzania 
pisowni, rozpoznawania polskich znaków oraz aplikacji 
Image Capture, służacej do skanowania małych 
obrazów. Sterowniki USB należy zainstalować w 
pierwszej kolejności. 

Instalowanie oprogramowania 
WizCom Desktop 
Zainstalowanie oprogramowania WizCom Desktoop 
umożliwia przesyłanie danych z tłumacza na komputer. Do 
zainstalowania programu potrzebne są: tłumacz 
Quicktionary®2Premium oraz dołączone do zestawu płyta 
CD i kabel USB.   
Uwaga: Przed zakończeniem instalowania sterownika USB 
nie można podłączać kabla USB. 
Aby zainstalować należy: 
1. włożyć płytę CD do stacji dysków komputera. 

W przypadku gdy instalacja nie rozpocznie się 
automatycznie powinno się: 
 w menu Start wybrać Uruchom 
 wpisać x:\setup.exe (gdzie x to napęd CD-ROM), 

a następnie wybrać OK 
2. Pojawi się okno dialogowe. 
3. Z głównego Menu wybierz Instaluj. 
4. Zgodnie z instrukcjami zainstaluj najpierw sterownik 

USB, a następnie oprogramowanie WizCom Desktop. 
Uwaga: Kiedy w trakcie instalacji pojawi się komunikat z 
poleceniem zrestartowania komputera należy postąpić 
zgodnie z instrukcjami. 



Pierwsze kroki 

9 

Nawiązywanie połączeń komputer-
tłumacz  
Aby poprawnie skonfigurować urządzenia, należy: 
Tłumacz 
1. włączyć tłumacza, odnaleźć w menu (Pen Main Menu) 

zakładkę Preferences, a następnie nacisnąć , 
2. przewinąć w dół do zakładki Communications 

Settings, a następnie nacisnąć ,  
3. po pojawieniu się komunikatu Connection Device 

nacisnąć , 
4. wybrać Cable, a następnie nacisnąć ,  
5. przewinąć w dół do ustawień prędkości transmisji 

danych (Baud Rate), a następnie nacisnąć , 
6. ustawić prędkość transmisji danych (Baud Rate) na 

115 200, a następnie nacisnąć ,  
7. dwukrotnie nacisnąć , aby powrócić do menu (Pen 

Main Menu)  
Program Wizcom Desktop 
Aby zobaczyć ustawienia połączeń, należy z Menu Bar 
przejść do menu Pen Communications, a następnie 
wybrać opcję Communications Settings. Pojawi się okno 
dialogowe Communications Settings: 

 
Prawidłowe ustawienia (przy użyciu kabla USB): 
Port powinien odpowiadać portowi COM, którego używa 
tłumacz. Aby sprawdzić czy ustawienia są poprawne, należy: 
W menu Start odnaleźć Ustawienia/Panel Sterowania 
oraz wybrać System. 
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a. Wybierz zakładkę System, potem Sprzęt i kliknij 
Menedżer Urządzeń  

b. Przewiń w dół do Ports (COM & LPT) i rozwiń 
listę dostępnych portów. 

c. Znajdź Prolific USB-to-Serial Comm 
Port , zanotuj numer COM, otwórz okno 
właściwości tego portu (2x kliknij na porcie) i w 
zakładce Ustawienia Portu ustaw Liczbę Bitów 
na Sekundę na 115200.  

 
d. Wróć do okna dialogowego Communications 

Settings i zmień ustawienia opcji Port. 
2. Wartość Baud Rate powinna wynosić 115 200, 

podobnie jak w urządzeniu Quicktionary i Twoim 
komputerze w porcie Prolific USB-to-Serial Comm 
Port .  

3. Naciśnij OK. 
Uwaga: Jeżeli Prolific USB-to-Serial Comm Port nie 
znajduje się na liście, oznacza to, że sterownik USB nie 
został poprawnie zainstalowany. W takim przypadku należy 
ponownie zainstalować sterownik, I postępować zgodnie 
z zaleceniami kreatora instalacji.  
Następnie należy uruchomić kreatora połączeń 
(Communications Wizard) aby ustanowić połączenie 
tłumacz-komputer. Połączenie może ustanowić jedynie 
administrator komputera. Należy sprawdzić czy kabel jest 
dokładnie umiejscowiony (należy docisnąć aż do ostatniego. 
„kliknięcia”). Kreatora uruchamia się w menu Help w menu 
programu WizCom Desktop. W przypadku problemów z 
komunikacją spróbuj połączyć się z komputerem ustawiając 
w urządzeniu „PC-Controlled Communications” z Pen Main 
Menu, a następnie w WizCom Desktop wybierz ikonę 
„Add / Remove Pen components”  

Więcej o problemach z nawiązaniem połączenia na stronie 
71 w rozdziale Rozwiązywanie problemów.
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SuperPen™ Professional  
Podstawowe funkcje 
Wszystkie funkcje znajdują się w menu (Pen Main Menu), 
które otwiera się po włączeniu tłumacza. Używając klawiszy 
wyboru można przewijać listę, a za pomocą klawisza  
wchodzi się w zakładki oraz wybiera funkcje i aplikacje. Aby 
powrócić do Pen Main Menu, należy nacisnąć .  

Opcje Pen Main Menu:  

Quicktionary  
Aplikacja Quicktionary pozwala skanować i tłumaczyć 
teksty. Na dołączonej płcie CD znajdują się słowniki do 
zainstalowania (patrz str. 12). 
Notes  
Aplikacja Notes pozwala wczytywać drukowany tekst do 
tłumacza Quicktionary®2Premium. Tekst można następnie 
przesłać na komputer lub na inne urządzenie posiadające 
port podczerwieni (patrz str. 28). 

Address Book  
Aplikacja Address Book pozwala skanować wizytówki oraz 
inne dane adresowe. Dane można przesyłać na komputer 
lub inne urządzenie z portem podczerwieni (patrz str. 32) 

Internet Links  
Aplikacja Internet Links umożliwia skanowanie adresów 
internetowych. Linki te mogą być przesłane na komputer 
oraz dodane do listy Ulubionych w przeglądarce Internet 
Explorer lub Zakładek przeglądarki Netscape Navigator 
(patrz str. 37).  

Tables  
Aplikacja Tables pozwala skanować tabele, które można 
przesłać na komputer oraz dokonać ich konwersji do formatu 
Excel patrz str. 41). 

Scan to PC  
Aplikacja Scan to PC pozwala wczytywać tekst bez-
pośrednio do programów systemu Windows (patrz str. 44). 
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QuickLink  
Opcja uruchamia przesył plików (patrz str. 48). 

PC-Controlled Communications  
Opcja nawiązywania połączenia tłumacz-komputer w celu 
dodawania i usuwania elementów oprogramowania tłumacza, 
takich jak: słowniki, interfejsy językowe oraz porządkować 
pliki (patrz str. 51). 

Preferences  
Opcja pozwalająca zmieniać ustawienia tłumacza, takie jak: 
jezyk czy menu (patrz str. 52). 

Information  
Opcja wyświetlania aktualnych ustawień (patrz str. 55). 

The Quicktionary Application 

 
Aplikacja Quicktionary służy do skanowania i tłumaczenia 
tekstów w różnych językach. Używając opcji Split Screen 
i Dictionary Screen można usłyszeć tłumaczone słowa. Po 
uruchomieniu opcji Input Screen, czerwona lampka na 
wąskiej końcówce tłumacza zacznie migać. Skanowanie jest 
możliwe wyłącznie kiedy lampka miga. Podczas poruszania 
się po menu, tryb skanowanie wyłącza się automatycznie. W 
przypadku gdy na tłumaczu nie są zainstalowane żadne 
słowniki, należy je zainstalować używając aplikacji 
Quicktionary.  

Instalowanie słowników 
Aby zainstalować słownik należy: 

1. włożyć płytę CD do stacji dysków komputera. 
W przypadku gdy instalacja nie rozpocznie się 
automatycznie powinno się: 

 w menu Start wybrać Uruchom 
 wpisać x:\setup.exe (gdzie x to napęd CD-
ROM), a następnie wybrać OK 
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2. Pojawi się okno dialogowe.  
3. W Main Menu kliknij Install Add-Ons. 
4. Pojawi się menu Install Add-Ons. Kliknij 

w Dictionaries. 
5. Pojawi się menu Dictionaries oraz lista dostępnych 

słowników.  
6. Aby zainstalować słownik należy postępować zgodnie 

z instrukcją na płycie.  

Quicktionary Screens 
W aplikacji Quicktionary teksty po wczytaniu wyświetlane 
są za pomocą Input Screen, Split Screen oraz 
Dictionary Screen. Każdy z ekranów wyświetla tłumaczony 
tekst. 
Każdy z tych ekranów może służyć do wyświetlania tekstów. 
Skanowanie jest możliwe, gdy miga czerwona lampka. 
Tłumaczenie zniknie z ekranu po zeskanowaniu nowego 
tekstu. 

Input Screen 
Ten ekran pojawia się po otwarciu aplikacji Quicktionary. 
Na nim pojawia się zeskanowny tekst. Komunikat "Scan in..." 
wskazuje język wyjściowy słownika, a podświetlone pole 
wskaże miejsce do wprowadzenia danych.  

 
 Po zeskanowaniu tekst wyświetlany jest na Split 

Screen lub Dictionary Screen.  
 Wprowadź tekst używając Character bar lub Opticard. 

Więcej informacji znaleźć można na stronie 18 w 
rodziale Edycja i wprowadzanie tekstu. Aby zobaczyć 
tłumaczenie wprowadzonego tekstu, należy wybrać GO. 
Tłumaczenie pojawi się na Split Screen lub 
Dictionary Screen.  

 Aby przejść z Edit Mode do Edit Menu nacisnąć . 
 Aby przejść z Input Screen do Quicktionary Menu 

należy wybrać . 



SuperPen™ Professional 

14 

Uwaga: Pojawiająca się na ekranie ikonka  wskazuje, że 
aplikacja Quicktionary jest gotowa do skanowania tekstu 
pisanego jasną czcionką na ciemnym tle. Na str 15 znajdują 
się informacje o zmianie ustawień Quicktionary Menu. 

Split Screen 
Split Screen uruchamia się przy skanowaniu co najmniej 
2 słów. Zeskanowany tekst pojawia się na górze ekranu, 
a tłumaczenie podświetlonego słowa wyświetla się na dole 
ekranu.  

 
 Używając klawiszy wyboru można przewijać 

skanowany tekst. Używając strzałki  można przewinąć 
tekst w prawą stronę. 

  Za pomocą klawiszy  i  można przewijać tekst 
definicji. 

 Po wybraniu  podświetlone słowo pojawi się 
w Dictionary Screen. 

 Jeżeli wybrany słownik posiada funkcję odtwarzania 
wymowy, można za pomocą strzałki wybrać . Aby 
usłyszeć zeskanowane słowa, należy podświetlić 
ikonkę  oraz nacisnąć . Aby przejść do Input 
Screen, należy nacisnąć . 

Dictionary Screen 
Dictionary Screen pojawia się po zeskanowaniu 
pojedynczego słowa lub po wybrani słowa ze ekranu Split 
Screen. 
Dictionary Screen pojawia się po zeskanowaniu 
pojedynczego słowa lub po wybrani słowa ze ekranu Split 
Screen. 
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 Za pomocą klawiszy  i  można przewijać tekst 

definicji.  
 Używając klawiszy  i  można wybrać spośród 

dwóch wersji wyświetlania. 
  Jeżeli wybrany słownik posiada funkcję odtwarzania 

wymowy, należy nacisnąć  aby usłyszeć wymowę 
wybranego słowa. 

 Aby powrócić do ekranu ze zeskanowym tekstem 
(Split Screen), należy wybrać . 

Menu Quicktionary 
 Quicktionary posiada dwa menu: Quicktionary Menu 
oraz Edit Menu. 
Quicktionary Menu 
Aby wyświetlić Quicktionary Menu, należy w Input 
Screen nacisnąć . Aby powrócić z Quicktionary Menu 
do Input Screen należy nacisnąć . 

Dictionary 
Podmenu Dictionary zawiera słowniki. 

History 
Ta opcja pozwala wyświetlać archiwum ostatnich 80 
wyświetleń. Po zapełnieniu listy najstarsze hasła zostaną 
wykasowane z pamięci.  

Aby wybrać słowo z listy archiwum i zobaczyć jego definicję, 
należy: 
1.Wybierz Dictionary, a następnie History. 
2. Po odnalezieniu wybranego słowa, naciśnij . Słowo 
pojawi się w Dictionary Screen 
3. Aby powrócić do archiwum naciśnij . 
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Adjacent Entries 
Ta opcja pozwala wyświetlać listę pokrewnych haseł we 
włączonym słowniku, zaczynając od ostatniego 
podświetlonego lub wybranego z archiwum słowa. Natomiast 
jeżeli jest pierwsze wyszukiwanie, wyświetli się pierwsze 
słowo słownika. 

1. Wybierz Dictionary, a następnie Adjacent 
Entries. 

2. Przewijaj listę, aby odnaleźć słowo. Wybierz . 
3. Słowo pojawi się w Dictionary Screen. 
4. Aby powrócić do listy wybranych haseł, wybierz 

.  
Select Dictionary 
Ta opcja służy do wyświetlania i wybierania dostępnych 
słowników. Opcja ta działa tylko na tłumaczach, na których 
zainstalowane są co najmniej dwa słowniki. 

Reset History 
Ta opcja służy do wymazywania haseł z archiwum. 

1. W Dictionary wybierz Reset History. 
2. Pojawi się komunikat „Are you sure?".  
3. Aby wymazać i powrócić do Input Screen, wybierz 

YES.  
4. Aby powrócić do podmenu Dictionary bez 

wymazywania archiwum, wybierz NO. 

Preferences 
Ta opcja pozwala zmieniać ustawienia Quicktionary. Aby 
zaakceptować zmiany, należy nacisnąć . Aby powrócić 
do podmenu Preferences nie dokonując zmian należy 
wybrać . Aby włączyć lub wyłączyć daną funkcję, należy 
nacisnać ,  lub .  oznacza, że funkcja jest 
włączona. 

 Inverse: Opcja służy do skanowania tekstów pisanych 
jasną czcionką na ciemnym tle. Przy włączonej opcji 
Inverse czerwona lampka szybko miga, a na ekranie 
idoczna jest ikonka . 

  Reduced Display: Ustawienia dotyczące szczegółów 
wyświetlania haseł w wybranym słowniku, np. zapisu 
fonetycznego. Po wybraniu Reduced Display niektóre 
elementy będą ukryte.  
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 Auto Speak: Po wybraniu Auto Speak aplikacja 
Quicktionary automatycznie odtwarza zeskanowany 
tekst.  

 Line(s) Per Scroll: Ustawienia dotyczące ilości 
wyświetlanych w aplikacji Quicktionary wierszy. Aby 
zmienić ilość wierszy, należy nacisnąć  lub . 

Guides and Glossaries 
Z tej opcji korzystać można tylko wtedy, gdy wybrany słownik 
zawiera objaśnienia i glosariusze, np. Pronunciation 
Guide, który pomaga zrozumieć symbole fonetyczne 
używane w danym słowniku.  

About 
Zawiera informacje dotyczące wersji aplikacji Quicktionary 
oraz praw autorskich. 

Pen Main Menu 
Z Quicktionary można powrócić do Pen Main Menu.  

Edit Menu 
Edit Mode to tryb, który umożliwia edytowanie 
i wczytywanie tekstu za pomocą klawiatur Character Bar 
lub Opticard. Aby włączyć Edit Mode, należy przejść 
z Input Screen do Edit Menu wybierając .  
Edit Menu posiada 3 opcje: 

Resume Editing 
Opcja powracania do bieżącego pola bez dokonywania 
zmian. Pole pozostaje w trybie Edit Mode.  

Activate Overwrite Mode 
Opcja wpisywania tekstu w miejsce już istniejącego innego 
tekstu. W tym trybie podświetla się pierwsza litera za 
migającym kursorem. Każdy wczytywany tekst zapisuje się 
na miejscu tekstu rozpoczynającego się od podświetlonej 
litery. Przy włączonym Overwrite Mode w menu pojawia 
się opcja Activate Insert Mode. Tekst zostanie wczytany 
w miejcu, w którym miga kursor. 

Clear Text 
Opcja usuwania tekstu z ekranu. 
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Edycja i wczytywanie tekstu 
Aby uruchomić tryb edycji tekstu, należy nacisnąć . 
Podświetlony tekst lub pole zostanie zastąpione zwykłym 
tekstem, na początku którego będzie migać kursor. Aby 
powrócić do normalnego trybu skanowania, należy 
dwukrotnie nacisnąć .  
Przy włączonym trybie Edit Mode można skanować 
i wczytywać tekst na dwa sposoby: 

 za pomocą Character Bar.  
 za pomocą Opticard.  

Character Bar 

 
Character Bar służy do ręcznego wprowadzania lub edycji 
tekstu. Klawiatura jest dostępna wyłącznie wtedy, gdy 
włączony jest tryb Edit Mode. Aby uruchomić Edit Mode, 
należy nacisnąć .  
Tekst wprowadzić można przewijając klawiszami wyboru 
ekran do wybranego miejsca. Aby otworzyć należy wybrać 

. Aby zamknąć Character Bar, należy wybrać .  

Jak używać klawiatury Character Bar 
Klawiatura Character Bar pracuje w dwóch trybach: Insert 
Mode oraz Overwrite Mode, które ustawia się w Edit 
Menu. W ustawieniach automatycznych włączony jest 
Insert Mode. 

 W Insert Mode litery wpisywane w miejscu, w którym 
znajduje się kursor.  

 W Overwrite Mode każdy nowy symbol zastępuje 
podświetlony symbol. 

Używając klawiszy  i  można wybrać dany symbol oraz 
wczytać go naciskając . Aby powrócić do poprzedniego 
ekranu po zakończeniu wpisywania tekstu, należy 
nacisnąć .  
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Opcje Character Bar 
Automatyczne ustawienia Character Bar przewidują 26 liter 
oraz dostęp do cyfr, znaków interpunkcyjnych, wielkich liter 
oraz liter z akcentami/ znakami polskimi 
 i symboli.  

Wprowadzanie Wielkich Liter  
Aby wprowadzić wielką literę, należy przewinąć do danej 
litery oraz nacisnąć . Wyświetlą się opcje wyboru 
mała/duża litera. Należy przewinąć do wybranej litery oraz 
nacisnąć .  
Wprowadzanie liter z akcentami/polskimi znakami 
oraz symboli  
Aby użyć liter z akcentami lub polskimi znakami należy 
przewinąć to danej litery oraz nacisnąć , aby rozwinąć listę 
dostępnych znaków, a następnie potwierdzić naciskając .  

 Wprowadzanie cyfr 
Należy przewinąć do tej ikonki oraz nacisnąć , aby 
wyświetlić klawiaturę numeryczną Character Bar. 

 Wprowadzanie znaków interpunkcyjnych 
Należy przewinąć do tej ikonki oraz nacisnąć , aby 
wyświetlić znaki interpunkcyjne na klawiaturze Character 
Bar. 

 Alfabet  
Aby powrócić do automatycznie ustawionego alfabetu, 
należy przewinąć do tej ikonki oraz nacisnąć C. 

 Usuwanie 
Ta ikonka służy do usuwania podświetlonego znaku. Jeżeli 
w danym polu wykorzystano limit znaków, kursor 
automatycznie wskaże ikonkę usuwania. Wprowadzanie 
kolejnych znaków nie będzie możliwe przed uprzednim 
usunięciem symboli z pola.  

 Spacja 
Aby użyć spacji, należy przewinąć do tej ikonki, a następnie 
nacisnąć . 
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 Tryb wyboru wielu znaków 
Ta ikonka oznacza, że można wprowadzać dowolną ilość 
znaków. Należy przewinąć do wybranego znaku nacisnąć 

. Aby zamknąć Character Bar, należy nacisnąć . 
Naciśnięcie tej ikonki powoduje przejście do trybu wyboru 
pojedynczych znaków. 

 Tryb wybierania pojedynczych znaków 
Ikonka ta oznacza, że przed zamknięciem Character Bar 
można wprowadzić tylko jeden znak. Należy nacisnąć ikonkę, 
aby przejść do trybu wyboru wielu znaków. 

Opticard 

 
Opticard to klawiatura skanująca znajdująca się na tylnej 
obudowie tłumacza.  
Każda litera zeskanowana za pomocą Opticard 
rozpoznawana jest za pomocą przyporządkowanego jej 
kodu kreskowego oraz konwertowana na odpowiedni symbol 
na tłumaczu. 
Opticard służy do edytowania zeskanowanego tekstu lub 
wprowadzania tekstu, którego nie da się zeskanować. Aby 
użyć Opticard należy:  
1. Trzymać tłumacza poziomo tak, aby klawiatura 

skanująca Opticard zwrócona była w stronę tekstu. 
Napis Opticard powinien znajdować się po prawej 
stronie.  

2. Aby uruchomić tryb, należy zeskanować kod Opticard 
znajdujący się w lewym dolnym rogu. Przy 
uruchomionym Opticard Mode lampka na wąskiej 
końcówce tłumacza szybko miga.  

3. Powoli przesuwać klawiaturę skanującą nad 
skanowanymi znakami, od lewej do prawej strony lub na 
odwrót. Znaki pojawią się na wyświetlaczu. 
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Aby wczytać wybrany znak należy: 
 Małe litery: Wskanuj daną literę.  
 Duże litery: Wskanuj Shift i daną literę. 
 Kapitaliki: Aby włączyć Caps Lock dwukrotnie 

wskanuj Shift. 
 Znaki przestankowe: Wskanuj Ctrl i dany znak. 
 Litery z akcentami i polskie znaki: Wskanuj Ctrl 

a potem dany znak. 
 Duże litery z akcentami I polskie znaki : 

Wskanuj Carl, Shift, akcent i odpowiadającą mu 
literę. 

 Spacja: Wskanuj spację. 
 Usuń: Wskanuj Shift i Delete. 

4. Po zakończeniu ponownie wskanuj kod Opticard, aby 
powrócić do normalnego trybu skanowania. 

Hasła słownikowe 
Hasła słownikowe mogą zawierać różne elementy oraz 
wskazówki. Poniższe przykłady pochodzą ze słowników 
angielsko-niemieckiego oraz niemiecko-angielskiego.  
Uwaga: Nie wszystkie słowniki wyposażone są we wspomniane tu 
elementy. 

 
Pełne lub niepełne wyświetlanie haseł 
Za pomocą klawiszy  i  można zmieniać wersje 
wyświetlania haseł. Reduced Display (niepełne 
wyświetlanie) ukrywa pewne elementy, np. zapis fonetyczny. 
Full Display (pełne wyświetlanie) pokazuje pełną wersję 
hasła ze słownika. 
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Ekranu strzałki  
Znajdujące się w dolnym prawym rogu ekranu strzałki 
umożliwiają przewijanie haseł słownikowych w dół i do góry. 

 Strzałka  wskazuje, że hasło wyświetlane jest 
niepełnej wersji (Reduced Display).  

 Strzałka  wskazuje, że hasło wyświetlane jest 
w pełnej wersji (Full Display). 

Word list  
Ikonka pojawia się w prawym górnym rogu Dictionary 
Screen i sygnalizuje, że dla wybranego hasła są jeszcze 
inne definicje. Aby zobaczyć listę słów (Word List), należy 
nacisnąć .  
Word List pojawia się gdy: 

 Zeskanowany wyraz odpowiada więcej niż jednemu 
hasłu w słowniku np. po zeskanowaniu słowa 
„dressing” aplikacja Quicktionary pozwala wybrać 
spośród haseł „dress” i „dressing”.  

 Wybrane słowo to homonim czyli słowo które pisze się 
tak jak inne słowo, ale którego znaczenie jest inne. Po 
zeskanowaniu idiomu lub związku frazeologicznego 
Quicktionary po pierwszym słowie rozpozna całą 
frazę wskaże Word List, zawierającą zarówno frazę, 
jak i pierwsze podświetlone słowo.  

Hasła 

 

 
 

Hasła oraz ich pochodne mogą składać się z wielu członów. 
Powyższe ilustracje obrazują, w jaki sposób wyświetlane są 
wyrazy „special" oraz „ate"(pochodna "eat"). 
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Zapis fonetyczny  

 

Zapis fonetyczny haseł wyświetla się po włączeniu Full 
Display. Aby wyświetlić objaśnienia symboli fonetycznych 
należy w Quictionary Menu wybrać Help, a następnie 
Guides and Glossaries. 

Części mowy 

 
Hasła posiadają oznaczenia wskazujące na kategorie słów, 
do których należą. Na przykład n.–noun (rzeczownik), v.–
verb (czasownik), adj.–adjective (przymiotnik).Niektóre 
wyrazy należą do kilku kategorii – są wtedy kilkakrotnie 
oznaczone. 

Idiomy  

 
Wyrażenia idiomatyczne zazwyczaj składają się z kilku 
wyrazów. Mogą być rozpoznane:  
 bezpośrednio w zdaniu, 
 po odnalezieniu i podświetleniu pierwszego wyrazu 

wyrażenia. 
Aplikacja Quicktionary rozpoznaje wyrażenia idiomatyczne 
podczas skanowania, i automatycznie wyświetla ich 
tłumaczenie po podświetleniu pierwszego wyrazu idiomu np.: 
idiom From A to Z można znaleźć pod hasłem From. 
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Czasowniki Złożone 

 
Jeżeli w skanowanym tekście czasowniki złożone zostały 
rozdzielone: 
1. Tłumaczenie pojawi się razem z ikonką Word List. Po 

wybraniu Word List można uruchomić opcję SPLIT 
VERB. Opcja ta pozwala na wczytanie pierwszgo 
członu rozdzielonego czasownika. 

2. Na ekranie pojawi się komunikat "Scan 1st part". 
Komunikat ten oznacza, że aby odnaleźć tłumaczenie 
całego czasownika wystarczy wczytać jego pierwszy 
człon. 

Aplikacja Quictionary automatycznie rozpoznaje 
rozdzielone czasowniki i łączy ich człony. 
Hasła słownikowe czasowników złożonych wyświetlane są 
po podświetleniu członu, który pojawia się w zdaniu jako 
pierwszy. W zdaniu ihr stellt etwas auf, hasło słownikowe dla 
aufstellen wyświetli się po podświetleniu stellt. 

Złożenia 

 
Po zeskanowaniu złożenia, któremu odpowiada nie jedno, 
ale kilka haseł słownikowych, aplikacja Quicktionary 
rozdziela złożenie, i wyświetla oddzielne hasła dla 
poszczególnych członów. 
Tłumaczenie głównego członu złożenia pojawia się jako 
pierwsze, wraz z ikoną Word List.  
Aby wyświetlić hasło słownikowe innego członu złożenia: 

1. Naciśnij  aby wejść do Dictionary Screen (jeżeli 
zeskanowane zostało więcej niż jedno słowo). 
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2. Naciśnij  aby wyświetlić Word List. 
3. Znajdź wybrane słowo, a następnie naciśnij . 

Przykład: po zeskanowaniu słowa Sprachgemeinschaft, 
pojawi się hasło dla gemeinschaft. Aby zobaczyć hasło dla 
Sprache należy wybrać to słowo z Word List. 

Odtwarzanie skanowanego 
tekstu 
Odtwarzanie skanowanego tekstu może się odbywać 
zarówno za pomocą Split Screen jak i Dictionary Screen . 
Aby ustawić głośność należy w menu Preferences wybrać 
Voice Settings. 
Uwaga: Nie wszystkie słowniki są wyposażone w funkcję 
odtwarzania tekstu. 

Z menu Preferences wybierz opcję Auto Speak . 
Po włączeniu opcji Auto Speak : 

 słowa podświetlone w Split Screen zostaną 
automatycznie odtworzone.  

 słowa skanowane za pomocą Dictionary Screen 
zostaną odtworzone. 

Kiedy opcja Auto Speak nie jest włączona należy: 
 tekst wyświetlony w Split Screen przewijać w lewo, 

aż podświetli się ikonka  Odtworzone zostanie 
całe zeskanowane zdanie. Tekst zostanie ponownie 
odtworzony po naciśnięciu . 

 Nacisnąć , aby odtworzyć wyrazy za pomocą 
Dictionary Screen. 

Wymowa Homografów 
Homografy to wyrazy posiadające tę samą pisownię oraz 
odmienne: pochodzenie, znaczenie, i nierzadko – wymowę, 
tak jak angielskie fair – piękny/targowisko, czy wind 
(wĭnd)/(wīnd).  
Jeżeli wybrany wyraz jest homografem, aplikacja 
Quictionary odtworzy wszystkie warianty wymowy. 



SuperPen™ Professional 

26 

Korzystanie ze słowników 
specjalistycznych 
Niektóre tłumacze zawierają słowniki zwane 
specjalistycznymi. Każdy słownik składa się z kilku 
mniejszych. Lista słowników specjalistycznych znajduje się w 
zakładce Select Dictionary podmenu Dictionary w 
Quicktionary Menu. 

 
Po wybraniu słownika i powrocie do Dictionary na ekranie 
wyświetlą się następujące opcje:  

1. Dictionary Display Order 
Pozwala zmieniać kolejność wyświetlania haseł słowników 
tematycznych.  

 
Aby zmienić kolejność: 

a. Za pomocą klawiszy  i  przewijaj listę aż 
odnajdziesz wybrany słownik.  

b. Naciśnij . Na ekranie pojawią się ikonki . Za 
ich pomocą wybierz miejsce na liście.  

c. Za pomocą klawiszy  i  przenieś słownik w 
wybrane miejsce. 

d. Aby potwierdzić, naciśnij . 

W czasie przeglądania haseł na ekranie pojawia się ikonka 
odpowiadająca słownikowi tematycznemu, z którego 
pochodzi dane hasło. Aby wrócić do Word List i obejrzeć 
hasła pochodzące z innych słowników tematycznych danego 
słownika specjalistycznego, należy nacisnąć ESC. Ikonka 
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odpowiadająca danemu słownikowi wyświetli się po prawej 
stronie ekranu. 

 

2. Select Cross-Ref. Dict. 
Pozwala  wyświetlać odnośniki do haseł z innych słowników 
specjalistycznych znajdujących się w pamęci tłumacza. 
Opcja dostępna tylko wtedy, gdy zainstalowano przynajmniej 
dwa słowniki specjalistyczne tego samego języka. 

Aby wybrać wyświetlanie odnośników: 
a. Za pomocą klawiszy  i  przewijaj listę aż 

odnajdziesz wybrany słownik. 
b. Naciśnij . 

Korzystanie z funkcji Cross-Reference 
Funkcja ta jest dostępna podczas korzystania z Dictionary 
Screen. Aby wybrać wyświetlanie odnośników z bieżącego 
słownika: 

a. Naciśnij  aby uruchomić Highlight Mode.  
b. Przewijaj definicję używając klawiszy wyboru. Każde 

kolejne słowo zostanie podświetlone osobno. 
c. Naciśnij   aby wyświetlić odnośnik dla danego 

słowa. 
d. Aby powrócić do hasła głównego naciśnij . Jeżeli 

po naciśnięciu   powracasz do Word List, 
ponownie naciśnij . 

e. Aby wyłączyć tryb wyświetlania odnośników ponownie 
naciśnij . 

Sposoby wyświetlania odnośników 
Istnieją dwa sposoby wyświetlania odnośników  - 
wewnętrzny i zewnętrzny. Podczas przewijania haseł w 
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Highlight Mode, wewnętrzne wyświetlanie sygnalizuje 
podkreślenie, zewnętrzne wyświetlanie sygnalizuje 
podkreślenie. 
1. Internal Cross-Reference: Wyświetlanie wewnętrzne 

odsyła do odnośników w danym słowniku 
specjalistycznym.  

2. External Cross-Reference: Wyświetlanie zewnętrzne 
odsyła do odnośników w wybranym słowniku. 

Odtwarzanie słów w trybie Highlight Mode 
Wybrane słowniki wyposażone są w opcję odtwarzania 
definicji I tłumaczeń haseł w trybie Highlight Mode.  
W tę opcję wyposażone są słowniki, których język jest 
zgodny z językiem odtwarzania tłumacza, na przykład 
słowniki angielsko-angielskie. 
 Aby odtworzyć wybrane słowo w Highlight Mode należy 
przytrzymać  .  
Uwaga: Wyświetlanie odnośników jest możliwe tylko w 
przypadku słowników specjalistycznych. 
 
 

Notes Application 

 
Pozwala skanować i przechowywać drukowany tekst (książki, 
czasopisma) jako notatkę. Aplikacja Notes  znajduje się w 
Pen Main Menu.  

Aby utworzyć nową notatkę, należy wybrać New File 
w Notes Menu (wyświetla się po otwarciu aplikacji). Aby 
zatytułować notatkę można zeskanować nazwę, lub wybrać 
nazwę domyślną. 
Na ekranie pojawi się migający kursor, oznaczający, że 
można rozpocząć skanowanie:  
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Skanowany tekst podświetli się. Jeżeli skanowany tekst jest 
niewyraźny, można go wymazać naciskając  (tekst musi 
być wciąż podświetlony). W innym przypadku należy 
kontynuować skanowanie. 
Aby wczytać tekst w wybranym miejscu ekranu, należy 
przesunąć kursor za pomocą klawiszy wyboru. Skanowany 
tekst wyświetli się w miejscu oznaczonym kursorem. 
Tekst można przewijać za pomocą klawiszy wyboru. Nowy 
akapit można wprowadzić za pomocą klawisza . 

Notes – Scanning Language 
Aplikacja Notes posługuje się domyślnym językiem 
skanowania, dopóki ustawienia nie zostaną zmienione. Aby 
zmienić ustawienia należy w podmenu Preferences zmienić 
Scanning Language. Aby zmienić język skanowania dla 
jednego pliku, nie zmieniając ustawień domyślnych, należy 
w Edit Menu wybrać Select Language. 
Edycja i wprowadzanie tekstu 
Aby edytować lub wprowadzić tekst należy: 

 Nacisnąć, aby dostać się do Edit Menu.  
 Nacisnąć, aby uruchomić Character Bar i ręcznie 

wprowadzać tekst.  
 Nie wykonywać żadnych ruchów i skanować za 

pomocą klawiatury skanującej Opticard. 

Więcej informacji na ten temat znajduje się w rozdziale 
Edycja i wprowadzanie tekstu na stronie 18. 
 
Przesyłanie plików Notes na komputer 
Aby przesłać pliki z Aplikacji Notes na komputer, należy 
uruchomić program WizCom Desktop, za pomocą kabla 
USB połączyć komputer z tłumaczem, w Pen Main Menu 
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wybrać opcję Quick Link. Aby zmienić ustawienia domyślne 
dotyczące przesyłu danych, należy postępować zgodnie ze 
wskazówkami znajdującymi się na stronie 50. 

Notes Menu 

 
Notes Menu posiada opcje opisane poniżej. Aby powrócić 
do Notes Menu z otwartego pliku należy dwukrotnie 
nacisnąć .  
Edit Current File 
Pozwala otworzyć I edytować ostatni używany plik.  
New File 
Pozwala tworzyć nowe pliki. Po zeskanowaniu nazwy należy 
wybrać OK. Pojawi się ekran skanowania. 
Open File 
Pozwala otwierać i edytować istniejące pliki. 
Delete File 
Pozwala usuwać pliki. 
Beaming 
Pozwala przesyłać I odbierać dane za pomocą portu 
podczerwieni. 
Pliki mogą być przesyłane z i do urządzeń takich jak 
Palmtopy i telefony typu Smartphone. 
1. Wysyłanie plików Notes 

a. Otwórz plik, który ma zostać wysłany. Powróć do 
Notes Menu.  

b. W Notes Menu wybierz Beaming I naciśnij . 
c. W menu Beaming wybierz Send Note. 
d. Sprawdź, czy włączony został port podczerwieni 

urządzenia, na które chcesz przesłać plik. 
e. Zbliż do siebie porty podczerwieni obu urządzeń. 
f. Poczekaj na komunikat potwierdzający nawiązanie 

połączenia. 
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2. Odbieranie plików Notes 
a. W Notes Menu wybierz Beaming I naciśnij . 
b. W menu Beaming wybierz Receive Note.  
c. Zbliż do siebie porty podczerwieni obu urządzeń. 
d. Rozpocznij przesyłanie na urządzeniu, z którego 

chcesz przesłać plik. 
e. Poczekaj na komunikat potwierdzający nawiązanie 

połączenia. 
f. Plik otworzy się na ekranie tłumacza, i zostanie 

automatycznie zapisany. 
Exit 
Pozwala zakończyć pracę Notes I powrócić do Pen Main 
Menu.  
About 
/Zawiera informacje dotyczące wersji aplikacji Quicktionary 
oraz praw autorskich. 

Notes Edit Menu 

 
Aby wejść do Edit Menu: 
1. Przewiń do pliku, który chcesz edytować za pomocą 

menu Open File w Notes Menu, a następnie naciśnij 
.  

2. Plik otworzy się na ekranie. Aby wyjść z Edit Menu, 
naciśnij . 

 Edit Menu posiada następujące opcje: 
Resume Editing 
Powrót do bieżącego pola bez zapisywania zmian. Pole 
postaje w trybie Edit Mode.  

Activate Overwrite Mode 
Opcja wpisywania tekstu w miejsce już istniejącego innego 
tekstu. W tym trybie podświetla się pierwsza litera za 
migającym kursorem. Każdy wczytywany tekst zapisuje się 
na miejscu tekstu rozpoczynającego się od podświetlonej 
litery. Przy włączonym Overwrite Mode w menu pojawia 
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się opcja Activate Insert Mode. Tekst zostanie wczytany 
w miejscu, w którym miga kursor. 
New Paragraph 
Opcja rozpoczynania nowego akapitu. 
Delete Paragraph 
Usuwanie bieżącego akapitu. 
Select Language 
Opcja pozwalająca dostosować język do skanowanego 
tekstu. Język skanowanego tekstu można zmienić tylko po 
uprzednim wyczyszczeniu pola. Wybrany język będzie 
używany do momentu, gdy zostanie ponownie zmieniony.  
Scanning Options 
W ramach aplikacji można zmieniać ustawienia skanowania. 
Ustawienia te zostaną zachowane dla następnych plików do 
momentu, kiedy dane ustawienie zostanie włączone lub 
wyłączone za pomocą ,  lub .  oznacza, że funkcja 
jest włączona.  

 Numeric: opcja służąca do skanowania wyłącznie cyfr. 
Kiedy jest włączona inne znaki nie zostaną poprawnie 
zeskanowane. 

  Inverse: opcja pozwalająca skanować teksty pisane 
jasną czcionką na ciemnym tle. 

Aplikacja Address Book 

 
Aplikacja Address Book służy do przechowywania adresów 
oraz przesyłania ich na komputer przy pomocy 
oprogramowania WizCom Desktop. Do Address Book 
wchodzi się z Pen Main Menu. 

Język skanowanych adresów 
Address Book używa automatycznych ustawień Scanning 
Language w menu Preferences. Język skanowania 
zmienić można w menu Preferences.  
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Edytowanie i wczytywanie tekstu w pola 
Address Book 
Aby wprowadzać i edytować tryb należy uruchomić Edit 
Mode przewijając pole oraz naciskając . Podświetlony 
tekst zostanie zastąpiony zwykłym tekstem z migającym 
kursorem na początku pola. Aby powrócić do normalnego 
trybu skanowania, należy nacisnąć .  
Przy włączonym trybie Edit Mode tekst edytować można na 
dwa sposoby: 
1. za pomocą  klawiatury Character Bar.  
2. za pomocą  klawiatury skanującej Opticard.  

Więcej informacji dotyczących używania klawiatur Character 
Bar and Opticard znajduje się na str. 18 w rozdziale Edycja i 
Wczytywanie Tekstu. 

Przesyłanie adresów na komputer 
Aby przesłać adresy na komputer, należy uruchomić 
program WizCom Desktop, połączyć komputer 
z tłumaczem kablem USB oraz wybrać QuickLink w Pen 
Main Menu. Informacje dotyczące zmieniania 
automatycznych ustawień przesyłania plików znajdują się na 
stronie 50 w dziale Ustawienia przesyłu Danych Programu 
WizCom Desktop. 

Address Book Menu 

 
Address Book Menu zawiera następujące opcje:  
New Address 
Wpisywanie nowego adresu 
1. Zeskanuj wybrany adres do odpowiedniego pola. Po 

zeskanowaniu kursor przeskoczy do następnego pola.  
2. Wybierz OK. 
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View Addresses 
Opcja pozwalająca wyświetlać zachowane adres. Listę 
adresową można przewijać za pomocą klawiszy wyboru. Po 
podświetleniu adresu: 
1. Naciśnij , aby zobaczyć pełny tekst. Aby otworzyć 

pole do edycji adresu, ponownie naciśnij .  
2. Aby wejść do Addresses Menu, naciśnij . 
      Addresses Menu sluży do: 

1. odnajdowania adresów (Find Address) 
2. wybierania języka Select Search Language 
3. usuwania adresów (Delete Address) 
4. wyświetlania adresów (View Address) 
5. edytowania adresów (Edit Address) 

Settings 
Ustawienia automatyczne dla nowych adresów można 
zmieniać używając. ,  lub .  oznacza że funkcja 
jest włączona. 

 Scroll Screen: Po wybraniu Scroll Screen ekran 
będzie się przewijać (nie przeskawiwać) aż do 
następnego pola.  

 Auto Advance: Po wybraniu Auto Advance ekran 
automatycznie przejdzie w następne pole. 

  AutoName: Po wybraniu AutoName imię i nazwisko 
zostaną równocześnie zeskanowane, a zeskanowany 
tekst zostanie automatycznie przesłany do pól First 
Name i Last Name.  

 Next Address Lang.: Zmiana języka na język 
kolejnego adresu.. 

 Select Fields: Wybieranie pola na przechowywanie 
informacji o adresie.  

 Field Settings: Lista pól, na których przechowywane 
są informacje o adresie. 

New File 
Do przechowywania wszystkich zeskanowanych adresów 
Address Book używa pliku mainadd. Plik ten jest jedynym 
plikiem, który jest zsynchronizowany z komputerem w funkcji 
QuickLink. Tworzenie nowych plików w celu porządkowania 
adresów jest możliwe, ale pliki te nie będą mogły być 
przesyłane na komputer.  
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Open File 
Otwieranie istniejącego pliku do przechowywania adresów.  

Delete File 
Usuwanie plików. Po usunięciu bieżącego pliku, należy 
otworzyć inny plik, aby móc kontynuować skanowanie.  
Uwaga: Pliku mainadd nie można usunąć.  

Beaming 
Adresy można wysyłać i odbierać przez port podczerwieni. 
Pliki przesyłać można przy pomocy urządzeń ze 
zintegrowanym modułem podczerwieni (IrOBEX), takimi jak 
palmtopy oraz telefony typu smartphone. 
1. Wysyłanie adresów 

a. W Address Book Menu przewiń do Beaming, 
a następnie wybierz . 

b. Z podmenu Beaming wybierz Send Address. 
c. Włącz port podczerwieni 
d. Zbliż do siebie porty podczerwieni obu urządzeń. 
e. Przewiń do adresu, który chcesz wysłać, 

a następnie naciśnij . 
f. Czekaj na potwierdzenie, które wyświetli się na 

tłumaczu. 
2. Odbieranie adresów 

a. W Address Book Menu przewiń do Beaming, 
a następnie wybierz . 

b. Z podmenu Beaming wybierz Receive Address. 
c. Zbliż do siebie porty podczerwieni obu urządzeń 

Czekaj na potwierdzenie, które wyświetli się na 
tłumaczu. 

d. Adres otworzy się na ekranie i zostanie 
automatycznie zapisany w pamięci. 

3. Wysyłanie wizytówek 
Wizytówki wysyłać wyłącznie używając pliku mainadd. 
Aby otworzyć plik mainadd: 
a. W Address Book Menu wybierz Open File. 
b. Przewiń w dół do mainadd , a następnie naciśnij 

.  

Aby wysyłać wizytówkę, trzeba najpierw wybrać adres, 
który ma się na niej znaleźć. 
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a. W aplikacji Address Book przewiń w dół do 
Beaming, a następnie wybierz . 

b. Z  podmenu Beaming wybierz  Select Business 
Card.  

c. Przewiń w dół do pliku, którego chcesz użyć, 
a następnie naciśnij .  

Następnie: 
a. W aplikacji Address Book przewiń w dół do 

Beaming a następnie naciśnij .  
b. Włącz port podczerwieni 
c. Włącz port podczerwieni 
d. Zbliż do siebie porty podczerwieni obu urządzeń Z 

podmenu  Beaming wybierz Send Business 
Card.  

e. Czekaj na potwierdzenie, które wyświetli się na 
tłumaczu. 

Exit 
Wyjście z aplikacji Address Book.  
About 
Zawiera informacje dotyczące wersji aplikacji Address Book 
oraz praw autorskich. 

Address Book Edit Menu 

 
Należy uruchomić tryb Edit Mode naciskąjąc  oraz 
przewinąć do pola, które ma być zapisane, a następnie 
nacisnąć , aby wejść do Edit Menu.  

Resume Editing 
Opcja powracania do bieżącego pola bez dokonywania 
zmian. Pole pozostaje w trybie Edit Mode.  

Activate Overwrite Mode 
Opcja wpisywania tekstu w miejsce już istniejącego innego 
tekstu. W tym trybie podświetla się pierwsza litera za 
migającym kursorem. Każdy wczytywany tekst zapisuje się 
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na miejscu tekstu rozpoczynającego się od podświetlonej 
litery. Przy włączonym Overwrite Mode w menu pojawia 
się opcja Activate Insert Mode. Tekst zostanie wczytany 
w miejscu, w którym miga kursor. 

Insert Line 
Wstawianie dodatkowego wiersza do bieżącego wiersza.  

Delete Line 
Usuwanie wiersza z danego pola. Jeżeli tekst ma tylko jeden 
wiersz, zostanie on w całości usunięty.  

Clear Line 
Usuwanie tekstu z bieżącego pola.  

Scanning Options 
Opcja pozwalająca zmieniać ustawienia dla danego pola. 
Aby wejść do tego menu podczas skanowania, należy 
nacisnąć  .Ustawienia można zmieniać naciskając ,  
lub .  oznacza że funkcja jest włączona. 

 Numeric: opcja służąca do skanowania wyłącznie 
cyfr. Kiedy jest włączona inne znaki nie zostaną 
poprawnie zeskanowane. 

  Inverse: opcja pozwalająca skanować teksty 
pisane jasną czcionką na ciemnym tle. 

 Multiple Lines: Opcja wskanowywania do pola 
wielowierszowego tekstu   

Aplikacja Internet Links  

 
Aplikacja ta pozwala przechowywać adresy URL oraz, za 
pomocą WizCom Desktop, przesyłać je na komputer. Aby 
uruchomić aplikację, należy odnaleźć ją w Pen Main Menu. 

. 
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Język Skanowania Internet Links 
Aplikacja Internet Links posługuje się domyślnym 
językiem skanowania. Język można zmienić wybierając 
Scanning Language w menu Preferences. 
 
 

Edycja i Wprowadzanie Tekstu do Pól 
Aplikacji Internet Links 
Aby wprowadzić tekst w wybrane pole, lub edytować go, 
należy odnaleźć to pole, po czym wcisnąć . Uruchomi się 
tryb edycji (Edit Mode). Na podświetlonym polu pojawi się 
tekst, poprzedzony migającym kursorem. Aby powrócić do 
trybu skanowania należy dwukrotnie nacisnąć .  
 
Kiedy uruchomiony jest Edit Mode, tekst może być poddany 
edycji na dwa sposoby: 

1. Za pomocą klawiatury Character bar. 
2. Za pomocą klawiatury skanującej Opticard.  

Więcej informacji na ten temat znajduje się w rozdziale 
Edycja i Wprowadzanie Tekstu na stronie 18. 
 
Przesyłanie Plików Aplikacji Internet 
Links na Komputer 
Aby przesyłać zeskanowane linki na komputer należy 
uruchomić program WizCom Desktop, za pomocą kabla 
USB połączyć komputer z tłumaczem, w Pen Main Menu 
wybrać opcję Quick Link.   
Aby zmienić ustawienia domyślne dotyczące przesyłu 
danych, należy postępować zgodnie ze wskazówkami 
znajdującymi się na stronie 50.   

Internet Links Menu 
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Menu aplikacji Internet Links posiada opisane poniżej 
opcje: 

New Link 
Tworzenie nowego adresu URL.  

1. Zeskakuj adres strony do pola Internet Link. Po 
zakończeniu tej czynności kursor automatycznie 
pojawi się w następnym polu. 

2. Zeskanuj opis adresu strony do pola Description, po 
czym wybierz OK. 

View Links 
Pozwala przeglądać przechowywane linki. Po wybraniu za 
pomocą klawiszy wyboru link zostanie podświetlony. Wtedy: 
1. Naciśnij  aby obejrzeć link I jego opis. Aby edytować 

link ponownie naciśnij .  
2. Naciśnij  aby dostać się do Links Menu, które 

pozwala na: 
1. kasowanie - Delete Link 
2. przeglądanie - View Link  
3. edytowanie - Edit Link 

Settings 
Pozwala zmieniać ustawienia domyślne, przy użyciu 
klawiszy  ,  lub . Ikonka   oznacza, że dane 
ustawienie zostało wybrane.  

 Scroll Screen: po zeskanowaniu tekstu kursor 
przewija się do następnego pola. 

 Auto Advance: Po zeskanowaniu tekstu kursor 
pojawia się w nowym polu. 

 AutoDescribe: Opis automatycznie kopiuje się z pola 
Link Description. 

 Next Link Language: Zmienia język skanowania do 
pola Description.  

New File 
Aplikacja Internet Links przechowuje skanowane pliki 
w pliku mainlink. Plik ten jest jedynym plikiem, który Quick 
Link przesyła na komputer. Nowe pliki mogą służyć 
porządkowaniu linków, nie będą jednak przesyłane na 
komputer. 
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Open File 
Ta opcja umożliwia dostęp do utworzonych linków i plików, w 
których są przechowywane. Pozwala też wybierać pliki, 
w których przechowywane będą linki. 

Delete File 
Pozwala na usuwanie utworzonych plików. Po usunięciu 
pliku należy utworzyć nowy plik aby móc rozpocząć 
skanowanie. 
Uwaga: Pliku mainlnk nie da się usunąć. 

Exit 
Zamyka aplikację Internet Links. 

About 
Informacje na temat wersji I praw autorskich.  

Internet Links Edit Menu 

 
Aby dostać się do Edit Menu, należy zaznaczyć wybrane 
pole, wcisnąć  aby  uruchomić Edit Mode oraz wcisnąć 

.Edit Menu posiada opisane poniżej opcje . 

Resume Editing 
Powrót do używanego pola bez dokonywania zmian. Pole 
pozostanie w trybie Edit Mode.  
Activate Overwrite Mode 
Pozwala skasować stary tekst wpisując nowy. W tym trybie 
na ekranie pojawi sie migający kursor, poprzedzający 
zmieniany tekst. 
Kiedy tryb Overwrite Mode jest włączony, opcja menu 
zmienia się na Activate Insert Mode. Tekst zostanie 
wprowadzony w miejscu, w którym miga kursor. 
Insert Line 
Pozwala wydłużyć pole o jeden wiersz.  
Delete Line 
Pozwala usuwać wiersze z pól. Jeżeli pole ma tylko jeden 
wiersz, tekst pola zostanie skasowany. 
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Clear Line 
Pozwala kasować tekst w używanym polu. 
Scanning Options 
Pozwala zmieniać ustawienia pól. To ustawienie można 
wybrać podczas skanowania za pomocą klawiszy ,  
i . Ikonka  oznacza, że ustawienie zostało wybrane.  

 Numeric: Wybierz by skanować liczby. To 
ustawienie nie powala na skanowanie zwykłego 
tekstu. 

 Inverse: Wybierz by skanować jasny tekst na 
ciemnym tle. 

 Multiple Lines: Wybierz by skanować do jednego 
pola tekst zapisany w kilku wierszach. 

Aplikacja Tables 

 
Aplikacja Tables pozwala przechowywać informacje 
w formie tabel oraz przesyłać je na komputer za pomocą 
programu WizCom Desktop. Aby uruchomić aplikację 
należy odnaleźć ją w Pen Main Menu. 

Język skanowania Tables Files 
Aplikacja Tables posługuje się domyślnym językiem 
skanowania. Język można zmienić wybierając Scanning 
Language w menu Preferences  
Edycja i wprowadzanie tekstu do Tables 
Cells 
Aby wprowadzić tekst do wybranej komórki lub edytować go 
należy odnaleźć ją, po czym wcisnąć . Uruchomi się tryb 
edycji (Edit Mode). W podświetlonej komórce pojawi się 
zwykły tekst, poprzedzony migającym kursorem. 
Aby powrócić do trybu skanowania należy dwukrotnie 
wcisnąć . 
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Kiedy uruchomiony jest tryb Edit Mode, tekst może być 
poddany edycji na dwa sposoby: 

1. Za pomocą klawiatury Character Bar.  
2. Za pomocą klawiatury skanującej Opticard.  

Więcej informacji na ten temat znajduje się w rozdziale  
Edycja i Wprowadzanie Tekstu na stronie 18. 

Przesyłanie plików Aplikacji Tables na 
komputer 
Aby przesłać pliki aplikacji Tables na komputer należy 
uruchomić program WizCom Desktop, za pomocą kabla 
USB połączyć komputer z tłumaczem, w Pen Main Menu 
wybrać opcję QuickLink Bz zmienić ustawienia domyślne 
dotyczące przesyłu danych, należy postępować zgodnie 
z wskazówkami znajdującymi się w rozdziale Ustawienia 
przesyłu Danych Programu WizCom Desktop na stronie 
50.  

The Tables Menu 

 
Tables Menu posiada opisane poniżej opcje. 
Edit Current File 
Pozwala otworzyć i poddać edycji ostatnio używany plik.  
Settings 
Pozwala zmieniać ustawienia domyślne plików aplikacji 
Tables przy użyciu klawiszy ,  i . Ikonka oznacza, 
że dane ustawienie zostało wybrane.  

 Scroll Screen: Po wybraniu tej opcji skanowany 
tekst będzie się przewijał do kolejnych komórek 
tabeli. 

 Auto Advance: Po wybraniu tej opcji skanowany 
tekst będzie się pojawiał w kolejnych komórkach 
tabeli. 

New File 
Tworzenie nowego pliku. Zeskanuj nazwę pliku i wybierz OK. 
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Pojawi się tabelaryczny ekran. Aplikacja Tables rozpoczyna 
zapisywanie danych od komórki A1, znajdującej się w 
górnym lewym rogu tabeli.  
Open File 
Otwieranie  istniejącego pliku. 
Delete File 
Usuwanie plików. 
Exit 
Zamykanie aplikacji Tables. 
About 
Informacje na temat wersji i praw autorskich. 

Tables Edit Menu 

 
Aby dostać się do Edit Menu, należy zaznaczyć wybrane 
pole, wcisnąć  aby uruchomić Edit Mode oraz wcisnąć 
ESC. Tables Edit Menu posiada opisane poniżej opcje. 
Resume Editing 
Powrót do używanego pola bez dokonywania zmian. Pole 
pozostanie w trybie Edit Mode.  
Activate Overwrite Mode 
Pozwala skasować stary tekst wpisując nowy. W tym trybie 
na ekranie pojawi się migający kursor, poprzedzający 
zmieniany tekst. 
Kiedy tryb Overwrite Mode jest włączony, opcja menu 
zmienia się na Activate Insert Mode. Tekst zostanie 
wprowadzony w miejscu, w którym miga kursor. 
Clear Line 
Pozwala kasować tekst w używanym polu. 
Select Language 
Pozwala zmienić język używanej komórki. Język można 
zmienić tylko wtedy, gdy komórka jest pusta. Jeżeli komórka 
zawiera tekst, musi on zostać skasowany przed próbą 
zmiany języka. Język skanowania można zmienić tylko dla 
używanej komórki. 
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Scanning Options 
Pozwala zmieniać ustawienia pól. To ustawienie można 
wybrać podczas skanowania za pomocą klawiszy ,  
i . Ikonka  oznacza, że ustawienie zostało wybrane.  

 Numeric: Wybierz by skanować liczby. To 
ustawienie nie powala na skanowanie zwykłego 
tekstu. 

 Inverse: Wybierz by skanować jasny tekst na 
ciemnym tle. 

 Multiple Lines: Wybierz by skanować do jednego 
pola tekst zapisany w kilku wierszach. 

Insert Row 
Pozwala wydłużyć tabelę o jeden rząd. Rząd zostanie 
dodany poniżej rzędu z zaznaczoną komórką. 
Insert Column 
Pozwala poszerzyć tabelę o jedną kolumnę, Kolumna 
zostanie dodana obok kolumny z zaznaczoną komórką. 
Remove Row 
Pozwala usunąć rząd z zaznaczoną komórką. 
Remove Column 
Pozwala usunąć kolumnę z zaznaczona komórką. 
Insert Line 
Pozwala wydłużyć komórkę o jeden wiersz.  
Delete Line 
Pozwala usuwać wiersze z komórek. Jeżeli komórka ma 
tylko jeden wiersz, tekst komórki zostanie skasowany. 

Aplikacja Scan to PC  

 
Aplikacja Scan to PC pozwala przesyłać skanowany tekst 
bezpośrednio na komputer. Skanowany tekst może być 
przesyłany do jakiegokolwiek pliku lub programu, w którym 
miga kursor. Aby uruchomić aplikację Scan to PC należy 
odnaleźć ją w Pen Main Menu. 
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Scan to PC działa w ten sam sposób co standardowe 
edytory tekstów uwzględniając opcje INSERT i OVERWRITE. 
Używanie aplikacji  Scan to PC nie zakłóca działania 
aplikacji Windows.  
Aplikacja Scan to PC działa tylko wtedy, gdy na komputerze 
uruchomione jest oprogramowanie WizCom Desktop. 
Jeżeli nie jest otwarta żadna aplikacja zgodna ze Scan to 
PC , tekst zostanie wysłany z tłumacza, nie będzie jednak 
dostępny na komputerze. Okno programu WizCom 
Desktop może być zminimalizowane (ikonka  na pasku 
zadań oznacza, że program nadal działa). 
Aby uruchomić aplikację Scan to PC:  

1. Na komputerze uruchom program WizCom 
Desktop. 

2. Upewnij się, że tłumacz jest podłączony do 
komputera za pomocą kabla USB. 

3. Upewnij się, że nawiązane zostało połączenie 
komputer-tłumacz. Jeżeli nie można nawiązać 
połączenia, uruchom program Communications 
Wizard w menu Help z WizCom Desktop Menu 
Bar.  

Uwaga: Jeżeli pojawią się problemy z nawiązaniem 
połączenia, wróć do rozdziału  Nawiązywanie 
połączeń komputer-tłumacz na stronie 9. 
4. Z menu tłumacza Pen Main Menu  wybierz opcję 

Scan to PC. Aplikacja otworzy się na ekranie 
skanującym (można rozpocząć skanowanie). 

5. Naciśnij ESC, aby zakończyć skanowanie i 
wyłączyć Scan to PC. 

 Uwaga: Aplikacja Scan to PC może być niekompatybilna 
z niektórymi aplikacjami systemu Windows. Jeżeli korzystasz 
z opcji „Send Immediately” (przesyłaj od razu) i występuję 
błąd podczas przesyłania, spróbuj wyłączyć funkcję „Send 
Immediately” w ustawieniach okna „Scan text to the PC”, 
zeskanować fragment dowolnego tekstu do docelowego 
dokumentu (zeskanuj i naciśnij ) i jeżeli operacja się 
powiedzie ponownie ustawić funkcję „Send Immediately”. 
Jeżeli nie uda Ci się przesłać spróbuj jeszcze raz po zmianie 
ustawienia na „Send Immediately”. 
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Tryby Aplikacji Scan to PC  
 Aplikacja Scan to PC posiada dwa tryby skanowania: Send 
Immediately i Deferred Sending. 
Send Immediately 
Kiedy w menu Scan to PC Settings wybrana jest opcja 
Send Immediately , skanowany tekst jest przesyłany 
bezpośrednio do pliku lub programu z migającym kursorem 
na komputerze.Ten tryb jest domyślnym trybem skanowania. 
Deferred Sending 
Kiedy w menu Scan to PC Settings opcja Send 
Immediately nie jest wybrana, skanowany tekst wyświetla 
się na ekranie tłumacza, a użytkownik może zdecydować 
czy przesłać tekst na komputer, usunąć go czy ponownie 
zeskanować. 

 Aby przesłać tekst wciśnij .  
 Aby przesłać więcej niż jeden wiersz, po zeskanowaniu 

jednego wiersza wciśnij ,aby zachować tekst i 
kontynuować skanowanie. 

 Wciśnij kiedy chcesz zachować tekst. Po zakończeniu 
skanowania wciśnij , aby przesłać dane na 
komputer. 

Scan to PC Settings on the Pen 
Aplikacja Scan to PC uruchamia sie bezpośrednio na 
ekranie skanującym. Aby zmienić tryb skanowania Scan to 
PC lub ustawienia domyślne należy wybrać menu Settings. 
Menu Settings posiada opisane poniżej opcje: 
Send Immediately 
Pozwala przesyłać tekst bezpośrednio na komputer. 
Ustawienie Send Immediately można zmienić za pomocą 
klawiszy ,  lub . Ikonka  oznacza, że ustawienie 
zostało wybrane.  
Scanning Options 
Pozwala zmieniać ustawienia domyślne przy użyciu klawiszy 

, lub . Ikona  oznacza, że dane ustawienie zostało 
wybrane.  

 Numeric: Wybierz by skanować liczby. To ustawienie 
nie powala na skanowanie zwykłego tekstu. 

 Inverse: Wybierz by skanować jasny tekst na ciemnym 
tle.  
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About 
Informacje na temat wersji i praw autorskich. 

Ustawienia aplikacji Scan to PC 
Settings w programie WizCom Desktop 
Scan to PC Settings programu WizCom Desktop 
pozwala ustalić jaki znak ma się pojawiać na ekranie 
komputera po zeskanowaniu kolejnych wierszy tekstu. 
Ustawieniem domyślnym jest Space (po zeskanowaniu 
kolejnych wierszy na ekranie pojawia się spacja). 
Ustawienia Scan to PC Settings dostępne są w menu Pen 
Communications w WizCom Desktop Menu Bar. 
Klawisze, które Scan to PC Settings pozwala wybrać po 
zeskanowaniu kolejnych wierszy: 

 Space: Spacja. 
 Tab: Tabulacja. (przy skanowaniu do tabeli programu 

Excel, kursor automatycznie pojawia się w kolejnej 
komórce.)  

 Enter: Kursor pojawia się w nowym wierszu. 
 Nothing: Skanowany tekst pojawi się bezpośrednio po 

wcześniej zeskanowanym. 

Języki skanowania 
Aplikacja Scan to PC posługuje się domyślnym językiem 
skanowania, który określa opcja Scanning Language 
w menu Preferences dostępnego z Pen Main Menu . Aby 
zmienić ustawienia domyślne, należy wejść w menu 
Preferences. 
Jeżeli skanowanie odbywa się w języku innym niż angielski, 
ustawienia Windows (non-unicode programs option) muszą 
zostać tak skonfigurowane, aby odczytywać język 
skanowania. Jeżeli dana wersja oprogramowania Windows 
nie pozwala na odczytywanie znaków specjalnych 
wybranego języka, niektóre znaki nie będą czytelne. 
Ustawienia Języka znajdują się w Panelu Sterowania  
systemu Windows (nazwa aplikacji może się różnić 
w zależności od wersji systemu). 
Klawiatura odpowiadająca językowi skanowania powinna 
zostać uruchomiona w aplikacji systemu Windows, w której 
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odbywa się skanowanie. Język powinien zostać zmieniony 
również w programie WizCom Desktop. 
Aby sprawdzić, czy włączone opcje językowe odpowiadają 
żądanym opcjom, należy uruchomić którąś z aplikacji 
Windows i wprowadzić tekst w wybranym języku. Jeżeli 
wszystkie znaki wyświetlają się prawidłowo, aplikacja jest 
gotowa do rozpoczęcia skanowania. 

QuickLink  

 
Aby przesyłać pliki z tłumacza do aplikacji na komputerze, 
należy w Pen Main Menu wybrać opcję QuickLink. Ta 
opcja pozwala przesyłać pliki aplikacji Notes, Address 
Book, Internet Links oraz Tables. 
Aby uruchomić opcję QuickLink, należy w pierwszej 
kolejności uruchomić na komputerze oprogramowanie 
WizCom Desktop. Okno WizCom Desktop może zostać 
zminimalizowane, program jednak nie może zostać 
wyłączony (ikona  pojawi się w pasku zadań Windows). 
Przed uruchomieniem opcji QuickLink należy 
zmodyfikować ustawienia domyślne programu WizCom 
Desktop wybierając opcję File Transfer Settings z menu 
Pen Communications w Menu Bar.  
Aby przesyłać pliki za pomocą opcji QuickLink:  
1. Podłącz tłumacza do komputera za pomocą kabla USB.  
2. Upewnij się, że połączenie komputer-tłumacz zostało 

ustanowione (patrz rozdział Nawiązywanie połączeń 
komputer-tłumacz na stronie 8).  

3. W Pen Main Menu tłumacza wybierz opcję QuickLink 
i wciśnij . 

4. Na ekranie komputera pojawi się okno dialogowe 
informujące o stanie procesu przesyłania danych. 

5. Po zakończeniu przesyłu na ekranie pojawi się 
komunikat informacyjny.  
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Ustawienia przesyłu Danych Programu 
WizCom Desktop 
Okno dialogowe File Transfer Settings pozwala ustalić co 
stanie się z plikami przesłanymi z tłumacza za pomocą opcji 
QuickLink. 
Jeżeli do tej samej aplikacji Desktop przyłączono więcej niż 
jednego tłumacza, ustawienia można zmieniać oddzielnie 
dla każdego z nich, posługując się przydzielonymi im 
nazwami.  

 
Aby zmienić ustawienia File Transfer Settings:  
1. W menu Menu Bar wybierz menu Pen 

Communications, a następnie menu File Transfer 
Settings. 

2. Sprawdź, czy wybrana jest nazwa tłumacza, którego 
używasz. Jeżeli nie, wybierz nazwę z listy.  

3. Aby wybrać funkcję przesyłu plików dla danej aplikacji 
kliknij dwukrotnie na jej nazwę w tabelce, albo po 
zaznaczeniu nazwy wybierz Change. Na ekranie pojawi 
się menu Change File Transfer Settings. Wyświetla 
ono dostępne dla danej aplikacji opcje. 

4. Zaznacz wybraną opcję, po czym wybierz OK. Powtórz 
dla wszystkich aplikacji. 

5. Jeśli chcesz aby okno dialogowe File Transfer 
Settings pojawiało się przed każdą kolejną operacją 
QuickLink, przed zamknięciem okna dialogowego 
wybierz Show this Dialog before each File Transfer.  

6. Po zakończeniu zamknij menu File Transfer Settings 
wybierając Close.  
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Zmiana ustawień przesyłu danych 
File Transfer Settings posiada cztery opcje dostępne dla 
wybranych aplikacji.  

1. Synchronize Pen and PC: Synchronizuje dane na 
tłumaczu i komputerze. Jeśli zmieniony zostanie 
rekord na komputerze, odpowiadający mu rekord na 
tłumaczu również zostanie zmieniony, a stare dane 
zostaną utracone. Aby usunąć zsynchronizowane pliki 
użyj opcji Flush.  

2. Pen to PC: Kopiuje pliki z tłumacza na komputer, 
zamieniając odpowiadające im pliki na komputerze. 
Aby usunąć zsynchronizowane pliki użyj opcji Flush.  

3. PC to Pen: Zamienia pliki programu Desktop 
i tłumacza w przypadku korzystania z zewnętrznych 
aplikacji (aplikacji Windows). Jeżeli ustawienia 
pozwalające na przesył danych z aplikacji 
zewnętrznych nie zostały wybrane, pliki tłumacza są 
zamieniane na pliki programu Desktop. 

4. Don’t transfer the files of this application: 
Pozostawia pliki na tłumaczu I na komputerze 
niezmienione. 

Synchronizowanie z Aplikacjami 
Zewnętrznymi 
Jeżeli pliki maja być zachowane w formatach pakietu 
Microsoft Office należy uruchomić funkcję Host Settings 
znajdującą się w menu File Transfer Settings. 

1. W Menu Bar programu Desktop wybierz Pen 
Communications, a następnie File Transfer 
Settings. Sprawdź, czy włączona jest opcja This Pen 
Name will transfer files with host applications. 
Uwaga: Tylko jeden tłumacz może być 
synchronizowany z aplikacjami zewnętrznymi. Jeśli 
dany tłumacz nie może być synchronizowany, to 
znaczy, że wybrany został inny tłumacz. W celu 
dokonania zmian należy zaznaczyć żądane 
urządzenie z listy i wybrać je.  

2. Kliknij na Host Settings (aby zmienić ustawienia). 
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3. Sprawdź informacje dotyczące poszczególnych 
aplikacji w kolumnie Host Application.  

4. Kliknij na nazwy poszczególnych aplikacji. Pojawi się 
lista opcji. 

5. Rozwiń listę i zaznacz wybraną opcję. 

PC-Controlled Communications 

 
Opcji PC-Controlled Communications należy używać 
tylko wtedy, kiedy program WizCom Desktop albo 
załączona płyta CD tego wymagają. Opcję tę można wybrać 
z Pen Main Menu.  
Opcja ta pozwala optymalizować pliki systemowe tłumacza, 
sprawdzać połączenia komputer-tłumacz za pomocą 
programu Communications Wizard oraz uruchamiać okno 
dialogowe Add\Remove Pen Components. Opcja ta 
uruchamia się przy instalacji dodatków (spellers, interfejsów 
językowych i słowników) z dołączonej płyty CD.  
Aby uruchomić opcję PC-Controlled Communications 
należy odnaleźć ją w Pen Main Menu oraz wcisnąć . 
Kiedy tłumacz znajdzie się w stanie gotowości, na ekranie 
pojawi się następujący komunikat:  

 
Aby upewnić się czy ustawienia tłumacza i komputera są 
odpowiednio dobrane, należy przejść do rozdziału 
Nawiązywanie połączeń komputer-tłumacz na stronie 9. 
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Preferences Menu 

 
Menu Preferences znajduje się w Pen Main Menu. 
Pozwala zmieniać ustawienia domyślne tłumacza za 
pomocą klawiszy ,  oraz  (opcje powinny być 
podświetlone). Aby powrócić do poprzedniego menu bez 
dokonywania zmian należy wcisnąć . 

Menu Preferences posiada następujące opcje: 

Scanning Language  
Pozwala zmieniać domyślny język skanowania.  

1. Wybierz Scanning Language. 
2. Zaznacz wybrany język i wciśnij .  

Uwaga: Wybrany język skanowania powinien być taki sam jak język 
skanowanego tekstu. Opcja sprawdzania pisowni (w tym znaków 
specjalnych) jest dostępna na dołączonej płycie CD. 

Interface Language  
Pozwala zmieniać język interfejsu. Pliki zawierające języki 
interfejsu znajdują się na dołączonej płycie CD. Aby zmienić 
język interfejsu: 

1. Wybierz Interface Language. 
2. Znajdź wybrany język używając klawiszy  i  po 

czym wciśnij . 
Communications Settings  
Pozwala dostosowywać opcje połączeń komputer-tłumacz. 

Connection Device  
Pozwala wybrać urządzenie łączące tłumacza z 
komputerem (kabel USB lub port podczerwieni). 
Zalecanym urządzeniem jest kabel USB. Aby zmienić: 
1. Wybierz Connection Device. 
2. Znajdź wybrane urządzenie używając klawiszy  i 

po czym wciśnij . 
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Baud Rate  
Pozwala zmieniać prędkość transmisji sygnału (zaleca 
się ustawienie wartości baud rate na 115,200). Aby 
zmienić:  
1. Wybierz Baud Rate. 
2. Jesli wartość Baud Rate wynosi 115,200, zmień 

używając klawisza , a następnie wciśnij . 

Voice Settings   
Pozwala zmieniać ustawienia głosowe tłumacza. Zmienia 
sposób odtwarzania aplikacji Quicktionary. 

Volume  
Pozwala zmieniać głośność urządzenia. Aby zmienić: 
1. Wybierz Volume. Pojawi się pasek ustawienia 

głośności. 
2. Dostosuj głośność używając klawiszy  i  po czym 

wciśnij . 
Pitch  
Pozwala zmieniać wysokość tonu.  
1. Wybierz Pitch. 
2. Dostosuj natężenie używając  i  I wciśnij . 
Reading Speed   
Pozwala zmieniać prędkość odtwarzania. Aby zmienić: 
1. Wybierz Reading Speed. 
2. Dostosuj prędkość używając klawiszy  i po czym 

wciśnij . Im wyższy numer, tym większa 
prędkość. 

Auto Shut-Off Time   
Nieużywany, tłumacz wyłącza się automatycznie po 2 
minutach. Aby zmienić ten czas: 

1. Wybierz Auto Shut-Off Time. 
2. Dostosuj czas używając i po czym wciśnij . 

Right-/Left- Handed   
Pozwala dostosować tłumacza do potrzeb osób 
leworęcznych. Zmiana trybu wyświetlania przekręca ekran 
o 180°. Aby zmienić: 

1. Wybierz Right-/Left- Handed.(Prawo-/Lewo-ręczny). 
2. Zaznacz żądany tryb używając klawiszy  i po 

czym wciśnij . 



SuperPen™ Professional 

54 

Menu Type   
Pozwala zmienić ustawienia wyświetlania menu (tekst/tekst i 
ikonki). Aby zmienić: 

1. Wybierz Menu Type. 
2. Zaznacz żądane ustawienie za pomocą klawiszy  

i  po czym wciśnij . 
Long-Press Interval   
Pozwala ustalić czas przytrzymywania klawiszy potrzebny do 
uzyskania efektu przytrzymania klawiszy. 

1. Wybierz Long-Press Interval. Pojawi się pasek 
regulacji czasu. 

2. Ustaw czas używając klawiszy  i . 
3. Sprawdź, czy wybrane ustawienie odpowiada 

żądanemu przytrzymując klawisz . Jeśli ekran miga, 
wybrane ustawienie odpowiada żądanemu. Jeśli ekran 
nie miga, powtórz czynność wybierając inne 
ustawienie. 

Double-Click Interval   
Pozwala ustalić czas klikania potrzebny do uzyskania efektu 
dwukrotnego kliknięcia.  
1. Wybierz Double-Click Interval. Pojawi się pasek 

regulacji czasu. 
2. Ustaw czas używając klawiszy  i . 
3. Sprawdź, czy wybrane ustawienie odpowiada 

żądanemu dwukrotnie klikając w . Jeśli ekran miga, 
wybrane ustawienie odpowiada żądanemu. Jeśli ekran 
nie miga, powtórz czynność wybierając inne 
ustawienie. 

Contrast   
Pozwala dostosować jasność ekranu. 
1. Wybierz Set Contrast; pojawi się pasek regulacji. 
2. Dostosuj jasność używając klawiszy  i po czym 

wciśnij . Im wyższy numer, tym ekran ciemniejszy. 
 



SuperPen™ Professional 
 

55 

The Information Menu 

 
Menu Information wyświetla następujące informacje: 

Memory Status  
Stan pamięci. Pozwala oszacować ile aplikacji (np. 
słowników i innych dodatków) zmieści się jeszcze w pamięci 
tłumacza. 

Compact Memory  
Stan pamięci dodatkowej. Pozwala kompresować pliki 
znajdujące się w pamięci tłumacza 

Battery Status  
Stan baterii. Pozwala sprawdzić ile energii pozostało 
w bateriach. 
Serial Number  
Numer seryjny tłumacza. 

About  
Numer wersji Quicktionary®2Premium, prawa autorskie, 
numer wersji oprogramowania WizCom Desktop.
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Oprogramowanie WizCom 
Desktop 

Oprogramowanie WizCom Desktop jest aplikacją 
pozwalającą na nawiązywanie połączeń komputer-tłumacz 
i przesyłanie danych. Główne funkcje programu to:  

 Przesyłanie danych z tłumacza na komputer za pomocą 
opcji the QuickLink. 

 Skanowanie teksty do aplikacji systemu Windows za 
pomocą opcji Scan to PC. 

Program może być również używany do przeglądania 
i zmieniania przesyłanych danych, konwertowania 
przesyłanych plików do innych formatów, modyfikowania 
i kompresowania plików systemowych tłumacza. 

Running the Desktop 
Jeżeli podczas instalacji wybrana została opcja Run upon 
Window's start-up, Program będzie się uruchamiał 
automatycznie po każdym włączeniu komputera. Aby 
otworzyć okno programu, należy kliknąć na ikonkę , 
znajdującą się na pasku zadań, po czym wybrać opcję 
Show Window z menu, które się pojawi. Jeżeli program nie 
uruchomi się automatycznie lub jeśli program został 
zamknięty, można go uruchomić z menu Start wybierając 
Programs\WizCom Desktop\WizCom Desktop. 

Exiting the Desktop 
Aby zakończyć pracę należy w menu File wybrać Exit ,lub 

po kliknięciu na ikonkę  wybrać Exit. 
Po naciśnięciu ALT+F4 na klawiaturze lub kliknięciu na 

ikonkę  znajdującą sie w prawym górnym rogu okna 
programu okno zamknie się, ale program nie zakończy pracy. 
Ikonka   pozostanie widoczna na pasku zadań. 
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Desktop User Interface 
Interfejs programu Desktop jest podzielony na 3 części:  

1. Menu Bar: Znajduje się w górnej części okna 
programu. Oferuje dostęp do wszystkich opcji 
programu. 

2. Toolbar: Pasek narzędzi. Oferuje dostęp do 
podstawowych funkcji programu. 

3. Desktop Window: Okno, w którym można 
przeglądać i edytować wszystkie pliki przesyłane 
z tłumacza na komputer.  

The Menu Bar 
Menu Bar znajduje się na górze ekranu. Zawiera 4 menu.  

 
Aby wybrać którąś z opcji, kliknij na menu i zaznacz ją na 
liście, która się pojawi. Niektóre menu uruchamiają się po 
użyciu skrótów klawiaturowych opisanych po prawej stronie 
danego menu. Aby uruchomić daną opcję należy użyć 
właściwego dla niej skrótu klawiaturowego.  

File Menu 
 File Menu posiada następujące opcje:  
 New: Tworzenie nowych plików. 
 Open: Otwieranie istniejących plików. 
 Save As: Zachowywanie istniejących plików w innej 

lokalizacji/innym formacie. 
 Pen Names: Dodawanie, usuwanie, zmienianie Pen 

Names (nazw tłumaczy). 
 Find: Wyszukiwanie słów w używanym pliku. 
 Print: Drukowanie używanego pliku. 
 Exit: Zamykanie programu. Kliknięcie na  

zminimalizuje okno, ale nie zakończy pracy 
programu. 

Pen Communications Menu  
 Pen Communications Menu posiada opcje:  
 Turn Pen Communications Off/On: 

Nawiązywanie i porzucanie połączeń komputer-
tłumacz.  
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 Add/Remove Pen Components: Dla 
użytkowników zaawansowanych! Usuwanie 
elementów.  

 Optimize Pen File System: Optymalizacja plików 
i pamięci tłumacza. 

 Communications Settings: Zmienianie ustawień 
połączeń komputer-tłumacz.  

 File Transfer Settings: Zmienianie ustawień 
przesyłu plików. 

 Scan to PC Settings: Ustalanie jaki znak ma się 
pojawiać na ekranie komputera po zeskanowaniu 
kolejnych wierszy tekstu. Ustawieniem domyślnym 
jest Space (po zeskanowaniu kolejnych wierszy na 
ekranie pojawia się spacja). 

View Menu  
View Menu posiada następujące opcje:  

 Log: Przeglądanie archiwum trzech ostatnich sesji 
przesyłu plików. 

 Interface Language: Zmienianie języka interfejsu. 
 Text Size: Zmienianie rozmiaru czcionek w Files i 

Current Files Panes. 
 Toolbar: Ukrywanie paska narzędzi Toolbar. 
 Status Bar: Ukrywanie paska Status Bar 

informującego o stanie używanej aplikacji. 
 Applications: Wybieranie aplikacji widocznych 

w menu View (zależne od aplikacji w pamięci 
tłumacza). 

Help Menu 
Help Menu posiada nastepujące opcje:  

 Help: Dostęp do pomocy online. 
 Communications Wizard: Nawiązywanie połączeń 

komputer-tłumacz za pomocą kreatora.  
 Register at WizCom Site: Rejestracja tłumacza na 

stronie internetowej WizCom. 
 About: Informacje dotyczące wersji i praw autorskich. 
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Toolbar 
Pasek narzędzi (Toolbar) znajduje się poniżej Menu Bar. 
Umożliwia szybki dostęp do wybranych funkcji. Aby wybrać 
opcje z paska narzędzi, należy kliknąć na ikonkę 
Aby ukryć lub uwidocznić pasek narzędzi, należy w menu 
View wybrać Toolbar.  

 
 
Opcje paska narzędzi: Toolbar 

 
New 
Tworzenie nowego pliku w wybranej aplikacji  

 
Open 
Otwieranie pliku w wybranej aplikacji  

 
Save As 
Zapisywanie bieżącego dokumentu pod nową 
nazwą lub w innym formacie 

 
Print 
Drukowanie bieżacego pliku  

 
Pen Names
Dodawanie, zmienianie lub usuwanie nazw (Pen 
Names) 

 
Add/Remove Pen Components 
Dodawania lub usuwanie elementów tłumacza 

 
Turn Pen Communications Off/On 
Włączanie i wyłączanie połączeń  

 

Current Pen Name 
Wyświetlanie obecnej nazwy 
tłumacza wybranej w programie  

 
Help 
Uzyskiwanie pomocy na stronach internetowych 
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Okno programu WizCom Desktop  
Okno programu podzielone jest na dwa podokna. Aby 
zmienić rozmiar pól lub je ukryć, należy przeciągnąć linię 
rozdzielającą  

 
Application Pane 
Pole aplikacji znajdujące się z lewej strony jest zawsze 
widoczne. Wyświetlają się na nim ikony wszystkich aplikacji 
zainstalowanych na tłumaczu. Aby wyświetlić pliku należące 
do danej aplikacji, należy kliknąć na ikonkę aplikacji.  

File pane 
Pole plików wyświetla listę plików danej aplikacji. Aby 
wyświetlić zawartość wybranych plików z pola po prawej 
stronie, należy kliknąć wybraną ikonę pliku (Current File 
Pane). Pole plików widoczne jest wyłącznie podczas 
wyświetlania plików aplikacji Notes i Tables.  

Current File Pane 
W tej części można tworzyć, otwierać i edytować pliki. Files 
can be created, opened and edited in this section. Aby 
otworzyć plik, na pasku narzędzi należy wybrać  lub 
kliknąć na Open z menu File oraz wybrać plik do otwarcia. 
Tylko jeden plik może być otwarty.  
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Uwaga: Wszystkie zmany w plikach są automatycznie 
zapisywane.  

Ikona paska zadań programu WizCom 
Desktop  
Ikona programu WizcomDesktop  znajduje się na pasku 
zadań. Jeżeli ustawiono uruchamanie programu przy starcie, 
ikonka będzie pojawiać się automatycznie przy każdym 
włączeniu komputera. W przeciwnym razie, ikonka będzie 
pojawiać się wyłącznie po włączeniu programu Wizcom 
Desktop.  

Kiedy program WizCom Desktop jest otwarty, naciśnięcie  
nie spowoduje zamknięcia aplikacji tylko zminimalizowanie 
okna. 
Po zminimalizowaniu program nadal jest aktywny. Kliknięcie 
na ikonkę  powoduje pojawienie się menu 
z następującymi opcjami:  

 

 Menu paska zadań (Taskbar Menu) zawiera następujące 
opcje:  

 Hide/Show Window: minimalizowanie 
i maksymalizowanie okien 

 Turn Pen Communications On/Off: Włączanie 
i wyłączanie połączenia tłumacz-komputer 
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 File Transfer Settings: zmienianie ustawień 
QuickLink za pomocą okna dialogowego File 
Transfer Settings. 

 Scan to PC Settings: Wybieranie znaków do 
wczytania za pomocą okna dialogowego Scan to PC 
Settings.  

 Log: rejestr ostatniego połączenia tłumacz-komputer  
 Help: dostęp do dokumentu  
 About: Zawiera informacje dotyczące wersji programu 

oraz praw autorskich. 
 Exit: wyjście z programu WizCom Desktop  

Zmienianie języka interfejsu  
Program WizComDesktop posiada opcje językowe 
interfejsów.  
Aby zmienić język interfejsu: 
1. Z menu View na pasku Menu Bar wybierz Interface 

Language. Pojawi się okno dialogowe Interface 
Language. 

2. Wybierz język z listy oraz naciśnij OK.  
3. Uruchom ponownie program. 

Uwaga: Ustawienia systemu Windows muszą być 
odpowiednio skonfigurowane, aby program mógł pracować 
w wybranym języku. Jeżeli wersja systemu Windows nie ma 
zainstalowanego alfabetu danego języka, poprawne 
wyświetlanie znaków nie będzie możliwe. Ustawienia języka 
zmienić można w Panelu Sterowania w zakładce Opcje 
Regionalne i Językowe.  
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Ustawienia połączenia tłumacz-
komputer   
Są cztery sposoby połączenia tłumacza z komputerem przy 
użyciu programu WizCom Desktop: 

 QuickLink (połączenia nawiązane z tłumacza)  
 Scan to PC (połączenia nawiązane z tłumacza)  
 Optimize Pen File System (połączenie nawiązane 

z komputera).  
 Otwieranie okna Add\Remove Pen Components  

Aby uzyskać połączenie, tłumacz i komputer muszą być 
połączone dołączonym do zestawu kablem. 

Ustawienia połączenia  
Okno dialogowe Communications Settings (na pasku 
Menu Bar w menu Pen-PC Communications) pozwala na 
zmienianie: 

 Typu połączenia (połączenie przez kabel/ port 
podczerwieni). 

 Portu połączenia na komputerze, do którego podłącza 
się tłumacza. 

 Szybkość przesyłu danych w ramach danego 
połączenia (w przypadku połączenia przez kabel) 

 Sterownik podczerwieni (w przypadku połączenia 
przez port podczerwieni). 

Aby uzyskać połączenie konieczne są poprawne ustawienia 
zarówno na komputerze, jak i tłumaczu. Więcej informacji na 
temat konfigurowania urządzeń znajduje się na str. 9 
w rozdziale Nawiązywanie połączeń komputer-tłumacz. 

Tryby programu WizCom Desktop 
Włączanie i wyłączanie połączenia 
z tłumaczem 
Aplikacja Desktop może działać w dwóch trybach – online  
i offline. Automatycznie ustawiony tryb to online.  

Offline Mode 
Kiedy komputer pracuje w trybie offline, połączenie 
z tłumaczem nie jest możliwe. Program nie może odbierać 
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danych, ani nawiązywać połączenia. Opcje menu Pen 
Communications są niedostępne. 

Aby uniemożliwić połączenie z tłumaczem, należy wybrać 
Turn Pen Communications Off z menu Pen 
Communications lub wycofać wybór ikony  na pasku 
narzędzi. Opcja zmieni się na Turn Pen Communications 
On Aby ponownie umożliwić połączenia należy wybrać Turn 
Pen Communications On.  

Online Mode 
Kiedy komputer pracuje w trybie online, połączenie 
z tłumaczem jest możliwe. Program WizCom Desktop jest 
gotowy do nawiązania połączenia z tłumaczem. Rozpoznaje 
komendy QuickLink oraz Scan to PC wysyłane z tłumacza 
oraz może zainicjować działania np. dopasować system 
plików przy użyciu opcji PC-Controlled Communication. 
Uwaga: Kiedy połączenie z tłumaczem jest możliwe, port 
połączenia wybrany w ustawieniach połączenia jest zajęty i 
nie może być używany w innych celach.  

Optymalizowanie ustawień plików 
systemowych  
Po usunięciu danych z tłumacza (za pomocą opcji Flush 
w oknie dialogowym File Transfer Settings), miejsce 
w pamięci długotrwałej pozostaje zajęte. Opcja Optimize 
Pen File System pozwala zwolnić miejsce w pamięci.  
Aby zoptymalizować ustawienia plików systemowych należy:  
1. włączyć tłumacza, a następnie z Pen Main Menu 

wybrać PC-Controlled Communications.  
2. z menu Pen Communications w Wizcom Desktop 

wybrać Optimize Pen File System. Na ekranie 
komputera pojawi się  pasek postępu, który wyświetla 
przebieg procesu optymalizacji ustawień. 

 Jeżeli wystąpi błąd w połączeniu, po wybraniu 
Optimize Pen File System wyświetli się 
komunikat błędu. Aby naprawić błąd, należy w  
Help Menu uruchomić program 
Communications Wizard. 
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 W przypadku gdy komputer nie rozpoznaje 
podłączonego tłumacza, należy użyć bieżącej 
nazwy tłumacza (Pen Name) lub utworzyć nową 
nazwę tłumacza. 

3. Następnie pojawi się komunikat potwierdzający zmiany.  
Ważne: Nie wolno przerywać procesu optymalizacji 
ustawień plików systemowych. Przerwanie procesu grozi 
ustratą wszystkich danych tłumacza.  

Dodawianie/Usuwanie elementów 
tłumacza   
De menu  Add/Remove Pen Components  wejść można 
z menu Pen Communications na pasku Menu Bar 
programu WizCom Desktop lub klikając na ikonę  na 
pasku narzędzi (Toolbar). Dialog można nawiązać 
wyłącznie jeżeli tłumacz jest podłączony do komputera, a na 
tłumaczu wybrano PC-Controlled Communications. 
Dialog może być używany wyłącznie przez  
zaawansowanych użytkowników.  

Odzyskiwanie elementów usuniętych 
z tłumacza  
Elementy przypadkowo usunięte w menu Add/Remove 
Pen Components można odzyskać używając załączonej 
płyty CD. Na płycie znajduje się menu Add-Ons. Należy 
w nim uruchomić którąkolwiek aplikacji instalacyjnych. 
Pierwszym krokiem każdej instalacji jest sprawdzanie 
brakujących elementów urządzenia. Potrzebne elementy 
zostana odtworzone.   
W przypadku usunięcia elementu aplikacji Add-Ons lub 
usunięcia słownika z tłumacza z zainstalowanymi 
słownikami,należy ponownie zainstalować aplikację Add-
Ons  za pomocą sekcji Add-Ons na płycie CD. 
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Zarządzania kilkoma tłumaczami w 
programie WizCom  Desktop 
Jednym programem Desktop można obsługiwać kilka 
tłumaczy. Każdemu tłumaczowi przypisana jest nazwa (Pen 
Name), dzięki czemu komputer może rozróżniać różne 
egzemplarze Quictionary®2Premium. Okno dialogowe Pen 
Names zawiera kilka opcji zarządzania tłumaczami 
w programie – można dodawać lub usuwać tłumacze oraz 
zmieniać ich nazwy. 
Do okna dialogowego Pen Names wchodzi się przez menu 
File menu na pasku Menu Bar lub klikając na   na pasku 
narzędzi (Toolbar). Automatycznie ustawiona nazwa to 
“MyPen". 

Dodawanie i usuwanie tłumaczy Quicktionary. 
Zmiana nazwy tłumacza. 

 Aby dodać nowego tłumacza: otwórz menu Pen 
Names, a następnie wybierz Add. Wpisze nazwę 
tłumacza i potwierdź naciskając OK.  

 Aby zmienić nazwę: otwórz menu Pen Names I 
wybierz nazwę (Pen Name), którą chcesz zmienić. 
Wybierz Rename, wpisz nową nazwę w pole Rename, 
a następnie potwierdź naciskając OK.  

 Aby usunąć tłumacza: otwórz menu Pen Names, 
wybierz nazwę tłumacza, którego chcesz usunąć (Pen 
Name), Remove, następnie potwierdź wybierając 
odpowiedź Yes, a następnie kliknij OK.  

Ustawiania bieżącego tłumacza 
W każdej chwili można zmienić aktualnie aktywnego 
tłumacza używając listy Current Pen na pasku narzędzi. 
You can change the current Pen at any time by using the list 
in the Toolbar.  
Drugi sposób ustawienia bieżącego tłumacza: otwórz menu 
Pen Names oraz wybierz nazwę tłumacza, którego chcesz 
używać. Wybierz Set as Current oraz potwierdź naciskając 
OK.  
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Zarządzanie plikami w programie 
WizCom Desktop 
Aplikacje Notes i Tables 
Aby utworzyć nowe pliki należy: kliknąć na ikonę aplikacji, 
na pasku narzędzi wybrać  , a następnie wpisać nazwę 
w polu New File i potwierdzić wybierając OK.  

  Notes: akapity można dodawać i usuwać klikając 
prawy klawiszem myszy na pole Current File Pane 
i wybierając żądaną opcję. 

 Tables: Wiersze i kolumny dodawać i usuwać można 
klikając prawym klawiszem myszy oraz wybierając 
żądaną opcję z menu. 

 Aby edytować pliki: z pola Files Pane wybierz plik, 
który chcesz edytować. Dwukrotne kliknięcie na 
wybrany akapit spowoduje pojawienia się migającego 
kursora na początku akapitu, który wskazuje, że tekst 
można edytować przy użyciu standardowych dla 
systemu Windows komend.  

Uwaga: Wszystkie zmiany są automatycznie zapisywane w 
programie.  
Aby otworzyć istniejący plik lub importować plik należy: 
Kliknąć na ikonę w polu Application Pane, z paska 
narzędzi wybrać , a następnie odnaleźć wybrany plik oraz 
kliknąć na Open. 
Aby zapisać plik pod inną nazwą lub w innym formacie 
należy: na pasku narzędzi kliknąć , wybrać format, nazwę 
pliku oraz kliknąć na Save.  
Aby usunąć pliki należy: Kliknąć prawym klawiszem myszy 
na plik, który chce się usunąć oraz w polu Files Pane 
wybrać Delete File..  

Aplikacje Address Book and Internet 
Links 
Aby utworzyć nowe hasło należy: kliknąć na ikonę 
aplikacji, a następnie dwukrotnie kliknąć na Current File 
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Pane. Pojawi się okienko, w które należy wprowadzić dane 
oraz wybrać Update.  
Aby otworzyć istniejący plik lub importować plik należy: 
Kliknąć na ikonę w polu Application Pane, z paska 
narzędzi wybrać , a następnie odnaleźć wybrany plik oraz 
kliknąć na Open. 
Aby edytować hasła należy: dwukrotnie kliknąć na hasło, 
które chce się edytować, zmienić dane w okienku, które 
pojawi się automatycznie oraz wybrać Update.  
Aby zapisać plik pod inną nazwą lub w innym formacie 
należy: na pasku narzędzi kliknąć , wybrać format, nazwę 
pliku oraz kliknąć na Save.  
Aby usunąć hasło należy: Kliknąć prawym klawiszem 
mysze na plik, który chce się usunąć oraz w polu Current 
Files Pane wybrać Delete File.  
Uwaga: Tylko pliki o rozszerzeniu "mainadd.qad" 
i "mainlnk.qlk" mogą być zsynchronizowane z tłumaczem.  
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Informacje dodatkowe 

Baterie 
Quicktionary®2Premium zasilany jest za pomocą dwóch 
baterii alkalicznych AAA (w zestawie). O potrzebie wymiany 
baterii informuje komunikat „Replace Batteries”. 
Quicktionary®2Premium automatycznie wyłącza się, kiedy 
baterie są słabe. Słabe baterie mogą być powodem zakłóceń 
pracy tłumacza – przy zakłóceniach pracy urządzenia należy 
sprawdzić stan baterii za pomocą menu Information. 

Bezpieczeństwo (Dotyczy baterii) 
UWAGA: Użycie nieodpowiednich baterii może zakończyć się eksplozją. 
Należy używać wyłącznie baterii AAA. 

 Zaleca się używanie nowych baterii o tym samym 
napięciu. 

 Nie należy używać baterii różnego rodzaju (np. 
jednorazowej i wielokrotnego użytku). 

 Należy pozbywać się zużytych baterii w zalecany 
przez producenta sposób. 

Wydajność i konserwacja 
Urządzenie tłumaczące Quicktionary®2Premium 
odpowiada najwyższym standardom technologicznym 
i standardom wykonania. Aby utrzymać go w dobrej kondycji 
należy: 

 Przechowywać tłumacza w etui ochronnym. 
 Chronić tłumacza przed wilgocią I skrajnymi 

temperaturami. 
 Czyścić tłumacza wilgotną szmatką. 
 Chronić przed nasłonecznieniem. 

UWAGA:Aby zmniejszyć ryzyko wystąpienia zwarcia 
elektrycznego należy chronić urządzenie przed cieczami.  
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Rozwiązywanie problemów 
 
Problem: Pomimo przestrzegania instrukcji 
ustanawiania połączeń komputer-tłumacz, nie udaje się 
nawiązać połączenia. Co należy zrobić? 
 
Rozwiązanie: 
1. Należy upewnić się, że używane baterie nie są 

rozładowane. 
2. Połączenia komputer-tłumacz może ustanawiać osoba 

posiadająca uprawnienia administratora komputera. 
3. Należy odłączyć inne urządzenia służące do 

przesyłania danych na komputer (palmtopy, aparaty 
cyfrowe itp). Jeżeli na pasku zadań widoczna jest 
ikonka danego urządzeni, należy zaznaczyć ją 
i zakończyć pracę urządzenia używając prawego 
przycisku myszy. 

4. Należy upewnić się, czy końcówki kabla USB łączącego 
tłumacza z komputerem są dociśnięte. 

5. Należy spróbować podłączyć kabel USB do innego 
portu USB komputera. 

6. Jeżeli używany komputer jest laptopem, a prędkość 
transmisji sygnału (baud rate) jest ustawiona na 115200, 
należy zmienić tę wartość za pomocą menadżera 
urządzeń w następujący sposób:  

a. W menu Start wybrać Panel Sterowania, po czym 
wybrać System. 

b. Kliknąć na ikonkę Sprzęt, a następnie wybrać 
Menedżer urządzeń. 

c. Odnaleźć Ports (COM & LPT) i rozwinąć listę.  
d. Znajdź Prolific USB-to-Serial Comm Port. 
e. Kliknij dwukrotnie na wybraną pozycję, po czym 

wróć do Port Settings. Te ustawienia należy 
zmieniać wyłącznie w Menedżerze urządzeń. 
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Problem: Po zainstalowaniu sterownika USB 
z dołączonej płyty CD kabel po podłączeniu kabla USB 
komputer nie rozpoznaje go. Co może być powodem 
problemu? 
 
Rozwiązanie: 
Powodów może być kilka: Sterownik mógł zostać 
zainstalowany z błędem, kabel USB może być wadliwy. Aby 
to sprawdzić, należy: 

1. Upewnić się, że jest się administratorem komputera.  
2. Odłączyć inne urządzenia służące do przesyłania 

danych na komputer (palmtopy, aparaty cyfrowe itp.). 
Jeżeli na pasku zadań widoczna jest ikonka danego 
urządzenia, należy zaznaczyć ją i zakończyć pracę 
urządzenia używając prawego przycisku myszy. 

3. Uruchomić instalację sterownika USB z płyty CD. Jeżeli 
jest to kolejna próba instalacji, pojawi się lista opcji. 
Należy wybrać opcję remove (usuń). Po usunięciu 
należy zrestartować komputer I ponownie zainstalować 
sterowniki. Należy upewnić się, czy końcówki kabla 
USB łączącego tłumacza z komputerem są dociśnięte. 

4. Pojawi się okno dialogowe “Add New Hardware Wizard” 
(Kreator dodawania sprzętu), wtedy będzie można 
zakończyć instalację. 

5. W menu Start wybrać Panel Sterowania, po czym 
wybrać System. Kliknąć na ikonkę Sprzęt po czym 
wybrać Menedżer Urządzeń. 

6. Znajdź Ports (COM & LPT) i sprawdź czy na liście 
figuruje  Prolific USB to Serial Comm Port. 

 
Jeżeli komputer nadal nie rozpoznaje urządzenia, należy:  

1. Ponownie zainstalować sterownik 
2. Spróbować podłączyć kabel USB do innego portu USB 

komputera. 
Jeżeli żadna z powyższych wskazówek nie pomaga 
rozwiązać problemu, należy postarać się o nowy kabel USB. 
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Problem: Przy próbie instalacji dodatków z płyty CD 
i strony internetowej wyświetla się następujący 
komunikat: Setup.exe has encountered a problem and 
needs to close. Co należy zrobić? 
 
Rozwiązanie: 
Błąd Setup.exe jest błędem systemu Windows. Kiedy się 
pojawi należy zrestartować komputer. 

 Problem może być również spowodowany: 

1. Jednoczesnym uruchomieniem programu Desktop 
i procesu instalacji. 

2. Usiłowaniem instalacji dodatków przez osobę nie 
będącą administratorem komputera.  

3. Uruchomieniem programu komputerowego 
uniemożliwiającego instalację. 

  
Należy spróbować: 

1. Zrestartować komputer.  
2. Upewnić się, że jest się administratorem komputera. 
3. Odłączyć wszystkie urządzenia służące do przesyłania 

danych na komputer (palmtopy, aparaty cyfrowe itp.). 
Jeżeli na pasku zadań widoczna jest ikonka danego 
urządzenia, należy zaznaczyć ją i zakończyć pracę 
urządzenia używając prawego przycisku myszy. 

 
Pasek zadań 

4. Zmienić baterie. 
5. Spróbować podłączyć kabel USB do innego portu USB 

komputera. 
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Problem: Kiedy włączam tłumacza otrzymuję komunikat:  
"Device is uncalibrated. Please return to Vendor". Co 
powinienem zrobić? 
 
Rozwiązanie: 
Proszę spróbować wymienić baterie, to powinno rozwiązać  
problem. Jeżeli komunikat nie zniknie będzie trzeba wysłać 
urządzenie do serwisu na przegląd. Prosimy o kontakt 
w celu ustalenia adresu, na który można przysłać urządzenie. 
Uprzejmie prosimy o podanie nazwiska oraz miejsca 
zamieszkania. 
 
Wszystkim naszym klientom przysługuje darmowy przegląd 
tłumacza Quictionary. Pokryć należy jedynie koszty przesyłki. 
W przypadku gdy okaże się, żę problem wykracza poza 
zakres przeglądu przed naprawą urządzenia zwrócimy się 
do Państwa celem ustalenia czy produkt jest na gwarancji 
oraz czy są Państwo skłonni ponieść koszty ewentualnej 
naprawy jeśli gwarancja wygasła.  
 
Problem: Zainstalowałem na swoim tłumaczu nowy 
słownik i dodatkowy język interfejsu. Kiedy dzisiaj 
włączyłem tłumacza nie znalazłem ani słownika ani 
interfejsu.Jak mogę je odzyskać? 
 
 
Rozwiązanie: 
Karta pamięci znajdująca się pod tylną obudową tłumacza 
mogła zostać niepoprawnie włożona.  
Proszę spróbować:  

 Otworzyć schowek na baterie. 
 Wyjąć kartę pamięci znad baterii, podmuchać na nią 

oraz na jej przegródkę w tłumaczu w celu usunięcia 
drobinek kurzu, które mogły się tam zgromadzić.  

 Włożyć kartę z powrotem na miejsce 
 To powinno pomóc odzyskać brakujące elementy. 
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Problem: Otrzymuję komunikat "Out of memory”. Co 
powinienem zrobić?  
 
Rozwiązanie: 
Otrzymywanie takiego komunikatu zazwyczaj oznacza, że w 
środku tłumacza, poluzowała się karta pamięci nie zaś, że 
na karcie brakuje miejsca.  
Aby rozwiązać ten problem, należy otworzyć tylną obudowę 
tłumacza i palce mocno docisnąć kartę do wewnątrz.  
 
Jeżeli to działanie nie przynosi zadowalających rezultatów 
należy otworzyć schowek na baterie i usunąć drobinki kurzu, 
które mogły się tam zgromadzić. Następnie włożyć kartę 
z powrotem na miejsce. Problem powinien zniknąć.  
 
Problem: Zmieniłam język interfejsu i nie wiem jak 
powrócić do wersji angielskiej 
 
Rozwiązanie: 
Należy: 

1. przewijać w dół Pen Main Menu aż do ikonek , 
a następnie nacisnąć . 

2. przewinąć w dół do  a następnie nacisnąć . 
3. za pomocą klawiszy wyboru  lub  przewijać w dół 

aż podświetli się English, a następnie nacisnąć . 
. 
Język interfejsu zmieni się na angielski.  
 
Problem: Mój tłumacz Quicktionary nie chce się włączyć. 
Co mam zrobić?  
 
Rozwiązanie: 
Kiedy tłumacz nie chce się włączyć po wciśnięciu klawisza 

 lub pokazuje pusty szary ekran, należy upewnić się czy 
tłumacz jest wyłączony oraz:  

 Otworzyć schowek na baterie i włożyć nowe baterie 
AAA (“małe paluszki 

 Wyjąć kartę pamięci znad baterii, podmuchać na nią 
oraz na jej przegródkę w tłumaczu w celu usunięcia 
drobinek kurzu, które mogły się tam zgromadzić.  
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 Włożyć kartę z powrotem na miejsce 
 Zamknąć schowek na baterie.  
 Nacisnąć i przytrzymać 3-4 sekundy klawisz  

równocześnie naciskając .  
 
 
Problem: Kiedy tłumacz jest włączony na wyświetlaczu 
pojawia się napis “Loading” Wtedy tłumacz sam się 
wyłącza. Co mogę zrobić?  
 
Rozwiązanie: 
Proszę spróbować przytrzymać klawisz  przez kilka 
sekund, a następnie nacisnąć . Tłumacz powinien się 
włączyć i wyświetlić Main Menu. 
Aby zapobiec podobnym sytuacjom można: 

1. przesyłać na komputer pliki aplikacji Notes o dużej 
objętości.  

2. zmienić ustawiony czas automatycznego wyłączania na 
dłuższy.  

3. unikać tworzenia dużych plików, przechowując dane 
w większej ilości mniejszych plików.  

 
 
Problem: Kółeczka tłumacza piszczą. Jak mogę 
wyeliminować ten odgłos?  
 
Solution: 
Kółeczka nie powinny piszczeć, zdarza się to niezwykle 
rzadko. Jeżeli zanotowali Państwo choćby drobny hałas przy 
skanowaniu, proszę pojeździć tłumaczem po kartce papieru 
lekko przyciskając lub przechylić wąską końcówkę tłumacza 
tak, by wyciekło z niej trochę grafitu, który nawilży oś koła. 
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Szczegóły Techniczne  
Właściwości Opis 
Wyświetlacz Rozdzielczość: 122 x 32 pikseli 

Wymiary: 61 mm x 20 mm / 2.4” 
x .8” 

Klawiatura Klawisze: 
Power/ESC/ENT/Up/Down/Left/ 
Right) 

CPU  ARM 7 TDMI 
Pamięć  

 RAM 192 KB 
 ROM 8 MB 
 Karty pamięci 4 MB, 6 MB lub 8 MB 

Połączenia USB, Podczerwień 
Skaner  128 pikseli 

 400 DPI rozdizielczość 
Zasilanie 2 x 1,5 v (baterie alkaliczne) 
Wymiary 163 x 38 x 23 mm razem z 

obudową 
Waga 90 g (bez baterii i kart pamięci 

flash) 
Zabiezpieczenia  CE 

 RoHS 
 UL 
 FCC class B 

Temperatura pracy 0° C - 40° C 
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Introduction 
Congratulations on your choice of the state of the art 
scanning Pen from WizCom Technologies. WizCom makes 
personal, portable scanning Pens that assist with reading, 
understanding and utilizing text. 
Use the Pen to scan full lines of text, receive word-by-word 
translations, and hear scanned words pronounced aloud. 
Use the CD provided with the Pen to install one or more of a 
wide range of dictionaries. 
The Pen can also scan and store printed material anytime 
and anywhere. Use the Pen to store over 500 pages of 
printed text, in a wide range of fonts and sizes, for easy 
transfer to a PC, PDA or Smartphone. Text can also be 
scanned directly into any Windows-based application for 
ultimate productivity! 
This manual is divided into four sections: 
1. Getting Started - This section provides basic 

information on Pen functions and how to scan, on 
using the CD you received with your Pen, installing the 
WizCom Desktop and establishing Pen-PC 
Communications. 

2. The Pen - This section demonstrates how to work with 
the Pen, including explanations of all the Pen menu 
options, applications and different ways of scanning, 
inserting and editing text in files. 

3. The WizCom Desktop - This section teaches the use 
of the PC application used for transferring and 
synchronizing data between the Pen and PC. 

4. Additional Information - View additional information 
such as Pen maintenance information. 
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Getting Started 
Familiarizing Yourself with the Pen 
The Pen Parts 
Your Pen contains the following parts: 

 
Front and Rear Views 

 

 
Top View 

 
Important: Before using the headphones, please adjust the 
volume using the Voice Settings option in the Preferences 
menu.  
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Setting Up Your Pen 
To get started: 
1. Remove your Pen from its protective case. 
2. Remove the battery compartment cover from the back 

of the Pen. 
3. Insert 2 AAA batteries into the Pen with the positive and 

negative terminals corresponding to the markings on 
the sides of the battery compartment.  

4. Close the battery compartment. 
5. Remove the protective cover from the Pen tip. 
6. Press  to turn the Pen on. 
7. The Pen is ready to scan! 

Note: If you are left-handed, see Right-Left-Handed on 
page 130 to change your Pen to left-handed scanning.  

Basic Pen Commands 
The Pen Keys and their Functions 
The keypad contains seven keys for operating your Pen.  
Use the keys as follows: 

 Power key : Turn the Pen on and off.  
 ENT key : Access submenus or screens, confirm a 

selection or perform an operation. 
 ESC key : Navigate backwards, close a screen, or 

cancel an operation.  
 Direction keys    : Scroll through menus and 

screens.  

Navigating Menus and Lists 
To select an item from a menu or a list:  

1. Scroll through the menu, using  or  until the item 
you want is highlighted. 

2. Press ENT. 

To select a command key on the display: 
1. Use the direction keys to highlight the command key. 
2. Press ENT. 

To return to a previous menu level from a sub-menu, option 
or list, press ESC. 
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Scanning Guidelines 
Scanning Mode 
The Pen is in scanning mode when the red light at the tip of 
the Pen is blinking. Scanning mode is disabled when 
accessing menus.  

Scanning Direction 
Text can be scanned from right to left or from left to right. 
Both will produce the same results. 

Scanning Restrictions 
The Pen scans and recognizes printed text in a wide range 
of languages, font types and point sizes (6-22 points, up to 
8mm) and in a variety of colors on contrasting backgrounds 
(except red on white, white on red, blue on black and black 
on blue).  
It does not recognize handwriting, cursive fonts, 
mathematical symbols or other profession-specific signs. 

Tips for Good Scanning 
To ensure optimum scanning results: 

 Hold the Pen at the correct scanning angle. 
 Place the scanning material on a flat surface. 
 Ensure scanning material is good quality and pages are 

not creased. Poorly photocopied materials may provide 
bad results. 

 Do not scan too fast. 

 
Correct scanning angle of 90° 

Poor Character Recognition 
Poor character recognition may occur for the following 
reasons: 

 Low quality scanning material. 
 The scanning settings are not set correctly (e.g. 

Inverse). 
 Holding the Pen at the wrong scanning angle. 
 Scanning too fast.  
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Learning to Scan (using the Trainer) 
This tutorial uses the Notes application and the plastic 
scanning Trainer provided with your Pen.  

1. Slide the Trainer onto the tip of the Pen (instead of the 
cap) and press into place. 

 
2. Turn the Pen on. The Pen Main Menu appears. If the 

Pen Main Menu does not appear, press ESC until it 
is visible on screen.  

3. Scroll to the Notes application using the direction keys 
and press ENT. 

4. Scroll down to New File and press ENT. 
5. Scroll down to OK and save the default file name. A 

blank screen appears with a blinking cursor. 
6. Position the Pen at a 90° angle and center the 

following text between the feet of the trainer. This angle 
should be maintained even when scanning without the 
trainer. 
Use the following practice sentence: 

 
This sentence will help me practice scanning.  

 

 
7. Glide the Pen from right to left in a straight line over the 

text. Start scanning 1cm from the end of the text and 
finish 1cm after the beginning of the text. 

8. The scanned text will appear on the screen. If the text 
does not appear correctly on the screen, press ENT to 
erase it and scan again. 
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The CD 
The CD should run automatically when you insert it into 
the drive on your PC. If the setup does not begin 
automatically: 
1. Click the Windows Start button and select Run. 
2. Type x:\setup.exe (where x is your CD-ROM drive), 

then click OK.  
Use the CD to: 

 Install Product on PC: Install the USB driver and 
WizCom Desktop necessary for transferring data 
between your Pen and PC. 

 Install Add-Ons: Install additional components on 
your Pen, such as dictionaries, interface languages, 
spellers (for enhanced scanning recognition for specific 
languages) and the Image Capture application for 
scanning small images. The USB driver must be 
installed (from Install Product on PC) before you can 
install any Add-Ons. 

Installing the WizCom Desktop 
While the Pen can be used as a stand-alone device, 
installing the WizCom Desktop from the CD allows you to 
transfer files between your Pen and PC. To install the 
Desktop you will need your Pen, the CD and USB cable 
provided with the Pen.  
Important: Do not connect the USB cable to your computer 
until you have completed the USB driver installation. 
To install the Desktop: 
1. Insert the CD into the drive on your computer. If the 

setup does not begin automatically: 
 Click the Windows Start button and select Run. 
 Type x:\setup.exe (where x is your CD-ROM drive), 

then click OK.  
2. The CD browser window will appear. 
3. From the Main Menu click Install Product on PC. 
4. Follow the instructions on the CD to install first the USB 

driver and then the WizCom Desktop. 
Note: Please restart your computer if requested to during the 
installation procedure. 
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Establishing Pen-PC Communications 
Do the following to check that your Pen and PC are 
configured correctly for Pen-PC Communications:  

On the Pen: 
To set the Pen communications settings:  
1. Turn the Pen on, scroll down to Preferences in the 

Pen Main Menu and press ENT. 
2. Scroll down to Communications Settings and press 

ENT. 
3. The Connection Device submenu appears. Press 

ENT. 
4. Select Cable and press ENT. 
5. Scroll down to Baud Rate and press ENT. 
6. The Baud Rate should be set to 115,200. Scroll down 

until you see 115200 on screen and press ENT. 
7. Press ESC twice to return to the Pen Main Menu.  

On the Desktop: 
To view the Desktop application communications settings 
select Communications Settings from the Pen 
Communications menu on the Menu Bar of the Desktop 
application.  
The Communications Settings dialog box appears:  
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The correct settings (when using the USB cable) should be 
as follows: 

1. The Port should correspond to the COM port being 
used by the Pen. To find out whether the port is correct 
do the following: 

a. Connect the USB cable to a USB port on your PC. 
b. On your computer go to Start/Settings/Control 

Panel and select System. 
c. Click on the Hardware tab and then click on the 

Device Manager. 
d. Scroll down to Ports (COM & LPT) and open the 

drop-down list of ports.  
e. Find the "Prolific USB-to-Serial Comm Port" and 

note the corresponding COM port number. 

 
f. Go back to the Communications Settings dialog 

box and modify the Port option accordingly.  
2. The Baud Rate should be set to 115,200.  
3. Click OK.  

Note: If the "Prolific USB-to-Serial Comm Port" is not listed 
under Ports (COM & LPT) it means that the USB driver has 
not been installed correctly. Go back to the CD and rerun the 
driver installation. If at any stage you are requested to restart 
your computer, please do so.  

Once this is complete, run the Communications Wizard to 
establish communications between your Pen and the PC.  
Make sure you are an administrator on your PC and that the 
cable jack is pushed firmly into the Pen (until you hear the 
last little “click”).  

The Communications Wizard can be accessed from the 
Help menu on the Menu Bar of the WizCom Desktop. 

If you are experiencing trouble installing the PC software and 
establishing communications, see Troubleshooting on page 
145. 
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The Pen 
Main Pen Functions 
You can access all the main Pen functions from the Pen 
Main Menu which can be seen when turning your Pen on 
for the first time. Use the direction keys to scroll through the 
menu options, and ENT if you wish to enter an application or 
access a function or menu. Press ESC to return to the Pen 
Main Menu from within any of the options.  

The Pen Main Menu contains the following options:  

Quicktionary  
The Quicktionary application allows you to scan and 
translate text. You can install dictionaries using the CD that 
came with your Pen. See page 88. 

Notes  
The Notes application enables you to scan printed text into 
your Pen. This text can later be transferred to your computer 
or beamed to an infra-red device. See page 105.  

Address Book  
The Address Book application enables you to scan 
business cards and other addresses into your Pen. The 
information can be synchronized with your PC or beamed to 
an infra-red device. See page 109. 

Internet Links  
The Internet Links application enables you to scan 
website addresses into your Pen. The links can be sent to 
the PC and synchronized with the Favorites folder of Internet 
Explorer or the Bookmarks folder of Netscape Navigator. 
See page 114. 

Tables  
The Tables application enables you to scan information in 
table format into your Pen. The tables can be transferred to 
the PC and converted to Excel files. See page 117. 

Scan to PC  
The Scan to PC application enables you to scan text directly 
into Windows applications on your PC. See page 121. 
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QuickLink  
Activates the file transfer process, which transfers files 
between your Pen and PC. See page 124. 

PC-Controlled Communications  
Initiates communications between your Pen and PC so that 
you can add and remove Pen components such as 
dictionaries and interface languages, or optimize the Pen’s 
file system. See page 127. 

Preferences  
Allows you to change settings on your Pen, such as the 
scanning language and the menu type. See page 128. 

Information  
Displays information about your Pen's current status. See 
page 131. 

The Quicktionary Application 

 
Use the Quicktionary application to scan and translate text 
in various languages. Hear scanned text read aloud from 
either the Split Screen or the Dictionary Screen. Access 
the Quicktionary from the Pen Main Menu. 

You will reach the Input Screen and the red light at the tip 
of the Pen will flash. Scan into any screen as long as the red 
light is flashing. Scanning is disabled when accessing menus.  
If your Pen does not come with a pre-installed dictionary, 
you will need to install one before you can start using the 
Quicktionary. 

Installing Dictionaries 
To install a dictionary: 
1. Insert the CD into the CD-ROM drive on your computer. 

If the setup does not begin automatically: Click the 
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Windows Start button and select Run. Type 
x:\setup.exe (where x is your CD drive), then click OK.  

2. The CD browser window will appear. 
3. From the Main Menu click Install Add-Ons. 
4. The Install Add-Ons menu appears. Click on the 

Dictionaries button. 
5. The Dictionaries menu appears, showing a list of all 

available dictionaries. 
6. Click on the dictionary you wish to install and follow the 

instructions provided.  

The Quicktionary Screens 
The Quicktionary application has three main screens, the 
Input Screen, the Split Screen and the Dictionary 
Screen. Each screen displays the translation of the selected 
words.  
You can scan into any screen when the red light at the Pen 
tip is blinking. Text on screen will be over-written by the 
newly scanned text. 

The Input Screen 
This is the screen that appears when you enter the 
Quicktionary application. Scan text directly into this screen. 
The "Scan in..." message indicates the source language of 
the selected dictionary and the highlighted section shows the 
input field. 

 
 After scanning, text is displayed in the Split Screen or 

the Dictionary Screen.  
 Insert text using the Character bar or Opticard. See 

Editing and Inserting Text on page 94 for more 
information on these options. After inserting text, 
select GO to view the translation in the Split Screen or 
the Dictionary Screen.  
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 Press ESC to access the Edit Menu while in Edit 
Mode. 

 Press ESC from the Input Screen to access the 
Quicktionary Menu.  

Note: If the  icon is visible on screen it indicates that the 
Quicktionary application is set to scan inverse text (light 
text on dark background). To change the setting, see The 
Quicktionary Menu on page 91. 

The Split Screen 
The Split Screen appears after scanning more than one 
word. The scanned text appears on the top of the screen, 
and the translation of the highlighted word appears on the 
bottom of the screen.  

 
 Scroll through the scanned text using the right/left 

direction keys. The  arrow indicates that scrolling to 
the right will reveal the rest of the scanned text. 

 Scroll through the dictionary entry for the highlighted 
word using the up/down direction keys. 

 View the highlighted word in the Dictionary Screen 
by pressing ENT. 

 If the selected dictionary supports reading aloud, use 
 to scroll to the  icon (voice). Highlight the icon to 

hear the scanned text read aloud. Press ENT to hear 
the text read aloud again.  

 Press ESC to return to the Input Screen. 

The Dictionary Screen 
The Dictionary Screen appears after scanning a single 
word, or after selecting a word from the Split Screen.  
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 Scroll through the dictionary entry using the up/down 

direction keys.  
 Switch between reduced and full dictionary display 

using the left/right direction keys. 
 If the selected dictionary contains support for reading 

aloud, press ENT to hear the word read aloud. 
 If you have reached the Dictionary Screen after 

selecting a word from the Split Screen, press ESC to 
return to the scanned text in the Split Screen. 

The Quicktionary Menus 
The Quicktionary contains two menus: The Quicktionary 
Menu and the Edit Menu. 

The Quicktionary Menu 
To display the Quicktionary Menu, go to the Input 
Screen and press ESC. To return to the Input Screen from 
the Quicktionary Menu, press ESC. 
Dictionary 
The Dictionary submenu contains a series of dictionary 
tools. 

History 
This option displays a chronological list of the most 
recently displayed words, with the last word you defined at 
the top. The history list can store up to 80 words. Once the 
list is full, the oldest word is deleted from the list to make 
room for the most recent one.  
To select one of these words and view its dictionary entry: 
1. Select Dictionary and then select History. 
2. Scroll through the list to find the word you want. 

Press ENT. The word appears in the Dictionary 
Screen. 

3. Press ESC to return to the history list. 
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Adjacent Entries 
This option displays a list of all the headwords in the 
current dictionary, placing you on the last word you 
highlighted, or on the last word you selected from the 
history list. If you haven't scanned or selected a word 
during the current scanning session, it places you on the 
first word in the dictionary. Scroll through the list to find a 
different word in order to view its definition. 
1. Select Dictionary and then select Adjacent 

Entries. 
2. Scroll to the word you want. Press ENT.  
3. The word appears in the Dictionary Screen. 
4. Press ESC to return to the adjacent entries list. 

Select Dictionary 
View a list of the dictionaries on the Pen and change the 
selected dictionary. This option is only available if there is 
more than one dictionary installed on the Pen. 
Reset History 
Select this option to erase all History entries.  
1. Select Dictionary and then select Reset History. 
2. The question, "Are you sure?" appears.  
3. Select YES to erase the history and return to the 

Input Screen.  
4. Select NO to return to the Dictionary submenu 

without erasing the history. 
Preferences 
Use this option to modify the default Quicktionary settings. 
To accept changes press ENT. To return to the 
Preferences submenu without making changes, press ESC. 
Toggle settings on or off by pressing ,  or ENT.  = on.  

 Inverse: Select this option to scan inverse text (white 
text on dark background). When inverse text mode is 
selected, the red light in the tip of Quicktionary blinks 
rapidly and the  icon is visible on the Input Screen.  

 Reduced Display: This preference determines whether 
display elements in the current dictionary, such as 
phonetics, appear with the translations. When Reduced 
Display is selected, certain display elements are 
hidden.  
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 Auto Speak: When Auto Speak is selected, the 
Quicktionary application reads scanned text aloud the 
moment you select it for translation.  

 Line(s) Per Scroll: This preference determines how 
many lines the Quicktionary application scrolls at a 
time in the Split Screen and Dictionary Screen. To 
change the number of lines per scroll, press  or .  

Help 
Guides and Glossaries 
This option is present only when the selected dictionary 
contains guides or glossaries, such as the Pronunciation 
Guide to assist with understanding special symbols used 
in the particular dictionary.  
About 
View copyright and version information for the 
Quicktionary application. 

Pen Main Menu 
Exit Quicktionary and return to the Pen Main Menu.  

The Edit Menu 
Edit Mode enables editing and inserting of text using the 
Character Bar or Opticard. Access the Edit Menu from 
the Input Screen by pressing ENT to activate Edit Mode 
and then pressing ESC.  
The Edit Menu contains three options: 
Resume Editing 
Return to the current field without making changes. The field 
remains in Edit Mode.  
Activate Overwrite Mode 
Overwrite the existing text. Overwrite mode highlights the 
first character after the blinking cursor. Any text that is 
inserted overwrites the text starting at the highlighted 
character. When Overwrite Mode is activated, the menu 
option changes to Activate Insert Mode. Text will be 
inserted at the site of the blinking cursor. 
Clear Text 
Clear the text on screen.  
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Editing and Inserting Text 
To edit or insert text press ENT to activate Edit Mode. The 
highlighted text or field will be replaced by regular text, with a 
blinking cursor at the beginning of the field. To return to 
regular scanning mode press ESC twice.  
When the Pen is in Edit Mode, text can be edited or 
inserted in two ways:  

 Using the Character Bar.  
 Using the Opticard.  

The Character Bar 

 
Use the Character Bar to manually insert or edit text. The 
Character Bar is only available when the Pen is in Edit 
Mode. Scroll to the field you wish to edit and press ENT to 
activate Edit Mode.  
Use the direction keys to scroll to the place you wish to 
insert text and press ENT to access the Character Bar. 
Press ESC to exit the Character Bar. 

Using the Character Bar 
The Character Bar works in two modes: Insert Mode and 
Overwrite Mode which are determined by the setting in the 
application's Edit Menu. The default mode is Insert Mode. 

 In Insert Mode characters are inserted at the site of 
the cursor.  

 In Overwrite Mode each character that is inserted 
replaces the highlighted character. 

Use  and  to scroll to the character you wish to insert 
and press ENT. Do the same thing for each character you 
wish to insert. When you have finished, press ESC to return 
to the previous screen. 
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Character Bar Options 
The default Character Bar contains the twenty six lower-
case ABC characters as well as the option to access 
numbers, punctuation characters, upper-case and accented 
characters and symbols.  

Insert Upper-Case Characters 
Insert upper case (capital) letters by scrolling to the lower-
case character and pressing  to reveal the upper and 
lower case options for the character. Scroll to the character 
you wish to insert and press ENT. 

Insert Accented Characters or Symbols 
Insert accented characters or symbols created using 
alphabet characters, such as  or  by scrolling to the 
lower-case character and pressing  to reveal the additional 
characters available. Scroll to the character you wish to 
insert and press ENT. 

 Insert Numbers 
Scroll to this symbol and press ENT to reveal the numeric 
Character Bar. 

 Insert Punctuation Symbols 
Scroll to this symbol and press ENT to reveal the 
punctuation Character Bar. 

 Alphabet  
Scroll to this symbol and press ENT to return to the default 
alphabetic Character Bar. 

 Delete 
Scroll to this option to delete the highlighted character. If you 
enter the Character Bar from a field that has reached its 
maximum number of characters, the cursor immediately 
jumps to the delete symbol and you will be unable to insert 
any characters until you delete a character from the field. 

 Spacebar 
Scroll to this option and press ENT to insert a space 
between characters. 
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 Multiple Characters Mode 
This symbol indicates that you can enter as many characters 
as you wish. Scroll to the character you wish to add and 
press ENT. Keep adding characters in this way. To exit the 
Character Bar press ESC. Scroll to this symbol and press 
ENT to change to Single Characters Mode. 

 Single Character Mode 
This symbol indicates that you can insert one character 
before the Character Bar exits. Scroll to this symbol and 
press ENT to change to Multiple Characters Mode. 

The Opticard 

 
The Opticard is a scanning keyboard found on the back of 
the Pen case.  
Every letter scanned with the Opticard is identified by its 
unique barcode and converted to the correct character on 
your Pen.  
Use the Opticard to edit scanned text, or to insert text that 
cannot be scanned due to scanning limitations. To use the 
Opticard:  
1. Hold the Pen case horizontally, with the Opticard 

facing up and the Opticard title on the right. 
2. Scan the Opticard key in the bottom left corner of the 

Opticard, from left to right or from right to left, to 
activate Opticard Mode. When Opticard Mode is 
activated, the light in the tip of the Pen blinks rapidly. 

3. Slowly scan the character key, from right to left or from 
left to right, or touch the key gently with the tip of your 
Pen. The letter appears in the Pen display. 
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Use the following key combinations to enter the required 
characters: 

 Lower-Case Characters: Scan the character key.  
 Upper-Case Characters: Scan the Shift key and 

then scan the character key. 
 Caps Lock: To activate/deactivate Caps Lock, 

scan Shift twice. Activating Caps Lock enables 
you to enter letters in upper case only. 

 Punctuation Symbols: Scan the Ctrl key and 
then scan the symbol. 

 Accented characters: Scan the Ctrl key, scan the 
accent, and then scan the character corresponding 
to the accent. 

 Accented characters in upper-case: Scan the 
Ctrl key followed by the Shift key, scan the accent, 
and then scan the character corresponding to the 
accent. 

 Space: Scan the spc key. 
 Delete: Scan the Shift key and then scan the del 

key. 
4. When you are finished, scan the Opticard key again to 

return to normal scanning mode. 

The Dictionary Entries 
The dictionary entries contain various elements and 
indicators. The following examples are taken from the 
English to German and German to English dictionaries.  
Note: Not all dictionaries contain all the elements mentioned. 
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Reduced and Full Dictionary Entry Display 
Press  or  to toggle the display of the current entry 
between reduced and full display. Reduced Display hides 
certain display elements such as phonetics. Full Display 
shows the entire dictionary entry.  

Scroll Arrows  
The scroll arrows on the bottom right of the screen indicate 
that you can scroll up and down to view the entire dictionary 
entry.  

 The hollow arrow  indicates the entry is being viewed 
in Reduced Display. 

 The full arrow  indicates the entry is being viewed in 
Full Display. 

Word List  
The Word List sign appears at the top right of the 
Dictionary Screen and indicates that there are additional 
entries for the headword on screen. Press ESC to view the 
Word List. 

The Word List appears: 
 When the scanned word corresponds to more than one 

dictionary entry. For example, if you scan the word 
“dressing”, the Quicktionary application enables you to 
choose between the dictionary entries “dress” and 
“dressing”. 

 When the scanned word is a homonym, a word that is 
the same as another in spelling but different in 
meaning.  

 After scanning an idiom or phrasal verb, the 
Quicktionary will automatically recognize the entire 
phrase from the first word highlighted, and will provide 
a Word List containing both the whole idiom and the 
first highlighted word.  
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Headword 

 
 

 
 

The selected word or a derivative of the selected word, may 
consist of more than one word. The screenshots here 
display the headword "special" and the word "ate", a 
derivative of the headword "eat".  

Phonetics  

 
The phonetic transcription of the headword. This can be 
seen when the dictionary entries are shown in Full Display. 
The guide to the phonetic symbols used in the dictionary, is 
available from the Guides and Glossaries menu in Help in 
the Quicktionary Menu.  

Parts of Speech  

 
Categories of words that describe their particular function, 
e.g. nouns, verbs, adjectives. Some dictionary entries 
contain several parts of speech, such as "land" which is both 
a noun (n.) and a verb (v.). 
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Idioms  

 
Expressions or phrases usually composed of a sequence of 
words. They can be identified: 

 Automatically within a sentence 
 By scrolling through the translation of the first word of 

the sequence. 
If you scan text containing an idiom, the Quicktionary 
application will automatically display the translation of the 
idiom when the first word is highlighted, i.e. the idiom "From 
A to Z" displayed from the headword "From". 

Split Verbs (German source language) 

 
If you scan a single word which is part of a split verb:  

1. The translation will appear along with the Word List 
icon. In the Word List, the SPLIT VERB option 
appears allowing you to scan the first part of the split 
verb. 

2. The message “Scan 1st part” will appear allowing you to 
scan the first part of the split verb in order to view the 
translation of the entire verb. 

If you scan a line of text containing a split verb (e.g., in the 
German to English dictionary), the Quicktionary 
automatically recognizes the verb and combines the parts.  
The dictionary entry for the verb is displayed as soon as you 
highlight the first part of the verb that appears in the 
sentence. For example, if you scan in the sentence "ihr stellt 
etwas auf", the dictionary entry for "aufstellen" appears as 
soon as you highlight "stellt". 
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Compound Words 

 
If you scan a word that is not a dictionary entry, but is a 
compound word consisting of existing dictionary entries (e.g., 
in the German to English dictionary), the Quicktionary 
separates the compound word into its respective entries.  
The translation of the primary word in the compound word 
appears first, with the Word List sign next to it.  
To display the dictionary entry for another part of the 
compound word: 
1. Press ENT to go to the Dictionary Screen (if you 

scanned more than one word). 
2. Press ESC to display the word list. 
3. Scroll to the word you want to translate and press ENT. 
For example: If you scan the word ‘Sprachgemeinschaft’, the 
entry for ‘gemeinschaft’ appears. Go to the word list and 
select ‘Sprache’ to view its translation. 

Hear Scanned Text Read Aloud 
Scanned text can be read aloud from both the Split Screen 
and the Dictionary Screen. Adjust the volume using Voice 
Settings in the Preferences menu.  
Note: Not all dictionaries have text-to-speech functionality.  

Access the Auto Speak option from Preferences in the 
Quicktionary Menu.  
When Auto Speak is selected: 

 Scrolling through the text in the Split Screen will 
cause the word to be read aloud automatically as it is 
highlighted.  

 Accessing the Dictionary Screen by either scanning 
a single word or from the Split Screen will cause the 
word to be read aloud automatically. 

When Auto Speak is not selected: 
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 Scrolling to the left in the Split Screen until the  
icon is highlighted will cause the entire sentence to be 
read aloud. Press ENT when the icon is highlighted to 
hear the text read aloud again.  

 Press ENT to hear the word read aloud in the 
Dictionary Screen. 

Homograph Pronunciation 
A homograph is one of two or more words that have the 
same spelling but differ in origin, meaning, and sometimes 
pronunciation, such as "fair" (pleasing in appearance) and 
"fair" (market) or "wind" (wĭnd) and "wind" (wīnd).  
If the selected word is a homonym, Quicktionary will read out 
all the options for pronouncing the word.  
 

Using Professional Dictionaries 
Some Pens contain dictionaries known as professional 
dictionaries. These dictionaries contain multiple sub-
dictionaries that are incorporated into a single dictionary, 
such as the HMC Dictionaries. These dictionaries are 
represented by a single heading in the Select Dictionary 
option in the Dictionary submenu accessed from the 
Quicktionary Menu. 

 
When you select the dictionary and exit to the Dictionary 
submenu you will see two additional submenu options:  

1. Dictionary Display Order 
Use this option to choose the preferred order in which 
entries from the sub-dictionaries are displayed.  
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To set the preferred dictionary order: 
a. Scroll through the dictionary list using  and  until 

the sub-dictionary you wish to move is highlighted. 
b. Press ENT. A scroll arrow  will appear indicating 

that you can move the sub-dictionary either up or down 
in the list. 

c. Use  and  to move the sub-dictionary to the 
desired location. 

d. Press ENT to confirm the location. 

When viewing the dictionary entry, the icon representing the 
sub-dictionary from which the entry is derived is displayed 
after the headword. Press ESC to access the Word List and 
see the additional entries available from each sub-dictionary 
within the professional dictionary. The icon representing the 
sub-dictionary is displayed on the right of the screen.  

 

2. Select Cross-Ref. Dict. 
Use this option to choose the dictionary you wish to use for 
cross-referencing words from within the professional 
dictionary entry. This option is only available if there is 
another dictionary installed on the Pen whose source 
language corresponds to the language used in the 
professional dictionary. 

To choose the cross-reference dictionary: 
a. Scroll through the list of available dictionaries using  

and  until the dictionary you wish to choose is 
highlighted. 

b. Press ENT. 
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Using the Cross-Reference Function 
The cross-reference function is available in the Dictionary 
Screen. To cross-reference from within the current 
dictionary entry: 

a. Press ENT to activate Highlight Mode.  
b. Scroll through words within the definition using the 

direction keys. Each word will be highlighted 
individually. 

c. Press ENT to view the cross-reference for the 
highlighted word. 

d. Press ESC to return to the original dictionary entry. If 
pressing ESC takes you to the Word List, press ESC 
again to access the original entry. 

e. Press ESC from within the original dictionary entry to 
deactivate highlight mode. 

Types of Cross-Reference 
There are two types of cross reference, internal and external. 
When scrolling through the dictionary entry in Highlight 
Mode, internal cross-reference is represented by an 
underline and external cross-reference is represented by a 
highlight. 
1. Internal Cross-Reference: Directs you to a relevant 

entry within the professional dictionaries.  
2. External Cross-Reference: Directs you to the 

corresponding entry for the highlighted word in the 
selected cross-reference dictionary.  

Hearing Words Read Aloud in Highlight Mode 
Some dictionaries allow you to hear the definition/translation 
read aloud when Highlight Mode is activated. This is 
possible only in dictionaries whose target language is 
compatible with the Pen’s voice capabilities, i.e. the AHD 
English to English dictionaries. 
Long-press the ENT key to hear words read aloud in 
Highlight Mode.  
Note: This feature is only available in the professional set of 
dictionaries. 
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The Notes Application 

 
Use the Notes application to scan printed text, such as 
excerpts from journals and books, into your Pen. Access 
Notes from the Pen Main Menu. 

To create a new note, select New File from the Notes 
Menu which opens as soon as you enter the application. 
Scan a new file name, or keep the default name.  
The scanning screen will appear, with a blinking cursor:  

 
Scan text directly into this screen. The text appears 
highlighted. If the scanned text is unclear, erase it by 
pressing ENT while it is still highlighted. Otherwise, continue 
scanning. The next scans will appear consecutively on 
screen. 
To insert text at a specific point, move the blinking cursor to 
that point using the direction keys. New scanned text will be 
inserted at the location of the blinking cursor. 
Scroll through the text using the direction keys. Insert a new 
paragraph at the end of the text by pressing . 

Scanning Language for Notes 
Notes uses the default scanning language from Scanning 
Language in the Preferences menu. Access the 
Preferences menu to change the default scanning 
language. Change the scanning language for a specific file 
using Select Language in the Edit Menu.  
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Editing and Inserting Text  
In the scanning screen: 

 Press ESC to access the Edit Menu.  
 Press ENT to access the Character Bar for manual 

inserting of text.  
 Scan directly into the screen using the Opticard. 

For more information on using the Character Bar and 
Opticard, see Editing and Inserting Text on page 94. 

Transferring Notes Files to the PC 
To transfer Notes files to the PC, launch the WizCom 
Desktop, connect the USB cable to both Pen and PC and 
select QuickLink from the Pen Main Menu. To change the 
default file transfer settings, see Change File Transfer 
Settings on page 126.  

The Notes Menu 

 
The Notes Menu contains the following options. Select the 
option to perform the function described. To return to the 
Notes Menu from within a file, press ESC twice.  
Edit Current File 
The last file you opened is called the current file. Select this 
option to open the current file for editing.  
New File 
Select this option to create a new file. Scan in the file name 
and select OK. The scanning screen will appear. 
Open File 
Open an existing file for viewing or editing. 
Delete File 
Delete an existing file. 
Beaming 
Beam and receive files using infrared communication. 
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Files can be transferred using IrOBEX compatible devices, 
such as PDAs (Palm, IPAQ etc), or Smartphones. 
1. Sending Notes 

a. Open the note you wish to send and return to the 
Notes Menu.  

b. In the Notes Menu scroll down to Beaming and 
press ENT. 

c. Select Send Note from the Beaming submenu.  
d. Confirm that the infrared port on the receiving 

device is enabled to receive. 
e. Align the infrared screens on both the sending and 

receiving devices. 
f. Wait for the success confirmation on the Pen. 

2. Receiving Notes 
a. In the Notes Menu scroll down to Beaming and 

press ENT. 
b. Select Receive Note from the Beaming submenu.  
c. Align the infrared screens on both the sending and 

receiving devices. 
d. Initiate infrared sending (beaming) from the 

sending device. 
e. Wait for the success confirmation on the Pen. 
f. The file will open on the Pen screen and will be 

saved automatically. 
Exit 
Exit Notes and return to the Pen Main Menu.  
About 
View Notes copyright and version information. 

The Notes Edit Menu 

 
To access the Edit Menu: 
1. Scroll to the file you wish to edit in the Open File menu 

from the Notes Menu and press ENT.  
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2. The file will open on screen. Press ESC to access the 
Edit Menu. 

The Edit Menu contains the following options:  

Resume Editing 
Return to the current field without making changes. The field 
remains in Edit Mode.  

Activate Overwrite Mode 
Overwrite the existing text. Overwrite mode highlights the 
first character after the blinking cursor. Inserted text 
overwrites the text starting at the highlighted character.  
When Overwrite Mode is activated, the menu option 
changes to Activate Insert Mode. Text will be inserted at 
the site of the blinking cursor. 

New Paragraph 
Insert a new paragraph after the current one. 

Delete Paragraph 
Delete the current paragraph. 

Select Language 
Change the scanning language for the current paragraph. 
The scanning language can only be changed if the field is 
empty. If the current field contains text it must be erased 
before the scanning language can be changed.  
The language change will apply to the remainder of the file, 
unless the scanning language is changed again. 

Scanning Options 
Change the scanning setting within the application. These 
settings will apply to all future files until the setting is toggles 
on or off. Toggle settings on or off by pressing ,  or ENT. 

 = on.  
 Numeric: Select this option to scan numbers only. 

When this option is selected regular characters will not 
scan correctly and will appear as gibberish text.  

 Inverse: Select this option to scan light text on a dark 
background. 
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The Address Book Application 

 
Use the Address Book to store addresses and transfer 
them to the PC via the WizCom Desktop. Access the 
Address Book from the Pen Main Menu. 

Scanning Language for Addresses 
Address Book uses the default scanning language from 
Scanning Language in the Preferences menu. Access 
Preferences to change the default scanning language. 

Editing and Inserting Text into Address 
Book Fields 
To edit or insert text into a specific field scroll to the field and 
press ENT to activate Edit Mode. The highlighted field will 
be replaced by regular text, with a blinking cursor at the 
beginning of the field. To return to regular scanning mode 
press ESC twice. 
When the Pen is in Edit Mode, text can be edited or 
inserted in two ways.  
1. Using the Character Bar.  
2. Using the Opticard.  

For more information on using the Character Bar and 
Opticard, see Editing and Inserting Text on page 94. 

Transferring Addresses to the PC 
To transfer addresses to the PC, launch the WizCom 
Desktop, connect the USB cable to both Pen and PC and 
select QuickLink from the Pen Main Menu. To change the 
default file transfer settings, see Change File Transfer 
Settings on page 126.  
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The Address Book Menu 

 
The Address Book Menu contains the following options. 
Select the option to perform the function described: 
New Address 
Create a new address.  
1. Scan the address details into the appropriate fields. 

After scanning, the cursor will jump automatically to the 
next field. 

2. Select OK. 
View Addresses 
View saved addresses. Scroll through addresses using the 
direction keys. When an address is highlighted: 
1. Press ENT to view the full entry. Press ENT again to 

open the address for editing. 
2. Press  to access the Addresses Menu.  
 Use the Addresses Menu to do the following: 

1. Find Address 
2. Select Search Language 
3. Delete Address 
4. View Address 
5. Edit Address 

Settings 
Change the default settings for new addresses. Toggle 
settings on or off by pressing ,  or ENT.  = on.  

 Scroll Screen: When Scroll Screen is selected, the 
screen will scroll (rather than jump) to the next field 
after text is scanned. 

 Auto Advance: When Auto Advance is selected, the 
screen will move automatically to the next field after 
text is scanned. 

 AutoName: When AutoName is selected, scan both 
the first name and last name at the same time, and the 
scanned text will automatically be sent to the First 
Name and Last Name fields.  
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 Next Address Lang.: Change the scanning language 
for the next address you scan. 

 Select Fields: Select the fields you wish to use for 
storing address information. 

 Field Settings: See a list of the fields available for 
storing address information.  

New File 
Address Book uses a file called "mainadd" to store all 
scanned addresses. This file is the only file that is 
synchronized with the PC when using the QuickLink 
function. You can create new files to organize addresses, 
but these files will not be transferred to the PC. 

Open File 
Open an existing file for storing addresses. 

Delete File 
Delete an existing file. If you delete the current file you must 
open another file before you can continue scanning. 
Note: you can't delete the file, "mainadd" from the Pen. 

Beaming 
Beam and receive addresses via infrared communication. 
Transfer files using IrOBEX compatible devices, such as 
PDAs (Palm, IPAQ etc), or Smartphones. 

1. Sending Addresses 
a. In the Address Book Menu scroll down to 

Beaming and press ENT. 
b. Select Send Address from the Beaming 

submenu.  
c. Confirm that the infrared port on the receiving 

device is enabled to receive. 
d. Align the infrared screens on both the sending and 

receiving devices. 
e. Scroll to the address you wish to send and press 

ENT.  
f. Wait for the success confirmation on the Pen. 

2. Receiving Addresses 
a. In the Address Book Menu scroll down to 

Beaming and press ENT. 
b. Select Receive Address from the Beaming 

submenu.  
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c. Align the infrared screens on both the sending and 
receiving devices. 

d. Initiate beaming from the sending device. 
e. Wait for the success confirmation on the Pen. 
f. The address will open on the Pen screen and will 

be saved automatically. 
3. Sending a Business Card 

You can only send a business card when you are using 
the default address book file, “mainadd”. Open the 
“mainadd” file by doing the following: 
a. In the Address Book Menu select Open File. 
b. Scroll down to “mainadd” and press ENT. 
To send a business card you need to first define which 
address you wish to use as your business card. Do 
the following:  
a. In the Address Book application scroll down to 

Beaming and press ENT. 
b. Select Select Business Card from the Beaming 

submenu.  
c. Scroll down to the file you wish to use as your 

business card and press ENT. 
Once you have defined your business card, send it as 
follows: 
a. In the Address Book application scroll down to 

Beaming and press ENT. 
b. Confirm that the infrared port on the receiving 

device is enabled to receive. 
c. Align the infrared screens on both the sending and 

receiving devices. 
d. Select Send Business Card from the Beaming 

submenu.  
e. Wait for the success confirmation on the Pen. 

Exit 
Exit the Address Book application.  
About 
View Address Book copyright and version information. 
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The Address Book Edit Menu 

 
Scroll to the field you wish to edit, press ENT to activate Edit 
Mode and ESC to access the Edit Menu. The Edit Menu 
contains the following options. Select the option to perform 
the function described: 
Resume Editing 
Return to the current field without making changes. The field 
remains in Edit Mode.  
Activate Overwrite Mode 
Overwrite the existing text. Overwrite mode highlights the 
first character after the blinking cursor. Inserted text 
overwrites the text starting at the highlighted character.  
When Overwrite Mode is activated, the menu option 
changes to Activate Insert Mode. Text is inserted at the 
site of the blinking cursor. 
Insert Line 
Insert an extra line into the current field.  
Delete Line 
Delete a line from the current field. If there is only one line, 
the text in the field will be deleted. 
Clear Line 
Delete the text in the current field. 
Scanning Options 
Change the settings for the current field. Press  to access 
this menu during scanning. Toggle settings on or off by 
pressing ,  or ENT.  = on.  

 Numeric: Select this option to scan numbers only. 
When this option is selected regular characters will not 
scan correctly and will appear as gibberish text.  

 Inverse: Select this option to scan light text on a dark 
background.  

 Multiple Lines: Select this option to scan multiple 
lines into the current field.  
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The Internet Links Application 

 
Use Internet Links to store web addresses (URLs) and 
transfer them to the PC via the WizCom Desktop. Access 
Internet Links from the Pen Main Menu. 

Scanning Language for Links Files 
Internet Links uses the default scanning language from 
Scanning Language in the Preferences menu. Access the 
Preferences menu to change the default scanning 
language.  
 

Editing and Inserting Text into Internet 
Links Fields 
To edit or insert text into a specific field scroll to the field and 
press ENT to activate Edit Mode. The highlighted field will 
be replaced by regular text, with a blinking cursor at the 
beginning of the field. To return to regular scanning mode 
press ESC twice. 
When the Pen is in Edit Mode, text can be edited or 
inserted in two ways.  

1. Using the Character Bar.  
2. Using the Opticard.  

For more information on using the Character Bar and 
Opticard, see Editing and Inserting Text on page 94. 

Transferring Internet Links to the PC 
To transfer links to the PC, launch the WizCom Desktop, 
connect the USB cable to both Pen and PC and select 
QuickLink from the Pen Main Menu. To change the 
default file transfer settings, see Change File Transfer 
Settings on page 126.   
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The Internet Links Menu 

 
The Internet Links Menu contains the following options. 
Select the option to perform the function described: 
New Link 
Create a new internet link.  

1. Scan the website address (English only) into the 
Internet Link field. When you finish, the cursor will 
jump automatically to the next field. 

2. Scan a description for the link into the Description 
field and select OK. 

View Links 
View saved links. Scroll using the up/down direction keys. 
When a link is highlighted: 
1. Press ENT to view the full entry. Press ENT again to 

open the link for editing. 
2. Press  to access the Links Menu.  

Use the Links Menu to do the following: 
1. Delete Link 
2. View Link  
3. Edit Link 

Settings 
Change the default settings for new links. Toggle settings on 
or off by pressing ,  or ENT.  = on.  

 Scroll Screen: When Scroll Screen is selected, the 
screen will scroll (rather than jump) to the next field 
after text is scanned. 

 Auto Advance: When Auto Advance is selected, the 
screen will move automatically to the next field after 
text is scanned. 

 AutoDescribe: When AutoDescribe is selected, the 
description for the new link is taken automatically from 
the Internet Link field.  
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 Next Link Language: Change the scanning language 
for the Description field of the next link you scan.  

New File 
Internet Links uses a file called "mainlnk" to store all 
scanned links. This default file is the only file that is 
transferred to the PC when using the QuickLink function. 
You can create new files to organize links, but these files will 
not be transferred to the PC.  
Open File 
If you have created new links files you can access them 
using this option. Scroll through the files and select the one 
you wish to use to store future links. 
Delete File 
Use this option to delete any links files you may have 
created. If you delete the current file you must open another 
file before you can continue scanning. 
Note: you can't delete the main links file, "mainlnk" from the 
Pen. 
Exit 
Exit the Internet Links application. 
About 
View Internet Links copyright and version information.  
The Internet Links Edit Menu 

 
To access the Edit Menu, scroll to the field you wish to edit, 
press ENT to activate Edit Mode and ESC to reach the Edit 
Menu. The Edit Menu contains the following options. 
Select the option to perform the function described: 
Resume Editing 
Return to the current field without making changes. The field 
remains in Edit Mode.  
Activate Overwrite Mode 
Overwrite the existing text. Overwrite mode highlights the 
first character after the blinking cursor. Any text that is 
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inserted overwrites the text starting at the highlighted 
character.  
When Overwrite Mode is activated, the menu option 
changes to Activate Insert Mode. Text will be inserted at 
the site of the blinking cursor. 
Insert Line 
Insert an extra line into the current field.  
Delete Line 
Delete a line from the current field. If there is only line, the 
text in the field will be deleted. 
Clear Line 
Delete the text in the current field. 
Scanning Options 
Change the settings for the current field. This setting can 
also be accessed during regular scanning by pressing . 
Toggle settings on or off by pressing ,  or ENT.  = on.  

 Numeric: Select this option to scan numbers only. 
When this option is selected regular characters will not 
scan correctly and will appear as gibberish text.  

 Inverse: Select this option to scan light text on a dark 
background.  

 Multiple Lines: Select this option if you wish to scan 
multiple lines into the current field. 

The Tables Application 

 
Use Tables to store information in tabular form and transfer 
it to the PC via the WizCom Desktop. Access Tables from 
the Pen Main Menu. 

Scanning Language for Tables Files 
Tables uses the default scanning language from Scanning 
Language in the Preferences menu. Access Preferences 
to change the default scanning language. 
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Editing and Inserting Text into Tables 
Cells 
To edit or insert text into a specific cell scroll to the cell and 
press ENT to activate Edit Mode. The highlighted field will 
be replaced by regular text, with a blinking cursor at the 
beginning of the field. To return to regular scanning mode 
press ESC twice. 
When the Pen is in Edit Mode, text can be edited or 
inserted in two ways.  
1. Using the Character Bar.  
2. Using the Opticard.  

For more information on using the Character Bar and 
Opticard, see Editing and Inserting Text on page 94. 

Transferring Tables to the PC 
To transfer Tables files to the PC, launch the WizCom 
Desktop, connect the USB cable to both Pen and PC and 
select QuickLink from the Pen Main Menu. To change the 
default file transfer settings, see Change File Transfer 
Settings on page 126. 
The Tables Menu 

 
The Tables Menu contains the following options. Select the 
option to perform the function described: 
Edit Current File 
The last file you opened is called the current file. Select this 
option to open the current file for editing.  
Settings 
Change the default settings for new Tables files. Toggle 
settings on or off by pressing ,  or ENT.  = on.  

 Scroll Screen: When Scroll Screen is selected, the 
screen will scroll (rather than jump) to the next field 
after text is scanned. 
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 Auto Advance: When Auto Advance is selected, the 
screen will move automatically to the next field after 
text is scanned. 

New File 
Select this option to create a new file. Scan in the file name 
and select OK. The tables screen will appear. The Tables 
application starts at A1, the cell at the upper left-hand corner 
of the table.  
Open File 
Open an existing file for viewing or editing. 
Delete File 
Delete an existing file. 
Exit 
Exit the Tables application. 
About 
View copyright and version information for the Tables 
application. 
The Tables Edit Menu 

 
Scroll to the field you wish to edit, press ENT to activate Edit 
Mode and ESC to reach the Edit Menu. The Tables Edit 
Menu contains the following options. Select the option to 
perform the function described: 
Resume Editing 
Return to the current cell without making changes. The cell 
remains in Edit Mode.  
Activate Overwrite Mode 
Overwrite the existing text. Overwrite mode highlights the 
first character after the blinking cursor. Any text that is 
inserted overwrites the text starting at the highlighted 
character. When Overwrite Mode is activated, the menu 
option changes to Activate Insert Mode. Text will be 
inserted at the site of the blinking cursor. 
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Clear Line 
Delete the text in the current cell. 
Select Language 
Change the scanning language for the current cell. The 
scanning language can only be changed if the cell is empty. 
If the current cell contains text it must be erased before the 
scanning language can be changed. The scanning language 
will only change for the current cell.  
Scanning Options 
Change the settings for the current cell. Toggle settings on 
or off by pressing ,  or ENT.  = on.  

 Numeric: Select this option to scan numbers only. 
When this option is selected regular characters will not 
scan correctly and will appear as gibberish text.  

 Inverse: Select this option to scan light text on a dark 
background.  

 Multiple Lines: Select this option if you wish to scan 
multiple lines into the current field.  

Insert Row 
Insert a row into the table. The row will be inserted below the 
row containing the current cell. 
Insert Column 
Insert a column into the table. The column will be inserted 
after the column containing the current cell. 
Remove Row 
Delete the row containing the current cell. 
Remove Column 
Remove the row containing the current cell. 
Insert Line 
Insert a line into the current cell. 
Delete Line 
Delete a line from the current cell. If there is only one line in 
the current cell, the text in the current cell will be deleted. 
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The Scan to PC Application 

 
Use Scan to PC to scan text and send it directly to the PC. 
Text can be scanned into any file or application on the PC 
that has a blinking cursor. Access the Scan to PC 
application by selecting it from the Pen Main Menu. 
Scan to PC works in the same way as standard editing 
using a keyboard i.e., highlighted text is overwritten, text is 
inserted in Insert Mode or overwritten in Overwrite Mode. 
Using Scan to PC does not interfere with your regular use of 
the Windows application.  
To use Scan to PC, the WizCom Desktop must be running 
on the PC. If there is no Scan to PC compatible application 
open on screen, the text will still be sent from the Pen, but 
will not be accessible on the PC. The WizCom Desktop 
does not need to be maximized on screen as long as it is 
running (the  icon appears in the notification area of the 
Windows taskbar). 

To use Scan to PC:  
1. Launch the WizCom Desktop. 
2. Make sure that the Pen is connected to the PC with the 

USB cable. 
3. Ensure that communications are working between your 

Pen and computer. If you are not sure if your 
communications are working, run the 
Communications Wizard from the Help menu on the 
WizCom Desktop Menu Bar.  
Note: If you have problems with Pen-PC 
Communications, see Establishing Pen-PC 
Communications on page 85. 

4. On your Pen, select Scan to PC from the Pen Main 
Menu. The application opens in the scanning screen so 
you can start scanning immediately. 
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5. When you have finished scanning, press ESC on the 
Pen to exit Scan to PC. 

 Note: Scan to PC works in most Windows applications, 
however, it may be incompatible with some applications.  

Scan to PC Modes 
Scan to PC has two scanning modes: Send Immediately 
and Deferred Sending. 

Send Immediately 
When the Send Immediately option in the Scan to PC 
Settings menu is selected , any text that is scanned is sent 
directly into an open file on the PC that has a blinking cursor. 
This is the default scanning mode. 

Deferred Sending 
When the Send Immediately option in the Scan to PC 
Settings menu is not selected , text that is scanned is 
shown on the screen, and the user can choose whether to 
send the text on screen to the PC or to discard it or rescan it.  

 To send the text on screen press ENT.  
 To scan multiple lines, scan a line of text and then 

press  to store the scanned text and keep scanning. 
Press  every time you want to save a line. When you 
have finished scanning press ENT to send the scanned 
text to the PC. 

Scan to PC Settings on the Pen 
Entering the Scan to PC application takes you directly to the 
scanning screen. Select the Settings menu from the 
scanning screen to switch between the Scan to PC modes, 
and to modify scanning options. 

The Settings menu contains the following options: 
Send Immediately 
Select this option for scanned text to be sent directly to the 
PC after scanning. Toggle Send Immediately on or off by 
pressing ,  or ENT.  = on.  
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Scanning Options 
Change the default settings for the application. Toggle 
settings on or off by pressing ,  or ENT.  = on.  

 Numeric: Select this option to scan numbers only. 
When this option is selected regular characters will not 
scan correctly and will appear as gibberish text. 

 Inverse: Select this option to scan light text on a dark 
background.  

About 
View copyright and version information for the Scan to PC 
application. 

Scan to PC Settings in the WizCom 
Desktop 
Use the Scan to PC Settings in the WizCom Desktop to 
determine what key is inserted after each line of text is sent 
to the PC application. The default setting is Space, meaning 
that a space is inserted after each scan appears in the 
application. 
Access Scan to PC Settings from the Pen 
Communications menu on the WizCom Desktop Menu 
Bar. 
From the Scan to PC Settings menu define the key you 
want to enter after each scan:  

 Space: Inserts a space after each scan.  
 Tab: Inserts a tab after each scan. (For instance, when 

scanning into an Excel table, when you finish scanning 
the cursor jumps automatically to the next cell.)  

 Enter: The cursor moves to the next line after each 
scan.  

 Nothing: Nothing is inserted after each scan; the next 
scanned text will be inserted immediately after the last 
character of the previous scan.  

Scanning in Different Languages 
Scan to PC uses the default scanning language from 
Scanning Language in the Preferences menu. Access 
Preferences to change the default scanning language. 
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If you are scanning in languages other than English, your 
Windows settings (non-unicode programs option) must be 
configured to fully support the language you wish to use. If 
the version of Windows you are using does not support the 
character set of the language you have selected, you will not 
be able to view the character set correctly. Language 
settings can be accessed through the Windows Control 
Panel settings (name of application varies depending on 
which operating system you are running). 
The keyboard corresponding to the scanning language you 
require should be installed and should be active in the 
Windows application you wish to scan into. The WizCom 
Desktop language bar should be set to the required 
language. 
To confirm that the language settings are correct in the 
Windows application, open the application you wish to scan 
text into and attempt to type text in the required language. If 
it appears correctly, the Windows application is ready. 

QuickLink  

 
Use the QuickLink option in the Pen Main Menu to 
transfer files from your Pen to the PC using the Desktop 
application. This function transfers files from the Notes, 
Address Book, Internet Links and Tables applications. 
To use QuickLink, the WizCom Desktop must be running 
on the PC. The WizCom Desktop does not need to be 
maximized on screen as long as it is running (the  icon 
appears in the notification area of the Windows taskbar). 
Before using QuickLink on the Pen, make sure to modify 
the default settings in the WizCom Desktop by accessing 
the File Transfer Settings option from the Pen 
Communications menu in the Menu Bar.  
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To transfer files using QuickLink do the following:  
1. Connect the USB cable to both the Pen and the PC.  
2. Make sure that Pen communications are set to On in 

the Desktop and that communications have been 
established (see Establishing Pen-PC 
Communications on page 85).  

3. On your Pen, scroll down to the QuickLink option in 
the Pen Main Menu and press ENT. 

4. A dialog box will open showing the file transfer process. 
5. The success message will appear when the file transfer 

process has completed.  

File Transfer Settings in the WizCom 
Desktop 
Use the File Transfer Settings dialog box to determine 
what happens to files saved on the Pen when you select the 
QuickLink option from the Pen Main Menu.  
If you have several Pens using the same Desktop 
application, you can define individual settings for each Pen, 
based on their individual Pen names.  

 
To define File Transfer Settings:  
1. Select File Transfer Settings from the Pen 

Communications menu on the Menu Bar of the 
Desktop to reveal the File Transfer Settings menu. 

2. Make sure that the Pen name shown is the same as the 
Pen you are using. If not, select the correct Pen name 
from the drop-down list.  
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3. To select the file transfer function for each application, 
either double-click on the application name in the table, 
or click on the application name and then click the 
Change button. The Change File Transfer Settings 
menu will appear. It displays the options available for 
the specific application. See below for more information. 

4. Select the option you wish to use and click OK. Repeat 
for each application. 

5. If you want the File Transfer Settings dialog box to 
appear before each QuickLink operation (to verify the 
settings), click on the Show this Dialog before each 
File Transfer checkbox prior to closing the dialog box.  

6. When you have finished, close the File Transfer 
Settings menu by clicking on the Close button.  

Change File Transfer Settings  
There are four options available when defining File 
Transfer Settings. Not all are available for all applications.  

1. Synchronize Pen and PC: The records on the Pen 
and computer are synchronized, resulting in identical 
data files on the Pen and the computer. If the same 
record was changed on both the Pen and computer, 
the original records disappear and two new records 
are created. To erase files from the Pen after 
synchronizing check the Flush option.  

2. Pen to PC: The Pen files are copied from the Pen to 
the computer, overwriting the corresponding files on 
the computer. To erase files from the Pen after 
synchronizing check the Flush option.  

3. PC to Pen: If you are interacting with host applications, 
the data in the host application file overwrites the data 
both in the Desktop and on the Pen. If you are not set 
to transfer files with host applications, the files on the 
Desktop are copied to the Pen, overwriting the 
corresponding files on the Pen.  

4. Don’t transfer the files of this application: No 
files are transferred between the Pen and computer for 
the specified application; the files remain untouched 
on both the Pen and computer.  
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Synchronize with Host Applications 
If you want your files to be saved in Microsoft Office 
compatible formats you must activate the Host Settings 
function in the File Transfer Settings menu. 

1. Select File Transfer Settings from the Pen 
Communications menu on the Menu Bar of the 
Desktop. The File Transfer Settings menu appears. 

2. Check the option This Pen Name will transfer files 
with host applications. 
Note: Only one Pen can be associated with host 
applications. If the checkbox is disabled it means 
another Pen has already been selected to interact with 
these applications. If you wish to change it, go through 
the list of Pen names, find the one where the option is 
checked and deselect it.  

3. Click on the Host Settings button (now enabled). 
4. Look at the information for each application in the 

Host Application column. Click on the line for each 
application and a drop-down menu will appear. 

5. Select the option you wish to activate for each 
application.  

PC-Controlled Communications 

 
Use PC-Controlled Communications only when directed 
to by the WizCom Desktop or the CD. It is accessed from 
the Pen Main Menu.  
This option is used by the Desktop to optimize the Pen file 
system, to check Pen-PC Communications using the 
Communications Wizard and to launch the Add\Remove 
Pen Components dialog.  
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It is used by the CD to install Add-Ons, including spellers, 
interface languages and dictionaries. 
When directed to by the Desktop or the CD, select PC-
Controlled Communications from the Pen Main Menu. 
Scroll down to the option and press ENT. The following 
screen shows that the Pen is ready to communicate.  

 
See Establishing Pen-PC Communications on page 85 to 
ensure that your Pen and PC are set up correctly for 
communication. 

The Preferences Menu 

 
Modify the default Pen settings using this menu which can 
be accessed via the Pen Main Menu. To select an option, 
scroll to the required option using  or  and press ENT 
when the option is highlighted. To return to the previous 
screen without making changes, press ESC. 

The Preferences menu contains the following options: 

Scanning Language  
Use this option to change the default scanning language.  
1. Select Scanning Language. 
2. Scroll to the required language and press ENT.  

Note: The scanning language should be set to the same 
language as the text you are scanning. Spellers can be 
added from the CD-ROM to enhance character recognition 
in supported languages. 
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Interface Language  
Use this option to change the language in which menus and 
messages appear. Interface languages can be added to the 
Pen using the Super Pen™ CD-ROM. 
1. Select Interface Language. 
2. Scroll to the interface language you want, using  or 

 and press ENT. 
Communications Settings  
Use this option to adjust the settings communications 
between your Pen and computer.  

Connection Device  
Use this option to select the connection device being 
used for Pen-PC Communications (USB cable or 
infrared). It is recommended that the USB cable is used 
when communicating with the computer. 
1. Select Connection Device. 
2. Scroll to the required device using  or  and 

press ENT. 
Baud Rate  
The Baud Rate should always be set to 115,200.  
1. Select Baud Rate. 
2. If the Baud Rate is not on 115,200, scroll down 

using  until it is visible on screen and press ENT. 

Voice Settings  
Use this option to adjust the voice settings on the Pen. This 
changes the way text is read aloud in the Quicktionary 
application. 

Volume  
Use this option to adjust the volume level of the speaker. 
1. Select Volume. The adjustment bar appears. 
2. Adjust the volume level to the setting you want using 

 or  and press ENT. 
Pitch  
When auto speak is selected, the Pen automatically 
pronounces the word you select or highlight.  
1. Select Pitch. 
2. Adjust the pitch using  or  and press ENT. 
Reading Speed  
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This option enables you to adjust the speed at which the 
Pen pronounces words. 
1. Select Reading Speed. 
2. Adjust the reading speed using  or  and press 

ENT. The higher the number, the faster the speed. 
Auto Shut-Off Time  
If the Pen is not in use it will shut down automatically after 
two minutes. Use this option to change the automatic shut-
off time. 
1. Select Auto Shut-Off Time. 
2. Choose the auto shut-off time you want using  or  

and press ENT. 
Right-/Left- Handed  
Use this option to switch between right and left handed 
modes. Switching between these modes rotates the text on 
the display 180°. 
1. Select Right-/Left- Handed. 
2. Scroll to the mode you prefer using  or  and press 

ENT. 
Menu Type  
Use this option to define whether your Pen menus appear as 
text only, icons only, or both text and icons. 
1. Select Menu Type. 
2. Scroll to the menu type you prefer using  or  and 

press ENT. 
Long-Press Interval  
Use this option to adjust the amount of time you need to 
keep a button pressed for a long press. 
1. Select Long-Press Interval. The adjustment bar 

appears. 
2. Move the slider to the setting you want using  or . 
3. Test the setting by pressing and briefly holding down 

the  key. If the screen flashes the setting is fine. If the 
display does not flash, either adjust the setting to a 
shorter press, or press longer. 

Double-Click Interval  
Use this option to adjust the amount of time between the two 
clicks for a double click.  



The Pen 

131 

1. Select Double-Click Interval. The adjustment bar 
appears. 

2. Move the slider to the setting you want using  or . 
3. Test the setting by double clicking the  key. If the 

screen flashes the setting is fine. If the display does not 
flash, either adjust the setting to a shorter press, or 
double click faster. 

Contrast  
Use this option to adjust the brightness of the display.  
1. Select Set Contrast; the adjustment bar appears. 
2. Adjust the contrast using  or  and press ENT. The 

higher the number, the darker the display. 

The Information Menu 

 
The Information menu displays the following Pen 
information:  
Memory Status  
See how much memory is left on the Pen's extension card. 
This option is useful if you wish to know if your Pen contains 
enough free memory to install extra components such as 
dictionaries. 
Compact Memory  
Maximize free space on the Pen's extension card by 
compacting components already on the Pen. 
Battery Status  
Check how much power is left in the batteries. A diagram 
displays the power level. 
Serial Number  
View the Pen’s serial number.  
About  
View Pen version number, copyright information and version 
number of the Pen operating system. 
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The WizCom Desktop 
The WizCom Desktop is the application your Pen uses to 
communicate with and transfer data to your PC. It has two 
main functions:  
1. Transferring stored data from the Pen to the PC using 

the QuickLink option on the Pen. 
2. Scanning data directly into Windows applications using 

Scan to PC. 
You can also use the Desktop to view and edit the text sent 
from the Pen to the PC, convert sent files to other formats, 
modify Pen components and optimize Pen performance by 
compacting the Pen file system. 

Running the Desktop 
If, during installation, you selected the option for the Desktop 
to run upon Window's start-up, the Desktop will automatically 
start running when you start your computer. To open the 
Desktop window, click the Desktop icon  in the notification 
area of the Windows taskbar and select the Show Window 
option from the pop-up menu. 
If the Desktop application does not run when you start up 
your computer, or if you closed the application, you can start 
it by opening the Windows Start menu and selecting 
Programs\WizCom Desktop\WizCom Desktop. 

Exiting the Desktop 
To exit the Desktop, select Exit from the File menu. Or click 
the Desktop icon, then select Exit. 

Pressing ALT+F4 on the keyboard or clicking  in the 
upper-right corner of the Desktop window closes the 
Desktop window, but does not close the Desktop application. 
The application continues to run in the background, and the 
Desktop icon remains in the notification area of the Windows 
taskbar. 
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The Desktop User Interface 
The Desktop is divided into three main sections:  
1. Menu Bar: The Menu Bar runs across the top of the 

screen. It contains all the options for using the Desktop.  
2. Toolbar: The Toolbar is an iconic interface containing 

some of the main Desktop features. 
3. Desktop Window: The Desktop Window is where 

all the files transferred between the Pen and PC can be 
viewed and edited. 

The Menu Bar 
The Menu Bar runs across the top of the screen. It contains 
four menus.  

 
To select an option, click on the menu and then click on the 
option in the drop-down list. Some menus can be activated 
using shortcut-key commands which are shown on the right 
of the menu option. Press the key sequence shown to 
execute the shortcut-key command.  

The File Menu 
The File Menu contains the following options:  

 New: Create a new file. 
 Open: Open an existing file. 
 Save As: Save an existing file in a different location/ 

format. 
 Pen Names: Add, rename or delete Pen Names. 
 Find: Search for words in the current file. 
 Print: Print the current file. 
 Exit: Exit the Desktop. Note: Selecting  will minimize 

the application to the Windows Taskbar. 

The Pen Communications Menu  
The Pen Communications Menu contains the following 
options:  

 Turn Pen Communications Off/On: Toggle 
communications on and off.  

 Add/Remove Pen Components: Advanced users 
only! Should only be accessed if advised by Support.  



The WizCom Desktop 

134 

 Optimize Pen File System: Clear empty spaces on 
your Pen extension card caused by file transfer and 
deletion. 

 Communications Settings: Define communication 
settings for Pen-PC communications.  

 File Transfer Settings: Define the settings for Pen-PC 
file transfer. 

 Scan to PC Settings: Choose the key you wish to 
insert after each line of text is sent to the PC. The 
default setting is Space. 

The View Menu  
The View Menu contains the following options:  

 Log: View the history of the last three file transfer 
sessions. 

 Interface Language: Change the language in which 
menus and messages appear in the Desktop. 

 Text Size: Change the text size in the Files and 
Current Files Panes. 

 Toolbar: Hide or show the Toolbar, which contains 
icons for accessing some of the main Desktop functions. 

 Status Bar: Hide or show the Status Bar at the 
bottom of the screen which provides information about 
the current status of the application files you are viewing 
in the Desktop application.  

 Applications: The applications shown in the View 
menu vary depending on the applications installed on 
your Pen. Select an application to view the application 
files in the Desktop Window.  

The Help Menu 
The Help Menu contains the following options:  

 Help: Access the Desktop online help document. 
 Communications Wizard: Run the 

Communications Wizard to establish 
communications between your Pen and the PC.  

 Register at WizCom Site: Register your Pen on the 
WizCom website.  

 About: View the Desktop copyright and version 
information. 
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The Toolbar 
The Desktop Toolbar is located beneath the Menu Bar and 
allows quick access to some of the most-used Desktop 
functions. To select a toolbar option, click on the icon.  
To hide or show the toolbar, select Toolbar from the View 
menu. 

 
 
The Toolbar contains the following options: 

 
New 
Create a new file in the selected application.  

 
Open 
Open a file in the selected application.  

 
Save As 
Save the current file under a new name or in a 
different format. 

 
Print 
Print the current file.  

 
Pen Names
Add, rename or remove Pen Names. 

 
Add/Remove Pen Components 
Add or remove Pen components. 

 
Turn Pen Communications Off/On 
Toggle Pen communications off and on.  

 

Current Pen Name 
Shows the name of the Pen 
currently selected on the 
Desktop.  

 
Help 
Accesses the Desktop online help.  
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Desktop Window  
The Desktop Window is split into vertical panes. To resize or 
hide a pane, drag the split bar between two panes to one 
side.  

 
Application Pane 
The left pane, present at all times, is the Application Pane 
and displays the icons of all the applications installed on the 
Pen. Click on the application icon to view the files associated 
with the application. 

Files Pane 
The Files Pane displays the list of files for the selected 
application. Select a file name to view the contents of the 
selected file in the right pane, the Current File Pane. This 
Pane is only visible when viewing Notes and Tables files. 

Current File Pane 
Files can be created, opened and edited in this section. To 
open a file, select  from the toolbar or Open from the File 
menu and choose the file you wish to open. For applications 
with a middle pane, click on a file from the Files Pane. Only 
one file can be opened at a time.  
Note: Any changes made to files are saved automatically.  
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The WizCom Desktop Taskbar Icon  
The Desktop icon  is located in the notification area of the 
Windows taskbar. If you have set the Desktop to launch 
upon startup, the icon will appear automatically each time 
you start your computer. If not, the icon will appear only after 
you launch the Desktop. 

When the Desktop is open on screen, clicking the  icon on 
the top right of the screen will not exit the application, but will 
cause it to minimize to the taskbar.  
The Desktop is still running in this state. Clicking on the icon 
will cause a pop-up menu to appear with the following 
options: 

 

The Taskbar Menu contains the following options: 
 Hide/Show Window: Minimize or maximize the 

Desktop application. 
 Turn Pen Communications On/Off: Activate or 

deactivate Pen-PC Communications. 
 File Transfer Settings: Modify the QuickLink 

settings using the File Transfer Settings dialog box. 
 Scan to PC Settings: Define the character to be 

inserted after each line of text you scan using the Scan 
to PC Settings dialog box.  
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 Log: See the log of the last Pen-PC communication 
activity.  

 Help: Access this document.  
 About: View the copyright and version information for 

the Desktop application.  
 Exit: Exit the Desktop application.  

Changing the Desktop Interface 
Language  
The Desktop contains support for user interfaces languages 
other than English.  

To change the Desktop interface language:  
1. Select Interface Language from the View menu on 

the Menu Bar. The Interface Language dialog box 
appears.  

2. Select the interface language you want from the list and 
click OK.  

3. Restart the Desktop. 

Note: Your Windows settings (non-unicode programs option) 
must be configured to support the selected language. If your 
Windows version doesn’t support the character set of the 
selected language, you will not be able to view the character 
set correctly.  

Language settings can be accessed through the Windows 
Control Panel Regional and Language Options setting 
(name of setting menu varies depending on which operating 
system you are running). 
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Pen-PC Communication Settings  
There are four ways in which the Pen communicates with the 
PC via the Desktop application:  

 QuickLink (initiated by Pen)  
 Scan to PC (initiated by Pen)  
 Optimize Pen File System (initiated by Desktop)  
 Launching the Add\Remove Pen Components 

dialog (initiated by the Desktop)  
When communicating with the PC, the Pen must be 
connected to the PC using the cable provided with the Pen.  

Communication Settings 
The Communications Settings dialog box (accessed from 
the Pen-PC Communications menu on the Menu Bar) 
allows the following information to be modified:  

 The type of communications (either Cable or Infra-
Red).  

 The communications port on the computer to which 
the connection device is associated.  

 The communications baud rate (the speed at which 
the data is transmitted), if you are using a cable.  

 The Infra-Red driver, if you are using Infra-Red 
communications.  

Communications settings must be defined correctly on both 
the Pen and Desktop in order for the two to communicate. 
See Establishing Pen-PC Communications on page 85 to 
configure the correct communication settings for both the 
Pen and PC. 

Desktop Modes – Turn Pen 
Communications Off/On 
The Desktop application runs in two modes - online or 
offline. The default mode is online. 
Offline Mode 
When the computer is offline, communications with the Pen 
are disabled. The Desktop cannot detect communications 
from, or initiate communications with the Pen. The Pen 
Communications menu options are disabled.  
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To disable Pen communications, select Turn Pen 
Communications Off from the Pen Communications 
menu on the Menu Bar, or deselect the  icon on the 
Toolbar. The option toggles to Turn Pen Communications 
On.  
Select Turn Pen Communications On to re-enable Pen 
communications.  

Online Mode 
When you are working online, communications with the Pen 
are enabled. The Desktop occupies the communications port 
on your computer and is in a state of readiness to receive 
communications from the Pen. It detects QuickLink or Scan 
to PC commands being sent from the Pen, and can also 
initiate Desktop-controlled communications, such as 
optimizing the Pen file system using the Pen's PC-
Controlled Communication option. 
Note: When Pen communications are enabled, the 
communications port specified in the communications 
settings on the Desktop is busy, and cannot be used for any 
other purpose.  

Optimize the Pen File System  
When you delete data from your Pen (either manually or by 
using the Flush option in the File Transfer Settings dialog 
box), the area that was used by the data is not actually 
deleted from the extension card memory. The Optimize 
Pen File System option enables you to free up those areas 
on the Pen’s extension card memory that are no longer 
being used by application data.  
To optimize your Pen's file system:  
1. Turn your Pen on and select PC-Controlled 

Communications from the Pen Main Menu.  
2. Select Optimize Pen File System from the Pen 

Communications menu on the Menu Bar of the 
Desktop application. A progress bar appears on the 
computer that displays the progress of the optimization 
process.  

 If communications between your Pen and PC fail, 
an error message appears when you select 
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Optimize Pen File System. Try running the 
Communications Wizard from the Help Menu 
on the Menu Bar to correct the communications 
setup.  

 If the Pen you have connected is not recognized by 
the Desktop, you are prompted to use the current 
Pen Name, choose an existing Pen Name or 
create a new Pen Name.  

3. When the process is complete, a success message will 
appear.  

Important: Do NOT abort the Optimize Pen File System 
process before it is completed. Failure to complete the 
process may result in the loss of all the Pen data.  

Add/Remove Pen Components  
The Add/Remove Pen Components menu is accessible 
via either the Pen Communications menu on the Menu 
Bar of the Desktop application, or by clicking  in the 
Toolbar. The dialog can only be launched when the Pen is 
connected to the PC and PC-Controlled Communications 
has been selected on the Pen.  
This dialog is for advanced users only and should not be 
accessed unless directed to by Support personnel.  

Recover Components Deleted from 
the Pen  
If you do access the Add/Remove Pen Components 
menu and accidentally delete components from the Pen, use 
the Pen CD to reinstall the lost components. 
The CD contains an Add-Ons menu. Access the menu and 
run one of the installations. The initial step of each 
installation will check the Pen for missing components and 
will restore the necessary components. 
If you delete any component from Add-On applications, or if 
you are using a Pen which has dictionaries installed, and 
have deleted a dictionary, reinstall the Add-Ons or 
dictionaries using the CD Add-Ons section. 
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Managing Several Pens in the Desktop 
You can use more than one Pen with the same Desktop 
application. Each Pen is defined on the Desktop by a unique 
Pen Name to make it recognizable by the software. The 
Pen Names dialog box contains several options for 
managing the Pens in the Desktop. Use it to add, rename or 
remove a Pen or to set the current Pen.  
Access the Pen Names dialog from the File menu on the 
Menu Bar or by clicking  on the Toolbar. The default 
Pen Name is "MyPen". 
Adding, changing and deleting Pens 

 To add a Pen: Open the Pen Names menu and select 
Add. Type in a name for Pen and click OK.  

 To change a Pen: Open the Pen Names menu and 
select the Pen Name you want to change. Select 
Rename, type the new name into the Rename box and 
click OK.  

 To delete a Pen: Open the Pen Names menu and 
select the Pen Name you want to delete. Select 
Remove, click Yes when the confirmation message 
appears and click OK.  

Set the Current Pen 
You can change the current Pen at any time by using the 
Current Pen drop-down list in the Toolbar.  
Alternately, to set the current Pen: Open the Pen Names 
menu and select the Pen Name that you want to set as the 
current Pen. Select Set as Current and click OK.  

Working with Files in the Desktop 
Notes and Tables 
To create new files: Click on the application icon and click 

 on the Toolbar. Type a name in the New File box and 
click OK.  

 In Notes: Add or delete paragraphs by right-clicking in 
the Current File Pane and selecting the required 
option from the menu. 

 In Tables: Add or delete rows by right-clicking on the 
row number and selecting the required option from the 
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menu. Add or delete columns by right-clicking on the 
column letter and selecting the required option from the 
menu.  

To edit files: Select the file you want to edit from the Files 
Pane. Double-click on the paragraph you wish to edit and a 
blinking cursor will appear at the beginning of the paragraph 
indicating that the text in the paragraph can be edited using 
the regular Windows keyboard editing commands.  
Note: All modifications made to files are automatically saved 
by the Desktop.  
To open an existing file or import a file: Clicking on the 
application icon in the Application Pane and click  on 
the Toolbar. Locate the file you wish to open and click 
Open. 
To save files with a different name or in a different 
format: Click  on the Toolbar. Choose the format, file 
name and location and click Save.  
To delete files: Right-click on the file you wish to delete in 
the Files Pane and select Delete File from the pop-up 
menu.  

Address Book and Internet Links 
To create new entries: Click on the application icon and 
then double-click in the Current File Pane. Fill in the entry 
details in the pop-up window and click Update.  
To open an existing file or import a file: Click on the 
application icon in the Application Pane and click  on 
the Toolbar. Locate the file you wish to open and click 
Open. 
To edit entries: Double-click on the entry you want to edit, 
change the details in the pop-up window and click Update.  
To save files with a different name or in a different 
format: Click  on the Toolbar. Choose the format, file 
name and location and click Save.  
To delete entries: Right-click on the entry you wish to delete 
in the Current File Pane and select Delete from the pop-
up menu.  
Note: Only entries saved in the files "mainadd.qad" or 
"mainlnk.qlk" will be synchronized with the Pen. 
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Additional Information 
Batteries 
Your Pen comes with 2 AAA Alkaline batteries. If the 
batteries are low, the "Replace Batteries" message appears 
on the Pen. When the batteries are about to run out, the Pen 
shuts down automatically. Many issues may occur on the 
Pen due to low batteries. If you encounter strange behavior, 
check the battery level in the Information menu and 
replace batteries if relevant. 

Safety Points (Batteries) 
CAUTION: Risk of explosion if battery is replaced by an 
incorrect type. Use AAA Alkaline batteries only. 

 Always place 2 fresh batteries in the Pen. It is not 
advisable to use the Pen with batteries that are not at 
the same voltage level. 

 Do not combine different types of batteries (e.g. 
rechargeable and non-rechargeable). 

 Dispose of used batteries according to the 
manufacturer's instructions. 

Pen Maintenance 
Your Pen conforms to the highest standards of 
craftsmanship and manufacture. To keep your product in 
good condition, follow these guidelines: 

 Store in protective case when not in use. 
 Keep away from excessive moisture and temperature 

extremes. 
 Clean using a soft, damp cloth. 
 Avoid exposing to direct sunlight for extended periods 

of time. 
CAUTION: To reduce the risk of electrical shock or damage 
to the internal components, do not spray liquid directly on the 
screen or allow excess liquid to drip inside your Pen.  
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Troubleshooting 
 
Problem: I have followed all the instructions for 
establishing Pen-PC communications and my Pen will 
still not communicate with my PC. What else can I do? 
 
Solution: 
1. Make sure you have new, fresh batteries in your Pen. 
2. Make sure you are an administrator on your computer. 

Sometimes installations will be unsuccessful if you try to 
install new software n a computer where you do not 
have full administrator rights. 

3. Unplug any devices that sync data between the device 
and your PC, i.e. PDAs or digital cameras. If the icon for 
the device appears in the notification area of the 
windows taskbar (bottom right of the screen next to the 
time display) right-click on the icon and exit the 
application. 

4. When you connect the USB cable to both the Pen and 
PC, make sure the cable jack is pushed all the way into 
the Pen and confirm that you hear the last little 'click' 
when the cable is fully inserted. 

5. If this doesn’t help, try inserting the USB cable into a 
different port on the computer. 

6. If you are using a laptop and the baud rate in the device 
manager is set to 115200, try changing the baud rate in 
the Device Manager as follows:  

a. On your computer go to Start/Settings/Control 
Panel and select System. 

b. Click on the Hardware tab and then click on the 
Device Manager. 

c. Scroll down to Ports (COM & LPT) and open the 
drop-down list of ports.  

d. Find the "Prolific USB-to-Serial Comm Port". 
e. Double-click on the prolific driver and go to Port 

Settings. Try changing the Port Settings only in 
the Device Manager (not on the Desktop or Pen).  

f. Try a few different settings. This should help. 
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Problem: I have installed the USB driver from the CD but 
when I plug the Prolific USB cable into my computer it is 
not recognized. What could be the problem? 
 
Solution: 
There could be one of two problems: Either the USB cable 
driver has not been installed correctly or you have a faulty 
cable. To check this, do the following: 

1. Make sure you are an administrator on your computer.  
2. Unplug any devices that sync data between the device 

and your PC, i.e. PDAs or digital cameras. If the icon for 
the device appears in the notification area of the 
windows taskbar (bottom right of the screen next to the 
time display) right-click on the icon and exit the 
application. 

3. Run the USB cable installation from the CD. If you have 
already tried to install the USB driver you will receive 
several options. Select the remove option. Once the 
driver has been removed, restart your computer and 
reinstall the driver from the CD. 

4. Connect the USB cable to both the Pen and PC. Make 
sure the cable jack is pushed all the way into the Pen 
and confirm that you hear the last little 'click' when the 
cable is fully inserted. 

5. The Windows “Add New Hardware Wizard” should 
appear and the complete the driver installation. 

6. On your PC go to Start/Settings/Control Panel and 
select System. Click on the Hardware tab and then 
click on Device Manager. 

7. Find Ports (COM & LPT) and check that the "Prolific 
USB to Serial Comm Port" is listed. 

 
If you can’t see the driver in the Ports list, try the following: 

1. Try to reinstall the driver 
2. Try using a different USB port. Sometimes the cable will 

be recognized when plugged into one USB port and 
might not be recognized on another. 

If you follow the above process and the cable is still not 
detected, contact support for a replacement cable. 
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Problem: I receive the following error when trying to 
install items from the CD or website: “Setup.exe has 
encountered a problem and needs to close”. What 
should I do? 
 
Solution: 
The Setup.exe error is an error generated by Microsoft. It 
occurs sporadically and is usually resolved by restarting your 
computer. 

 It can also be caused by the following: 

1. The Desktop application running at the same time as 
the installation.  

2. Trying to install applications or dictionaries using a 
computer where you don’t have administrator rights.  

3. Another program running on your PC which is 
interfering with the installation. 

  
Please try the following: 

1. Restart your computer.  
2. Make sure that you are administrator on the computer 

you are using. 
3. Close any programs that may be running, especially 

any devices that sync data between the device and your 
computer, such as a PDA or digital camera.  
This may also include closing programs such as printer 
software and anti-virus software. You can see which 
programs are currently running by looking in the 
notification area of the windows taskbar (the bottom 
right of your PC screen, next to the clock).  

 
The notification area of the taskbar 

4. Replace the batteries in the Pen with new, fresh 
batteries. 

5. Try inserting the USB cable into a different port on the 
computer. 
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Problem: I receive the following message when I turn my 
Pen on: "Device is uncalibrated. Please return to 
Vendor". What should I do? 
 
Solution: 
Try inserting new batteries into the Pen. This should solve 
the problem. If the message still appears, your Pen will need 
to be sent to our offices for calibration. Please contact 
support in order to determine where to send your product. 
Please include your name and location. 
 
Calibrating the Pen is free. You will only need to pay 
shipping costs. If, when the Pen is being checked, we 
discover other problems that are not related to calibration, 
you will be contacted prior to any work being done, to check 
if you have a valid warranty and if not, whether you agree to 
pay the extra repair charges. 
 
Problem: I installed a specific dictionary or interface 
language on my Pen but when I turned it on today, the 
dictionary or interface language had disappeared! What 
can I do to get it back? 
 
Solution: 
The extension card at the back of your Pen may not be 
inserted properly. 
 
Please try the following:  

 Open the battery compartment.  
 Remove the extension card from its slot above the 

batteries and blow on it and into the extension card 
compartment to remove any dust particles that may 
have accumulated.  

 Replace the extension card firmly into the slot.  

 
 
This should restore the components to the Pen. 
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Problem: I receive an "Out of memory" message on my 
Pen. What should I do?  
 
Solution: 
If you receive this message, it most likely means that the 
extension card at the back of your Pen is loose, not that you 
have no memory left in your Pen.  
 
All you have to do to fix this is open the back of the Pen 
(where you inserted the batteries) with your fingernail and 
press down firmly on the extension card with your finger.  
 
If this does not fix the problem, open the battery 
compartment. Remove the extension card from its slot above 
the batteries and blow on it and into the extension card 
compartment to remove any dust particles that may have 
accumulated. Replace the extension card firmly into the slot. 
This should solve the problem. 
 
Problem: I’ve changed my Pen user interface to another 
language and now I don’t know how to change it back to 
English! 
 
Solution: 
Do the following: 

1. From the Pen Main Menu scroll down until you see 
 and press ENT. 

2. Scroll down until you see  and press ENT. 
3. Scroll up or down using  or  until you see the word 

English on the screen and press ENT. 
 
This should return the Pen to the English interface. 
 
Problem: My Pen will not turn on. What should I do?  
 
Solution: 
If your pen does not seem to turn on when you press the 
power key, or if it seems to show a blank gray screen, make 
sure the Pen is off and do the following: 

 Open the battery compartment and insert new AAA 
batteries. 
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 Remove the extension card from its slot above the 
batteries and blow on it and into the extension card 
compartment to remove any dust particles that may 
have accumulated.  

 Replace the extension card firmly into the slot. Place 
the flash card firmly back in place. 
Close the battery compartment. 

 Press the ESC button – and hold it down for 3-4 
seconds – while pressing the power ON button. 

 

Product Specification 
Feature Description 
Display Information Resolution: 122 x 32 pixels 

Size: 61mm x 20mm / 2.4” x .8” 
Keypad Push Buttons - 

Power/ESC/ENT/Up/Down/Left/ 
Right) 

CPU  ARM 7 TDMI 
Memory  

 RAM 192KB 

 ROM 8 MB 

 External memory card 4MB, 6MB or 8MB 
Communications USB Cable, Infrared IrOBEX 
Optical Scanner  128 pixels linear array image 

sensor 
 400 DPI resolution 

Power 2 x 1.5V AAA Alkaline batteries 
Size L x W x H: 

163 mm x 38 mm x 23 mm 
(6.4” x 1.5” x 1”) 

Weight 90 grams (3 oz.) without batteries  
+/- flash memory card) 

Safety  CE 
 RoHS 
 UL 
 FCC class B 

Operating Temperature 
Range 

0°C - 40°C 
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Copyrights and Trademarks 
© 2008 WizCom Technologies Ltd. All rights reserved.  

WizCom Technologies Ltd. uses the Ligature OCR-on-a-Chip copyright  

© 1995-2008, Ligature Compression Technology copyright © 1996-2008, 
and Ligature reverse inflection and derivation technology copyright © 
1997-2008 under license from Ligature Ltd. All rights reserved.  

WizCom InfoScan™, QuickLink-Pen®, Quicktionary®, Readingpen®, 
WizCom SuperPen™, WizCom and Pen design are trademarks or 
registered trademarks of WizCom Technologies Ltd. All rights reserved.  

All other brands and product names appearing here are registered 
trademarks or trademarks of their respective owners. 

Worldwide Limited Warranty 
WizCom Technologies Ltd. (hereinafter - "WizCom") warrants the initial 
purchaser (hereinafter - "PURCHASER") of each of the products bearing 
the trade names or trademarks Quicktionary, ReadingPen, SuperPen, 
InfoScan, QuickLink or MEK (hereinafter - "PRODUCT") sold by WizCom 
(including sale through WizCom's Web Site) or WizCom's authorized local 
retail dealer (hereinafter - "AUTHORIZED RETAILER") as follows: 
WizCom warrants that your PRODUCT, under normal use, will be free of 
defects in materials and workmanship for a period of two (2) years from 
the date of original purchase from WizCom or from WizCom's 
AUTHORIZED RETAILER. 
This limited warranty extends only to the original Purchaser of the 
PRODUCT and is not assignable or transferable to any subsequent 
purchaser/end-user. 
WizCom's sole obligation, and Purchaser exclusive remedy, under this 
express warranty, in lieu of all other warranties express or implied by law 
or otherwise, shall be, at WizCom's option and expense, to repair or 
replace- either with new parts or used parts, without charge, PRODUCTS 
that are found to be defective and malfunctioning during normal usage 
and returned within the warranty period, provided that:  
(i) The PRODUCT has not been damaged or subjected to mishandling, 
improper storage, misuse, neglect, abuse, accident, alteration, abnormal 
operation or conditions, operation in an unsuitable environment or in a 
manner for which it is not intended, unauthorized repair, unauthorized 
modifications, or other acts which are not the fault of WizCom.  
(ii) The PRODUCT has not been damaged from external causes such as 
fire, flooding, sand, dirt, storm or any other damage from weather 
conditions, an Act of God, theft, or battery leakage, blown fuse, or 
improper use of any electrical source, damage caused by computer or 
internet viruses, bugs, worms, Trojan Horses, cancelbots or damage 
caused by the connection to other products not recommended for 
interconnection by WizCom. 
(iii) No one other than an authorized WizCom representative opens the 
casing of the PRODUCT.  
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(iv) WizCom has been advised in writing by the PURCHASER of the 
alleged defect or malfunction of the Product within fourteen (14) days after 
the expiration of the applicable limited warranty period. 
(v) This limited warranty does not cover physical damage to the surface of 
the product, including breakage, cracks or scratches on the LCD screen 
or outside casing.  
(vi) The liability under this warranty is limited to the actual cash value of 
the PRODUCT, determined by the price paid by the Consumer for the 
Product less a reasonable amount for usage.  
Repair or replacement of the PRODUCT shall not extend the original 
warranty period.  
PURCHASER will be charged for all PRODUCT repairs for damage or 
failure not covered by this limited warranty. 
Return of the PRODUCT for repair or replacement under this warranty, 
must be made to PURCHASER'S local dealer and must be accompanied 
by proof of date of purchase, identification of the PRODUCT by model 
number and serial number and complete description of the problem. 
WizCom makes no warranty or representation that the PRODUCT will 
meet the PURCHASER'S requirements or will work in combination with 
any hardware or software products provided by third parties, that the 
operation of the PRODUCT will be uninterrupted or error free, or that all 
defects in the PRODUCT will be corrected. 
EXCEPT AS EXPRESSLY SET FORTH IN THIS WARRANTY, WIZCOM 
MAKES NO OTHER WARRANTIES EXPRESSED OR IMPLIED, AND TO 
THE FULLEST EXTENT PERMITTED BY LAW, WIZCOM DISCLAIMS 
ALL OTHER WARRANTIES EXPRESSED OR IMPLIED, INCLUDING 
BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OR 
USE.  
In no event shall WizCom, its agents, officers or employees be liable for 
any damages whatsoever, including (without limitation) special, direct or 
indirect, punitive, consequential or incidental damages, including, without 
limitation, damages resulting from use of or reliance on the products 
and/or services and/or advertisements regarding the PRODUCT, loss of 
revenues, loss of profit, business interruption, loss of information or costs 
of replacement goods, loss of use of the product or any associated 
equipment, cost of capital, loss of enjoyment of the PRODUCT, arising 
from claims of third parties, including customers or arising from breach of 
the warranty, breach of contract , negligence, strict tort, or any other legal 
or equitable theory without limitation.  
WizCom reserves its right to make technical alterations to the PRODUCT 
and such alterations shall not be considered as breach of warranty. 
WizCom shall not be liable for any delays or defaults hereunder by reason 
of fire, floods, acts of God, labor troubles, accidents to machinery, delays 
of carriers or suppliers, inability of suppliers to supply, the impositions of 
priorities, restrictions or other acts of government, or other causes beyond 
its reasonable control. 
The agents, dealers and employees of WizCom are not authorized to 
make modifications to the warranty, or additional warranties that are 
binding on WizCom. 
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